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1. Project Management Introduction
About project management

After an initiative is created for a client, you can create projects for the initiative. The
approval rules for projects for clients are defined in initiatives.

You use projects to define and track work that is being done for a client or an initiative. You
can set up projects as chargeable or non-chargeable. The progress of a project is tracked
through tasks that define the project work. You assign tasks to resources, and the resources
enter their time and expenses for the tasks into Changepoint.

You can group related tasks under summary tasks and create dependencies between tasks. If
a project is large or complex, you can divide it into subprojects. Each project can support up
to 20 levels of tasks and subprojects. These levels are displayed in the Projects tree view.

When you no longer require the project to be available in Changepoint, you can archive the
project data.

About project resources

The typical resources that work with projects are the following:

• Project manager – has full edit access to the project and its tasks. The project manager is
specified on the project profile. There can only be one project manager for a project at a
time.

• Project plan editors – can edit existing project tasks and can view the project dialog box
but cannot edit the project profile. Project plan editors are granted access to the project
by the project manager. The project manager can also specify whether project plan
editors can create and delete project tasks, save project baselines, and take over the
project to become the project manager.

• Summary task managers – can view the summary tasks and subtasks under the summary
tasks that they have been assigned to. The project manager can also specify whether
summary task managers can create, edit and delete the subtasks under their summary
tasks.

• Resources assigned to project tasks – can view and update the status of the tasks that
they have been assigned to.
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About resource leveling
If resource leveling is enabled for your Changepoint installation, all entries that affect task
assignments are validated. If the task assignments will result in a resource being overbooked,
a validation report displays a list of the affected task assignments.

Depending on how the staffing workgroup for the initiative that is associated with the project
has been configured, the validation report will contain either warnings or failures:

• If the validation report contains warnings, then you can choose either to accept the
warning and save the task assignment or cancel the task assignment.

• If the validation report contains failures, the task assignment cannot be saved.

About soft-bookings
Soft-bookings are tentative bookings of resources for planning purposes. Soft-booked time is
shown as flexible on the resource schedule calendar. Available for task assignments, project
team entries, request demand items, projected resources and calendar entries.

If resource request workflow is not used and soft-booking is allowed, resource request
initiators determine whether a resource is soft-booked at the time they create the resource
request.

If resource request workflow is used and soft-booking is allowed:

• Resource requests created by non-resource managers are treated as soft-bookings until
they are approved by the resource manager.

• When a resource request is approved, the booking changes to hard-booked and the
resource is committed for the duration of the request.

Resource managers can directly hard-book resources. The default setting for initiatives and
projects is soft-booked, and for tasks it is hard-booked.
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2. Creating Projects
About methods for creating projects

The following methods for creating a project are available:

• Create project – you can create a detailed project plan, and the related tasks, and task
assignments. The related client, initiative, and cost structure must already exist. For
more information, see "Creating a project" on page 19.

• Quick Plan – you can set up a simple initiative, project and task in one step. For more
information, see the "Creating a project using the Create Quick Plan report" section on
page 195.

• Quick project – if you do not require a detailed project plan, you can create a quick
project from an initiative. A quick project is based on the work team information that is
defined on the Projected resources tab of the initiative dialog box. For more
information, see "Creating a project based on the projected resources of an initiative" on
page 202.

• Copy an existing project – you can use an existing project as a template to create a
project or a project and its tasks. For more information, see "About copying projects" on
page 41.

Accessing a project
1. Click General > Projects.

The Projects tree view appears.

2. Expand the tree view, and then select the project.

The project profile appears.

About the noneditable sections in the project profile

The project profile contains the following sections that cannot be edited:

• Record information – displays information about when the project was created and by
whom, and when the project was last updated.

• Fiscal year breakdown – displays the planned, actual and remaining hours for the
project distributed across the fiscal years that the project covers. This section displays
only if fiscal periods have been specified for the project.
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• Portfolio memberships – displays only if the project is part of a portfolio. You can click
the portfolio names to view the portfolios.

• Project dependencies – displays all of the information related to both predecessor and
successor tasks.

Icons in the Projects tree view

The following table describes the project icons that display in the project tree view.

Blue project icon indicates that you are the project manager for the project.

Gray project icon indicates that you have view access to the project.

Microsoft Project icon indicates that the project is linked to aMicrosoft

Project project.

About creating projects
After clients and initiatives have been created, you can create your project, add tasks and
assign resources. All projects in Changepoint are associated with an initiative.

You can create a project using the New option or from an entity (initiative, client, candidate or
request) profile. When you create a project from an entity profile, the entity-related
information is automatically added to the project.

You can create a project by completing only the following fields and then saving the project:

• Project

• Client

• Initiative

You can then enter the rest of the information for the project in stages.

The following fields are required, but because they have default values, you do not have to
enter values for them:

• Planned start

• Planned finish

• Planned hours
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• First status (required only if Status required is selected in the Project type field)

You can enter values for the planned fields when you create the project, but the actual values
based on the project data can be determined by rolling up the project after the tasks have been
added.

About project statuses

The project status affects all of the tasks related to the project, and controls the project-related
functionality that resources are able to perform.

The following table lists the standard project statuses and descriptions of how the statuses can
be changed in the workflow.

Status Description

Draft The project is under revision. Only the project manager has

access to the project profile while it is inDraft status. Assigned
resources cannot view the project, update the status of project

tasks, or enter time and expenses. When you create a new

project, it is inDraft status.
Draft can be changed to any other status.

Active The project is in progress. Only the project manager can edit

the project profile and tasks. All other resources can access

the project and its tasks and enter time and expenses

according to their access rights.

Active can be changed toCompleted or Inactive. When

project managers change the status from Active to
Completed, all associated tasks aremarked as Completed
and are locked.

Completed The project has been completed. Resources cannot enter

project expenses or time for project tasks.

Completed can be changed toActive or Inactive.

Inactive The project is suspended. Resources cannot enter project

expenses, or time against project tasks until the status is

changed back toActive.
Inactive can be changed toActive orCompleted.
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About project phases

Project phases represent the stages in a project’s life cycle. When you create tasks, you can
specify the project phase in which the work should be done. When a project is rolled up, the
current project phase is based on the latest phase of the tasks that have actual hours recorded,
and is displayed in the Project phase field on the project profile.

Note: The Project phase field displays on the project profile only after the project is
rolled up.

If the project includes summary tasks, the project phase is based on the summary task and not
its subtasks. As a best practice, you should ensure that either all tasks under a summary task
have the same project phase as the summary task, or that no phase is specified (provided that
project phases are not mandatory). If no project phase is specified for the summary task, then
the project phase of its subtasks is taken into consideration.

The Proposed phase field on the project profile displays the phase that the project is working
towards. If project workflow is enabled, the field displays the workflow step that is currently
in progress. By comparing the proposed phase with the actual phase, you can see if work is
occurring within a phase that has not yet been approved to start.

About task status updates

Status updates for project tasks can be mandatory or not required:

• Status required – Resources must update the status of their assigned tasks. However, you
can remove the status requirement for specific tasks and task assignments if necessary.

• Status not required – Resources are not required to update the status on their assigned
tasks. You cannot specify that certain tasks require status updates. Therefore, if you
require updates on any tasks in your project, you must select the Status required project
type when setting up your project.

For task assignments that do not require status updates:

• Only the project manager, project plan editor, or the resource who is assigned to the task
can specify when the task is completed. Rolling up a project does not automatically set the
task assignments as complete.

• When a project is rolled up, the remaining hours are calculated as:

planned hours – actual hours
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If the actual hours are greater than or equal to the planned hours, the remaining hours are
set to 1. The percentage complete is calculated as follows:

actual hours/(actual hours + remaining hours).

About using fiscal periods on projects

If you want to use fiscal periods on a project, you must add them before you create tasks and
task assignments.

When you add fiscal periods to a project, the planned effort is recalculated using a specific
default loading method and can result in changes to planned hours totals and allocations. Also,
you cannot edit dates and planned hours in past fiscal periods.

Creating a project
1. Click New > Project.

The Create Project dialog box appears.

2. In the General tab, complete the fields as required. For more information, see "Create/Edit
Project dialog, General tab options" on page 20.

3. Click Save. The project is created.

4. To complete the project, see the following topics:

• "Entering budget information for a project" on page 21

• "Specifying time approvers for a project" on page 23

• "Associating an objective to the project" on page 24

• "Specifying a work location and work code for a project" on page 25

• "Allowing resources to submit project expenses" on page 30

• "About granting access to projects" on page 26

• "Associating a project to an application" on page 31
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Create/Edit Project dialog, General tab options

Field Description

Project field Name of the project.

Alternate name field Specifies the alternate name for the project. Typically used

to display the project name in a different language

Client type-ahead field client for which the project is being created.

Initiative list initiative for which the project is being created.

Planned start field Start date for the project.

Planned finish field Finish date for the project.

Planned hours field Planned hours for the project.

Status list Overall status of the project.

Proposed phase list Project phase that the project is currently working towards.

If project workflow is enabled, the field displays the state in

the current workflow process.

Project ID field ID for the project. Depending on the organization, the project

ID may be automatically assigned by the system.

Chargeable project check
box

When selected, specifies that the project is chargeable.

Project contact list Contact from the client that is associated to the project.

Cross charge contact list Contact to whom the cross charges will be sent.

Project type list Option that specifies whether resources must update the

status of their assigned tasks. Options are:

• Status required
• Status not required

First status date field Date that resources must start updating the status of their

assigned tasks, if the project type is set toStatus required.
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Field Description

Status every [ ] weeks field Frequency in weeks that resources are required to enter a

status update for their assigned tasks.

CP project type list Custom project type that allows the project to be

categorized within Changepoint.

Fiscal period type-ahead
field

Cost structure whose fiscal periods apply to the project

worksheet.

Cost center type-ahead field Cost center that is associated with the project. The cost

center determines the burden rate that applies to cost rates

for budgeted services, when specific resources are not

selected.

Work performed for type-
ahead field

Client for which the work is performed, as specified in the

associated initiative.

Candidate type-ahead field Candidate to associate to the project

Request field Request number of the originating request, if applicable.

View in Client Portal check
box

When selected, Client Portal users can view the project and

its tasks, and create requests for the project.

Display MSP WBS in tree
view check box

When selected, displays theMicrosoft Project work

breakdown structure (WBS) number for a task before the

task name in theProjects tree view.

Calculate critical path check
box

When selected, critical path is calculated for the project.

Comments field Comments regarding the project.

Entering budget information for a project

The budget information that you enter here is for information purposes only and is displayed in
the Budget information section of the project profile. To estimate and track the labor,
material and expenses required to perform the work defined in the project, you can create a
project-specific budget.

1. Access the project.
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2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Budget and approval information tab.

4. Complete the fields as required. For more information, see "Create/Edit Project dialog,
Budget and approval information tab options" on page 23.

5. Click Save.

About specifying time approvers for projects

By default, the time approver specified for a resource in user setup approves all time for a
resource. However, if a time approver has been specified for an initiative, then the initiative
time approver approves time for all projects under the initiative.

If an initiative is configured to allow time approval on projects, you can also enable time
approval and specify a time approver for individual projects under the initiative. In this case,
the specified project time approver approves the project time, followed by the initiative
approver. If a project time approver is not specified, then the resource approver approves the
time, followed by the initiative approver.

If a time approver is not specified for the initiative, then the project time is approved by the
project time approver only.

The following table shows the time approvers when time approvers are specified on more than
one entity.

Initiative
Time
Approver

Project Time
Approver

Resource Time
Approver

Time entry approvers

Specified Specified Specified or not

specified

The project time approver, then the initiative time

approver.
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Initiative
Time
Approver

Project Time
Approver

Resource Time
Approver

Time entry approvers

Not specified Specified Specified or not

specified

The project time approver.

Specified Not specified Specified If time approval is enabled for the project: the

resource time approver, then the initiative time

approver

If time approval is not enabled for the project: the
initiative time approver.

Specifying time approvers for a project

1. Access the project.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Budget and approval information tab.

4. Complete the fields as required. For more information, see "Create/Edit Project dialog,
Budget and approval information tab options" on page 23.

5. Click Save.

Create/Edit Project dialog, Budget and approval information tab options

Field Description

Labor field Proposed labor budget for the project.

Expenses field Proposed reimbursable expense budget for the project.

Other expense field Proposed budget for other expenses for the project.

Project value field Value of, and currency for, the project.

The project value is one of the search criteria for resources.
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Field Description

Enable project time
approval check box

When selected, the time worked on the project must be

approved at the project level.

Time approver field Resource who approves the time submitted for the project.

Secondary time approver
field

Resource who approves the time that the time approver

submits.

Associating an objective to the project

The primary objective appears in the Primary objectives column on a project portfolio.

1. Access the project.

2. Click the Objectives tab.

3. In the Primary objective list, select the primary objective for the project.

4. In the objective list, select the objectives for the project.

5. To create a new objective, right-click in the objectives list and select Add objective. For
more information, see "Creating a competitoran objective" on page 1 in the Customer
Relationship Management User Guide.

6. Click Save.

About specifying work locations and work codes for a project

Work locations and work codes are required to assign the correct taxation information when
cross charging the client. Work locations specify where the work is performed, and work
codes specify the type of work.

The work locations and codes for a project come from the associated initiative. However, you
can specify different work locations and work codes or change the default ones for the project.
The default work location and work code display on all time and expense records for the
project.

You can allow resources to change the work location on time and expense entries. You can
also allow resources to select a work location that has not been specified for the project. The
system administrator can set up an email notification to let you (the project manager) know
when expenses are being entered for a location that is not specified on the project.
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If work locations or work codes are changed or removed from the initiative, they display in
red. They are still available to select at another time.

Specifying a work location and work code for a project

1. Access the project.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Work locations/work codes tab.

4. In the Selected work locations list, expand the tree view and select the work location.

5. To change the default work location:

a. Right-click a work location.

b. Select Set as default.

6. To allow resources to select a different work location for expenses, select the Allow
expense location override check box.

7. To allow resources to choose a work location that is not in the Selected work locations
list for an expense, select the Allow non-project locations check box.

8. In the Selected work codes list, expand the tree view and select the work codes.

9. To change the default work code:

a. Right-click a work code.

b. Select Set as default.

10. Click Save.

Setting up split charge charging for a project

You select clients and specify the percentage that each client will be cross charged. You can
either specify the percentage manually as you select each client, or select all of the clients
first and then select the option to automatically split the cross charge amount evenly between
the clients.

1. Access the project for editing.

The Edit Project dialog box appears.
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2. Click the Split charges tab.

3. To specify a client:

a. Right-click in the table, and then select Insert.

b. In the Client type-ahead field, select the client.

4. To add the clients that have already been for the initiative, right-click in the table and
select Load initiative split charge.

5. To specify the percentage, do one of the following:

• To specify the percentage manually, enter the value in the Percentage field.

• To split the charge evenly between all clients, right-click in the table and select Auto-
split.

6. Click Save.

About granting access to projects
As project manager, you automatically have access rights to view and edit all aspects of the
project.

However, you can manage the access for other resources. For more information, see the
following:

• "Granting a resource view access to a project" on page 26

• "Removing view access restrictions to project requests" on page 27

• "Specifying access for project plan editors" on page 28

• "Granting access to subprojects" on page 29

• "Allowing resources to save baselines" on page 29

• "Allowing resources to submit project expenses" on page 30

Granting a resource view access to a project

When you grant view access to a project to a resource, the resource can view the project and
all of its tasks, including in the project worksheet.

1. Access the project.

2. Click Actions > Edit.
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The Edit Project dialog box appears.

3. Click the Access tab.

4. In the View project list, select the resources.

Tip: To add resources to the View project list, and optionally to your preferred resources,
right-click in the list and then selectManage Resources.

5. Click Save.

Removing view access restrictions to project requests

If system-wide restrictions for viewing requests have been set up by your organization, only
the resources that have been granted specific access to a project can view the project requests.
However, you can remove the restrictions for a project.

If system-wide restrictions have not been set up, you cannot add access restrictions to a
project.

1. Access the project.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Access tab.

4. In the Request access section, select the Disable view access restrictions for viewing
all requests under this project check box.

5. Click Save.

About specifying access for project plan editors

You can designate resources as project plan editors for a project. Only resources who have the
security access to manage tasks are available as potential project plan editors. By default,
project plan editors can only view and edit project tasks. However, you can set additional
options to allow them to also create and delete project tasks, assign summary tasks, and take
ownership of the project.

You can remove project plan editor access from resources at any time, except for the default
project plan editors.
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Specifying access for project plan editors

1. Access the project.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Access tab.

4. In the Edit project plan list, select the resources to be project plan editors for your
project.

Tip: To add resources to the Edit project plan list, and optionally to your preferred
resources, right-click in the list and then selectManage Resources.

5. In the Project plan editor access section, do the following:

• To allow project plan editors to assign summary tasks to resources, select the Allow
to assign summary tasks check box.

• To allow project plan editors to create new tasks for the project, select the Allow to
create new tasks check box.

• To allow project plan editors to delete tasks from project, select the Allow to delete
tasks check box.

• To allow project plan editors to take ownership of the project, select the Allow to take
ownership of the project check box.

6. Click Save.

Granting access to summary task managers

A summary task manager is a resource who has been assigned to a summary task for the
project. You can set options to allow summary task managers to create, edit and/or delete the
subtasks under their assigned summary tasks.

1. Access the project.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Access tab.

4. In the Summary task manager access section, do the following:
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• To allow summary task managers to edit the subtasks under the summary tasks to
which they are assigned, select the Allow to edit tasks check box.

• To allow summary task managers to add new tasks under the summary task, select the
Allow to add new tasks check box.

• To allow summary task managers to delete subtasks associated with the summary task,
select the Allow to delete tasks check box.

5. Click Save.

Granting access to subprojects

1. Access the project.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Access tab.

4. In the Subproject settings section, do the following:

• To allow resources to create a subproject under the project, select the Allow
subprojects to be created check box.

• To automatically make the project manager a project plan editor for all subprojects,
select the Allow the project manager complete access to all subprojects check box.

• To display all subprojects in the Projects tree view, select the Display subprojects in
the project tree view check box. If this check box is cleared, only the project
manager of the subproject can view it in the tree view only.

• To have planned start, planned finish and planned hours roll up from subprojects to the
parent project task when the project is rolled up, select the Roll up planned
information from subprojects to parent task check box.

5. Click Save.

Allowing resources to save baselines

You can control whether project plan editors and summary task managers can save baselines.
You can also give resources the option to save a baseline for a task with or without affecting
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higher-level tasks. For more information, see "About saving a task baseline without affecting
higher level tasks" on page 69.

1. Access the project.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Access tab.

4. In the Baseline settings section, do the following:

• To allow project plan editors to save baselines for the project, select the Allow
project plan editors to save baselines check box.

• To allow summary task managers to save baselines for their summary tasks and
subtasks, select the Allow summary task managers to save baselines check box.

• To give resources the option to save baselines without affecting higher-level tasks,
select the Allow users to save task baselines without affecting higher-level tasks
check box.

5. Click Save.

Allowing resources to submit project expenses

You can allow all of the resources who are assigned to project tasks to submit expenses for
the project. You can also allow:

• individual resources to submit expenses even if they are not assigned to any project tasks

• all resources who are assigned to the project to override the chargeable status on
expenses, even if the expenses for the project are chargeable

The Expense only users list includes your preferred resources who have access rights to
create expenses. If resource requests are enabled at the project level, then list also includes
the resources from the project team who have access rights to create expenses.

1. Access the project.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Expense access tab.
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4. To allow resources to submit expenses even if they are not assigned to any project tasks,
select the resources in the Expense only users list.

Tip: To add resources to the Expense only users list, and optionally to your preferred
resources, right-click in the list and then selectManage Resources.

5. To allow all of the resources who are assigned to the project to submit expenses, select the
Allow resource with task assignments to enter expenses check box.

6. To allow all of the resources who are assigned to the project to override the chargeable
status for a particular expense, select the Allow users to override the [Chargeable]
status on expenses entered for this project check box.

7. Click Save.

Associating a project to an application
You can associate projects to the applications for which the work is being done. When you
associate a project to an application, all of the project tasks are automatically associated with
the application. You can also associate individual tasks in the same project to different
applications. For more information, see "Associating a task to an application" on page 57.

The first application you select is marked as the primary application and is used for reporting
purposes.

1. Access the project.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Applications tab.

4. In the Applications list:

a. Expand the tree view and select the primary application associated with the project.

b. Select additional applications, as required.

5. To change the primary application, click the name of the application instead of the check
box.

6. Click Save.
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Removing the association between a project and an application

1. Access the project.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Click the Applications tab.

4. To remove the association to a primary application, you must first select a different
primary application by clicking the name of the application instead of the check box.

5. Clear the check box for the primary application.

6. Click Save.

About creating subprojects
You can create subprojects when you require a more complex project structure. Subprojects
appear the same as projects in all tree views.

By default, only the project manager of the subproject can view it in the Projects tree view.
To allow all resources who have access to the project to view the subproject, you must select
the option for displaying subprojects on the parent project.

Creating a subproject

You must create a subproject from the profile of a task that has been created for that purpose,
and you must be assigned to that task.

1. Create a task.

2. Assign the task to yourself.

3. From the task profile, click Actions > Create > Subproject.

The Edit Project dialog box appears.

4. Complete the fields as required. For more information, see "Creating a project" on page
19.

5. Click Save.
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About project teams

If resource requests are enabled at the project level, the Project team tab is available on the
project dialog box. You define your general resource requirements by adding project team
entries. Project team entries consist of combinations of staffing levels, functions, and the
duration and estimated effort of assignments.

You manage the project team resources as follows:

• add project team entries

• submit the resource requests for approval

• track the progress of resource requests

• after resource requests have been approved, assign resources to project tasks

Creating a project team entry

For planning purposes, you can create project team entries that are based on staffing levels,
instead of naming specific resources. Later, you can use these project team entries to submit
resource requests.

1. Access the project for editing.

2. Click the Project team tab.

3. In the Project Team Details section, complete the fields as required. For more
information, see the "Edit Project dialog, Project team tab options" section on page 34.

4. To add resources to your preferred resources list, in the Project Team Details section,
click Actions > Manage resources.

5. In the section, click Actions > Apply.

The entry is added to the project team table.

6. Click Save.
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Edit Project dialog, Project team tab options

Field Description

Assigned resource type-
ahead field

Resource that has been assigned to the project team. This

field is editable when no resource request is associated

with this project team. This list includes resources who are

exempt from the resource request process.

Requested resource list Resource that you request for project team entry. Available

only when no resource has been assigned.

When you submit the resource request, the requested

resource in this section is set by default from the requested

resource in the project team. You canmodify this value

later, if required.

Cost structure list Cost structure from the project. You can select a different

cost structure to access a different set of staffing levels.

Staffing level list Staffing level of the project team entry.

Function type-ahead field Job function of the resource.

Start date field Date the resource will start.

Finish date field Date the resource will finish.

Estimated hours field Number of hours that you require the resource.

Soft-booked check box When selected, indicates that the resource is tentatively

booked for planning purposes. Available only if soft-booking

is enabled on the cost structure.For more information, see

"About soft-bookings" on page 14.

Add to calendar check box When selected, adds the project team entry to the

resource’s personal calendar and the resource scheduling

calendar

Submit request check box When selected, displays theRequested resource and the
Number of resource requests fields that are required to
submit a resource request.
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Field Description

Requested resource list Resource that you request.

Number of resource
requests field

Number of resources that you require.

Comments field Instructions for the resourcemanager.

Resource request status
field

After the resource request has been submitted, the project

team entry displays the request number.

Specified qualifications
field

Qualifications that the resourcemust have.

Assigned tasks field List of project tasks that can be assigned to resources.

Project team comments
field

Comments about the project team entry.

Copying projected resources to a project team

The projected resources from the initiative that is associated with a project can be copied to
the project team as project team entries. Assigned resources are copied only if they are exempt
from resource requests. You can then edit the project team entries as required.

1. Access the project for editing.

2. Click the Project team tab.

3. Click Actions > Copy from projected resources.

The projected resources records from the initiative are added to the project team table.

4. To edit a project team entry:

a. Select the row in the project team table. The details appear in the Project Team
Details section.

b. Make the necessary changes.

c. Click Actions > Apply.
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5. To include an entry in the resource’s personal calendar and the resource scheduling
calendar, select the Add to calendar check box.

6. Click Save.

Submitting a resource request for a project team

When you submit a resource request, you can either request a specific resource or leave the
resource field blank and have the resource manager assign the resource. The resources
available for selection are the resources from your preferred resources list. You can also
submit a resource request for multiple resources based on a staffing level only. For example,
you could submit a resource request for 5 developers.

1. Access the project for editing.

2. Click the Project team tab.

3. In the table, select the project team entry for which you want to submit a request.

The details of the project team entry are displayed in the Project Team Details section.

4. In the Project Team Details section, select the Submit request check box.

The Requested resource type-ahead field, the Number of resource requests field and
the Comments field appear.

5. To request a specific resource, in the Requested resource type-ahead field, select the
resource.

6. To request multiple resources:

a. Leave the Requested resource field blank.

b. In the Number of resource requests field, enter the number of resources that you
require.

7. To mark a qualification as preferred, in the Specified qualifications tree view, right-click
the qualification and select Set as preferred.

8. In the Comments field, enter instructions for the resource manager.

9. In the Project Team Details section, click Actions > Apply.

In the project team table, a check mark is displayed in the Submit request column of the
project team entry row.
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10. Click Save.

The resource request is submitted to the resource manager for approval.

Tip: You can search for available resources by clicking Actions > Resource search. For
more information, see "Resource Searches" in the Resource Management User Guide.

Editing a project team entry

You can edit a project team entry only if a resource request has not been submitted, or the
associated resource request is still in the New status. Once the resource request is no longer in
the New status, changes can only be made by editing the resource request.

1. Access the project for editing.

2. Click the Project team tab.

3. In the table, select the project team entry.

4. Make the necessary changes. For more information, see "Edit Project dialog, Project team
tab options" on page 34.

5. In the Project Team Details section, click Actions > Apply.

6. Click Save.

Deleting a project team entry

You can delete a project team entry provided that a resource request has not yet been
submitted for it, or the resource request has been submitted but it is still in the initial status.

1. Access the project for editing.

2. Click the Project team tab.

3. In the table, select the project team entry.

4. In the Project Team Details section, click Actions > Delete.

5. Click Save.

Assigning a project team resource to a task

After a resource request has been approved, you can assign the resource to tasks. The duration
and effort for the task must be within the duration and effort of the project team entry.

1. Access the project for editing.
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2. Click the Project team tab.

3. In the table, select the project team entry.

A list of project tasks appear in the Assigned tasks list.

4. In the Assigned tasks list, select the tasks that you want to assign to the resource.

5. To set the planned hours for a task:

a. Right-click the task and select Set planned hours. The Set Planned Hours dialog box
appears.

b. In the Planned hours field, enter the number of planned hours planned for this task
assignment.

c. Click OK.

6. In the Project Team Details section, click Actions > Assign task.

7. Click Save.
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About editing projects

Only the project manager can edit the project profile; that is, change the information in the
project dialog box. Project plan editors can view the project dialog box only. This topic
includes information to consider before making certain changes to the project profile.

Changing the cost structure of a project

If you change the cost structure, all planned effort that has been manually allocated for
project task assignments will be lost, except in the following circumstances:

• allocations for loading methods 3 and 4 that do not replace planned effort in past periods
with actual hours are retained

• allocations for loading methods 0, 1 and 2 that replace planned effort in past periods are
retained when the past data does not have to be recalculated, for example:

• the cost structure is removed and no new cost structure is selected

• the start date of the current fiscal period on the new cost structure matches the start
date of the current fiscal period on the previous cost structure

• the planned start date of the task assignment is in the current fiscal period or a future
fiscal period of the new cost structure

Changing the chargeable status of a project

You cannot change the setting of the Chargeable project check box when the Split charges
check box has been selected on the Cross charge information tab of the initiative, and
either of the following conditions exist:

• Cross charges exist for an initiative or phantom initiative that is in Draft, Pending
Approval, Pending second approval or Approved status.

• All cross charges are committed, but there is time or expenses for the initiative or
phantom initiative that have not been fully cross charged.

Changing the requirement for task status updates

You can change whether task status updates are required for a project by changing the
project type.
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If you change the requirement for task status updates from Status required to Status not
required, the requirements for all existing tasks and task assignments as well as new tasks
and task assignments created later will automatically be changed to Status not required.

If you change the requirement for task status updates from Status not required to Status
required, you have the following options:

• change the requirement for existing as well as new tasks and task assignments

• change the requirement for new tasks and task assignments only

Editing a project

1. Access the project.

The project profile appears.

2. Click Actions > Edit.

The Edit Project dialog box appears.

3. Make the necessary changes. For more information, see "Create/Edit Project dialog,
General tab options" on page 20.

4. Click Save.

About deleting a project

When you delete a project, all of the project and task information is deleted. You cannot delete
a project if any of the following conditions exist:

• there are time and expense entries for the project that have not been cross charged and
archived

• the project contains an active subproject

• the project is included in a project portfolio

• there is a project task associated to an expense

Deleting a project

1. Access the project for editing.

The Edit Project dialog box appears.

2. Click Delete.

40 | Changepoint PPM2017 SP1



About copying projects

3. Click OK to confirm.

About copying projects
You can copy project information to update an existing project or create a new project. When
you copy project information, all project and task field values, including the configurable field
values from the source project, are automatically copied to the target project, except for the
settings in the Access tab.

Note: If resource requests are required for the project, then you cannot copy task
assignments from the source project to the new project.

When you copy project information, you can:

• Specify a project manager (for new projects only). The new project manager must be in
your preferred resources list and have the security access to manage tasks in order for the
project tasks to be copied to the target project

• Specify whether the planned start and finish dates for the target project are based on a
specified start or end date.

• Copy project-related knowledge items.

• Copy resource assignments and/or specify a default resource.

• Copy resource staffing levels.

• Copy work locations and work codes for the project.

• Copy work locations and work codes for the tasks and task assignments.

About copying a project to update an existing project

You can copy project information from a source project to an existing target project provided
that you have edit access to both the source and target projects and/or the projects’ tasks, and
the project manager of the target project is in your preferred resources list.

You can only copy the type of information that you have edit access to on the target project.
For example, if you are the project manager for both the source and target projects, you can
copy all project and task information. However, if you are the project manager for the source
project, but only a summary task manager for the target project (and summary task managers
can create tasks for the project), then you will only be able to add tasks under the summary
tasks that you have access to in the target project.
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Copying a project

1. Access the profile of the source project.

2. Click Actions > Copy.

3. If knowledge items exist for the source project, a dialog box appears. Do one of the
following:

• To include the knowledge items, click OK.

• To exclude the knowledge items, click Cancel.

The Copy Project dialog box appears.

4. Do one of the following:

• To create a new project from an existing project, do not select the Update project
check box.

• To update an existing project with the information of the source project, select the
Update project check box.

5. Complete the fields as required. For more information, see "Copy Project dialog box
options" on page 42.

6. Click Save.

Copy Project dialog box options

Field Description

Copy source field Name of the source project which information are copied.

Update project check box When selected, the source project information is copied to an

existing project.

When cleared, the source project information is used to create

a new project.

Project manager list Project manager of the target project. The field displays your

name by default.
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Field Description

Target project type-ahead
field

Project to which the information is copied.

Insert into summary task
type-ahead field

Summary task under which tasks are copied

Name of new project field Name for the new project.

Alternate name field Alternate name for the project.

Client type-ahead field Client for which the project is created.

Client ID type-ahead field ID of the client.

Initiative list Initiative associated with the project.

Phase list Phase of the tasks.

If phases are selected, only the tasks that are in one or more

phases of the source project are copied to the project.

Base new timescale on.

Start date check box
When selected, planned dates are based on the start date of

the source project.

Base new timescale on,

End date check box
When selected, planned dates are based on the end date of the

source project.

Date field Start or end date for the project.

Copy resource
assignments into the
new project check box

When selected, copies the resource assignments from the

tasks in the source project to the new project.

Copy resource staffing
levels into the new
project check box

When selected, copies the staffing levels from the tasks in the

source project to the new project.

Default resource list Default resource to be used when the resources from the

source project are not available.
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Field Description

Copy selected work
locations and work
codes from the source
project check box

When selected, copies the work locations and codes from the

source project to the new project.

Copy selected work
locations and work
codes from the source
tasks and task
assignments check box

When selected, copies the work locations and codes from

source tasks and task assignments to the new project.

About completing the Copy Project dialog box

Copying tasks

By default, all tasks are copied from the source project. However, you can specify that only
the tasks that are associated to one or more project phases in the source project are copied.

Selecting a default resource

You can select a default resource from your preferred resources list to be used when the
resources from the source project are not available. For example, the default resource is used
when a resource from the source project has been deleted or unassigned from a task or is
unavailable to the new project manager. If resource requests are enabled on the initiative, the
Default resource list contains resources from the projected resources for the initiative.

Specifying the target project timescale

You can specify whether the target project planned dates are based on a start date or end date.
If you specify that the project timescale be based on a start date, then the planned start dates
for the target project tasks are based on the relative period of time between the planned start
date of the source project tasks and the planned start date of the source project.

For example, if the planned start date for a source project task was 10 days after the planned
start date of the source project, then the start date for the target project task will be 10 days
after the start date that you specify for the target project.

Similarly, if you specify that the project timescale be based on an end date, the planned finish
dates for the target project tasks will be based on the relative period of time between the
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planned finish date of the source project tasks and the planned finish date of the source project.

Copying resource assignments

You can copy resource assignments from the tasks in the source project to the tasks in the
target project. If resource leveling is enabled for your organization, the copied task
assignments are validated for any resource leveling restrictions when you save the target
project. If resource requests are enabled at the initiative level and the option to override task
restrictions is not selected, then task assignments are not created.

Only the invalid task assignments in the source project that include planned hours are copied to
the target project and assigned to the default resource. The planned hours for the copied task
assignment will be the total hours of all of the invalid task assignments for the same task.

Copying staffing levels

You can copy the staffing levels from the tasks in the source project to the tasks in the target
project. Only the staffing levels that are valid and available are copied to the target project.

Copying project work locations and work codes

You can specify whether the selected work locations and codes, including the defaults, are
copied from the source project or from the initiative of the target project. In either case, only
the work locations and codes that are specified in the initiative of the target project are valid
for the target project. If you specify to copy the work locations and codes from the project and
none of them are valid, then the work locations and codes from the initiative of the target
project are used.

Note:When the work locations and codes are copied, the settings for expense overrides
and whether non-project locations can be used are also copied.

Copying work codes and locations for tasks

You can specify whether the selected work locations and codes for tasks and task assignments,
including the defaults, are copied from the source project. If the default work location and
work code from the tasks and task assignments of the source project are not valid for the target
project, then the default values from the target project are used.

If the selected work locations and codes for tasks and task assignments are not copied from the
source project, then the work locations and codes from the target project are used for new
tasks and task assignments.
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Note:When the work locations and codes are copied, the settings for expense overrides
and whether nonproject locations can be used are also copied.

Reassigning a project
Project managers can reassign a project to any resource that has access rights to edit the
project plan. When you reassign a project, the resource becomes project manager of the
project and has full edit rights, and you become a project plan editor.

1. Access the project for editing.

The Edit Project dialog box appears.

2. Click the Access tab.

3. In the Edit project plan list, right-click the resource to whom you want to reassign the
project and select Reassign.

4. Click OK to confirm.

5. Click Save.

Taking ownership of a project
Project plan editors can take ownership of a project if the project manager has enabled the
option on the project. When a project plan editor takes ownership of a project, the project plan
editor becomes the project manager and the project manager becomes a project plan editor.
Project managers can take back ownership of a project when necessary.

1. Access the project.

2. Click Actions > Transfer project to me.

About saving project baselines
After you have set up your project, you can save a baseline for the entire project, subproject,
summary task or individual task. This topic describes saving project baselines. For task
baselines, see "About saving task baselines" on page 67.

When you save a baseline for a project, the planned information for the project is rolled up
first to ensure that accurate information is available at the task, summary task and project
levels.

The baseline information for the project, summary tasks, tasks and task assignments, including
the date and time that the baseline was created and the resource who created it, is stored in
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the database. The following information is displayed in the Status information section of the
project profile:

• Baseline start – the earliest planned start date of all project tasks

• Baseline finish – the latest planned finish date of all project tasks

• Baseline hours – total planned hours for the project tasks

If the option to roll up planned information from subprojects to parent tasks has been enabled
for the parent project, then during summary tasks will be updated to also include the rolled up
information from subtasks and subprojects and the baseline information will be captured in the
general section of the summary task profile.

Note: The baseline functionality is not available for projects that are linked to Microsoft
Project. Also, if a parent project of the project being baselined is linked to Microsoft
Project, then baseline information will not roll up to the parent project.

You can save a baseline at any time. When you save a new baseline, the current and previous
baseline information is stored in the database. All baseline information can be accessed by
creating custom reports in Report Designer.

The project manager can also give resources the option to save a baseline for a task without
affecting higher-level tasks. Note however, that saving a baseline without affecting higher-
level tasks can result in the project and task baselines being out of balance.

Note: Some example project and task baseline scenarios are available. For more
information, see "Scenarios for saving baselines" on page 229.

Saving a project baseline

1. Access the project.

2. Click Actions > Baseline.

3. To view the baseline information:

a. Click  .

b. Expand the Status information section.

Project Management | 47



4. Managing Projects

About rolling up projects
When you roll up a project manually, the system rolls up the following information from the
task assignments to the tasks, and then from the tasks to the project:

• planned, actual, and forecast start dates – the earliest of each of these dates from the task
assignments becomes the planned, actual, and forecast start dates for the project

• planned, actual, and forecast finish dates – the latest of each of these dates from the task
assignments becomes the planned, actual, and forecast finish dates for the project

• planned, actual, and forecast hours – the totals of these hours from the task assignments
become the planned, actual, and forecast hours for the project

• remaining hours – the remaining hours (forecast hours) for the task assignments roll up to
the tasks and then the project

To ensure the project information is as accurate as possible, it is recommended that you roll up
a project after all of the project tasks have been created.

Rollup rules for open tasks

The planned start, finish and hours from the task assignments of open tasks do not roll up. Only
the actual and forecast dates and hours roll up to the open task and then to the project.

Rollup rules for summary tasks

The planned, actual and forecast information from the task assignments of both the summary
task and its subtasks roll up to the summary task and then up to the project.

Rollup rules for subprojects

The planned, actual and forecast information from the task assignments roll up to the tasks
which roll up to the parent task of the subproject and then to the parent project.

If the parent project has been configured to NOT roll up planned information from subprojects
to parent tasks, then only the actual and forecast information from the tasks assignments of the
tasks of the subproject is rolled up to the subproject task and then up to the parent project.

Automatic roll up of projects

Projects for which fiscal periods have been selected, and projects that belong to portfolios are
automatically rolled up by system updates. Projects are rolled up automatically in the following
situations:
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• When there is a change to the project that makes a rollup necessary, for example, changes
to planned, actual, and forecast information.

• The project has task assignments with loading methods that replace past data with actual
data. These projects are rolled up at the beginning of the fiscal period that was selected for
the project.

Rolling up a project

1. Access the project.

2. Click Actions > Rollup.

3. If a set of fiscal periods has been selected for the project, a message appears. Do one of
the following:

• To roll up the project information and update the information in the Fiscal year
breakdown section of the project profile, click OK.

• To roll up the project information only, click Cancel.

The planned, actual and forecast information is rolled up and updated in the task and
project profiles.
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About tasks

After a project is created, the next step is to create tasks and assign them to resources. You
can create the following type of tasks for your projects.

Tasks

You create tasks for specific project work and assign them to resources. Only the resources
who are assigned to a task can enter time for it.

Summary tasks

Summary tasks are tasks that contain subtasks, which are the tasks grouped under them in
the Projects tree view. You use summary tasks to organize the major phases and subphases
in a project.

By default, time can be entered for summary tasks. During project rollup, the time amounts
from the subtasks are added to the summary task amounts.

Tip: To prevent time entry on a summary task or its subtasks, select the Locked
taskcheck box on the task.

Open tasks

Open tasks are tasks that all resources assigned to the project can log time against.
Examples are status meetings or for tasks that can be performed by any resource in a
resource pool. You can also use open tasks to track non-project related tasks instead of using
non-project time buckets that must be configured by the system administrator. You can
restrict access to an open task by role or workgroup. Open tasks cannot contain subtasks and
therefore cannot be summary tasks. When a resource enters time for an open task, a task
assignment is automatically created for the resource.

If resource leveling is enabled, the planned hours for open tasks is 0 (zero) and cannot be
edited.

If resource leveling is not enabled, you can specify the planned hours for an open task so that
when a resource logs time against the task, the planned hours are automatically defined.

Task icons

The following table list the various task icons and their descriptions.
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Task Icon Description

A green task icon indicates that you are assigned as a resource to the task.

Assigned tasks are also included in the Time Sheet tree view.

A gray task icon indicates that you have access to view the task, but are not

assigned to the task.

A task icon with a diamond indicates the task is a project milestone.

A task icon with a circled check mark icon indicates the task is complete.

Accessing a task
You can only access the tasks to which you are assigned, and tasks within a project for which
you are the project manager, project plan editor or summary task manager.

1. Click General > Projects.

The Projects tree view appears.

Tip: To locate a task, you can enter the full or partial task name in the Filter field and
then click Filter. The tree view displays the projects that contain tasks that match the
filter text.

2. Expand the Projects tree view to display the tasks.

3. Select the task.

The task profile appears.

About creating tasks
After creating a project, you create a task for each activity that you want to track.

You can create tasks from many different starting points. The starting point determines the
amount and type of task-related data that is automatically completed for the task. For example,
if you create a task from a project, then the project-related information will automatically be
completed for the task. However, if you create a task from the toolbar, then you must select
the project information yourself. You can choose from any one of the following starting points:

• From the New menu in the navigation bar.

• From the Projects tree view, by right-clicking a project and selecting Create task.

52 | Changepoint PPM2017 SP1



About creating tasks

• From a project profile using the Actions menu.

• From the project worksheet. For more information, see "About creating tasks in the project
worksheet" on page 97.

• From a request profile, using the Actions menu.

Task editing view, General section options

Option Description

Project list Project for the task.

Task name field Name for the task.

Planned start date field Date that the task should start. The default date is the date that

the task is created.

Planned finish date field Date that the task should be completed. The default date is the

day after the date that the task is created.

Planned hours field Estimated number of hours that are required to complete the

task. The planned hours for the task must equal the total of the

planned hours for the task assignments.

Project phase field Project phase that the task applies to. For more information, see

"About project phases" on page 18.

Staffing level type-ahead
field

Default staffing level for resources that are assigned to the task.

You can override the default whenmaking specific staff

assignments. The staffing levels come from the initiative. If no

staffing levels are specified for the initiative, or the default was

cleared for the task, the task assignment is created without a

staffing level.

Function list Default job function for resources that are assigned to the task.

You can override the default for task assignments.

Request type-ahead field Number of the request that is associated with the task.

Project Management | 53



5. Managing Tasks

Option Description

Locked task check box When selected, prevents resources from entering time for the

task assignments for the task. However, you can change the

setting for individual task assignments.

Include in resource
demand check box

When selected, new task assignments created for this task are

included in resource demand analysis by default. Selected by

default on new tasks.

The setting for this field is also used as filter criteria for task

assignments in the resourcemanagement worksheet.

You can override the default for task assignments.

Open task check box When selected, makes the task an open task and the

Assignment planned hours field appears.
For more information, see "Open tasks" on page 51.

Chargeable task check
box

When selected, makes the task chargeable.

Cross-charged to fixed-
fee portion of the
initiative check box

When selected, cross charges the task to a fixed-fee portion of

the initiative. The time entered for this task does not display on

the cross charge.

Fixed fee list Deliverable to which the task is associated, if theCross
charged to fixed-fee portion of the initiative option is
selected. Specifying a deliverable allows costs and revenues to

be tracked against fixed fees.

Utilization eligible
check box

When enabled, the task time is included in the utilization for

assigned resources.

For chargeable projects, the option is automatically selected.

For non-chargeable projects, the option is automatically cleared.

The project manager can change the utilization eligible setting of

any task.

Milestone check box When selected, identifies the task as amilestone on theGantt

chart.
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Option Description

Capital check box When selected, designates the task as a capital cost.

Completed check box When selected, sets the task to completed status. Typically

used for tasks that are not assigned to resources, such as

milestone tasks. When a task is set to complete, the status for

the task assignments is automatically set to complete.

The task is automatically set as completed when all of its task

assignments are completed.

Add to calendar check
box

When selected, the planned hours for the task are included in

the personal calendars of the assigned resources and the

resource scheduling calendar.

Initiative non-labor
items field

Non-labor items that can be associated with the task and cross

charged based on the status of the task.

Intiative non-labor item
ready to cross-charge
check box

When selected, the non-labor item that is associated with the

task becomes available for cross charging.

Comments field Additional information about the task. Comments can be viewed

by all resources assigned to the task.

Creating a task

You can create a task for planning purposes by completing only the following fields in the
General section:

• Task name

• Project

• Planned start

• Planned finish

• Planned hours

After you have saved the task, you can complete the remaining fields and sections as required.
For a list and description of all task fields, see "Task editing view, General section options" on
page 53.
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1. Click New > Task.

The task editing view appears.

2. In the Task name field, type the task name.

3. In the Project field, select the project for which the task is being created.

4. In the Planned start field, enter the date that you expect the task to be started.

5. In the Planned finish field, enter the date you expect the task to be finished.

6. In the Planned hours field, enter the estimated number of hours required to complete the
task.

7. Do one of the following:

• To save the task, click Actions > Save. The task is created.

• To complete the remaining task sections, see "Completing the General section of the
task editing view" on page 56.

Completing the General section of the task editing view

For more information about the task fields, see "Task editing view, General section options"
on page 53.

1. Access the task.

2. Click Actions > Edit.

The edit task view appears.

3. Complete the fields as required.

4. To make the task an open task:

a. Select the Open task check box. The Assignment planned hours field displays. If
resource leveling is enabled, the value is 0 and cannot be edited.

b. If resource leveling is not enabled, you can specify planned hours for the open task.

5. To charge the task to a fixed fee portion of the initiative:

a. Select the Charged to fixed fee portion of the Initiative option.

b. In the Fixed fee field, specify the deliverable to which the task is associated.
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6. Click Actions > Save.

7. To complete the remaining sections, see the following topics:

• "Changing the work location and work code settings for a task" on page 76

• "Assigning a resource to a task assignment" on page 57

• "Associating a task to an application" on page 57

Associating a task to an application

You can associate a task to one or more applications. The first application you select is
marked as the primary application and is used for reporting purposes.

1. Access the task.

2. Click Actions > Edit.

The edit task view appears.

3. Expand the Applications section.

4. Expand the tree view and select the check boxes of the applications associated with the
task.

Tip: To change the primary application, click the name of the new primary application
instead of the check box.

5. Click Save.

Assigning a resource to a task assignment
You can assign resources to tasks from the task editing view by creating a task assignment.
When you create a task assignment, most of the fields have the same values as in the task, but
they can be changed. The resources that you can assign to a task come from your preferred
resources list.

1. Access the task.

2. Click Actions > Edit.

The task editing view appears.

3. Expand the Assignments section.
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4. Complete the fields as required. For more information, see "Task editing view,
Assignments section options" on page 58.

5. To specify a resource, in the Resource list, select the name of the resource that you want
to assign to the task.

6. To add a resource to the list (and optionally to your preferred resources), click , which

opens the Select Resources dialog box.

7. To specify the planned start and planned finish dates, do one of the following:

• Enter the dates in the Planned start and Planned finish fields.

• To have the system allocate effort for this task assignment, and calculate the planned
start and finish dates, see the "About allocating planned hours for a task assignment
automatically" section on page 64.

8. In the Assignments section, click Actions > Save.

The resource is added to the task assignment table.

9. On the task editing view, click Actions > Save.

Task editing view, Assignments section options

Option Description

Resource list Resource assigned to the task.

Planned start date field Date that the task should start. The default date is the date

that the task is created.

Planned finish date field Date that the task should be completed. The default date is

the day after the planned start date.

Planned hours field Estimated number of hours that are required to complete

the task. The planned hours for the task must equal the

total of the planned hours for the task assignments.
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Option Description

Allocate effort based on
resource's current
committed workload check
box

When selected, the effort is allocated and the planned start

and finish dates are calculated automatically.

Staffing level type-ahead field Default staffing level for resources that are assigned to the

task. You can override the default whenmaking specific

staff assignments. The staffing levels come from the

initiative. If no staffing levels are specified for the initiative,

or the default was cleared for the task, the task assignment

is created without a staffing level.

Cross charge rate field Cross charge rate for the resource.

Staffing level cost rate and
Resource cost rate fields

Staffing level-based or resource-based cost rate that is

applicable to the task assignment.

Function list Default job function for resources that are assigned to the

task. You can override the default for task assignments.

Locked task check box When selected, prevents resources from entering time for

the task assignments for the task. However, you can

change the setting for individual task assignments.

Include in resource demand
check box

When selected, new task assignments created for this

task are included in resource demand analysis by default.

Selected by default on new tasks.

The setting for this field is also used as filter criteria for

task assignments in the resourcemanagement worksheet.

You can override the default for task assignments.

Status not required check
box

When selected, resources are not required to update the

status of their task assignments.

Work location group list
Work location list

Work location group and work location where the work will

be performed.
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Option Description

Work code category list
Work code list

Work code category and work code of the task.

Allow work location
override check box

When selected, resources can choose a different work

location when they enter time for the task.

Allow work code override
check box

When selected, resources can choose a different work

code when they enter time for the task.

Soft-booked check box When selected, the resource is tentatively booked for

planning purposes. Soft-booked time is shown as flexible

on the resource schedule calendar.

When cleared, the resource is committed to the project.

Assignment comments field Additional information about the task assignment.

About selecting resources for tasks

The following options to help you select resources are available from the Actions menu on the
Assignment section of the task editing view:

• Check available hours to check if each assigned resource has enough available hours to
cover the planned hours for the task. For more information, see "Checking the available
hours of a resource" on page 60.

• Resource search to search for an available resource. For more information, see
"Resource Searches" in the Resource Management User Guide.

• Resource availability to view the calendar of a resource. For more information, see the
"Resource Scheduling Calendar" in the Resource Management User Guide.

Checking the available hours of a resource

To avoid overbooking resources, you can check their available hours directly from the task
editing view.

1. Access the task.

2. Click Actions > Edit.

The edit task view appears.
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3. Expand the Assignments section and verify the Planned hours values for each of the
resources.

4. In Assignments section, click Actions > Check available hours.

The Check Available Hours dialog box appears. For more information, see "About
checking the available hours for resources" on page 61.

When the planned hours for the task exceed the available hours for a resource, the values
are displayed in red. However, you can still assign the task to the resource.

About checking the available hours for resources

The Check Available Hours dialog box displays the following information for each resource
listed in the Assignment section of the task editing view.

Resource name and task duration

The duration of the task is displayed next to the resource name. If the task status has not been
updated, then the Planned start and Planned finish dates are used for the task duration. If the
task status has been updated, then the Actual start and Forecast finish dates are used.

Planned hours for this task

The planned hours for the current task.

Planned hours for all other tasks

For each task other than the current task, the total planned hours for the task are divided by the
number of working days in the task duration to calculate a daily amount. The total of the daily
amounts for the tasks is then multiplied by the number of working days for the current task. If
the task status has been updated, then Remaining hours are used instead of Planned hours.

Resource calendar entries

The total hours from all calendar entries, excluding the task assignment entries.

Available hours

Available hours = Total working hours – (Planned hours for all other tasks + Resource
calendar entries)

Total working hours = Number of working days in the task duration * daily capacity for the
resource
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If the available hours is less than the planned hours for the current task and resource, then all
of the values for the resource display in red. If the available hours is 0 or less, then 0 is
displayed.

Example of Check Available Hours calculations

This example consists of a current task for a resource, who has also been assigned task A and
task B during the same time period, and an explanation of how each of the values in the
Check Available Hours dialog box is calculated.

Current task information

Planned start: Monday, January 1

Planned finish: Monday, January 8

Planned hours: 15

Non-working days: Monday, January 1 (legal holiday), Saturday, January 6, and Sunday,
January 7

Working days in the task duration = 8 – 2 weekend days – 1 legal holiday = 5 days

Daily capacity (specified in user setup) = 8

Total working hours: 5 * 8 = 40

Planned hours for this task = 15

The planned hours for the task in this example is 15, which comes from the task assignment.

Planned hours for all other tasks = 14

The planned hours for this task is 14, calculated as follows:

Task A, status has not been updated

Planned start: January 2

Planned finish: January 11

Working days in task A duration = 8 days

Planned hours = 16

Planned hours per day: 16 / 8 = 2

Planned hours for the current task duration (January 2 to 8) = 2 * 5 = 10
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Task B, status has been updated

Actual start: January 5

Forecast finish: January 10

Remaining hours = 8

Working days in task B duration = 4 days

Planned hours per day: 8 / 4 = 2

Planned hours for the current task duration (January 5 and January 8): 2 * 2 = 4

Total planned hours for task A and task B: 10 + 4 = 14

Resource calendar entries = 12

The resource has three calendar entries, each for 4 hours.

4 * 3 = 12

Available hours = 14

The available hours is 14.

Available hours = Total working hours – (Planned hours for other tasks + Resource calendar
entries)

40 – (14 + 12) = 14

The values in the Check Available Hours dialog box would display in red because the
available hours (14) is less than the planned hours (15) for the current task.

About viewing cross charge rates and cost rates in task assignments

If you have view access rights to cross charge rates, the Cross-charge rate column and either
Resource-based cost rate or Staffing level-based cost columns display in the task assignment
table, and the corresponding fields display in the Assignments section. The rates come from
the cost structure and cannot be edited.

You can show or hide the cross charge rate and cost columns that display in the task
assignment table. Right-click anywhere on the task assignment table and select the appropriate
option (Hide/show cross charge rates, Hide/show cost rates).

Project Management | 63



5. Managing Tasks

About allocating planned hours for a task assignment automatically

If your organization uses resource leveling, you can have the system allocate effort (planned
hours) for a task assignment based on the availability of the resource. The system calculates
the resource’s availability based on the following formula:

daily capacity * (percent available / 100) – committed resource demand hours

Where:

• daily capacity is the number of hours specified in user setup

• percent available is the percent available for planned work for the workgroup that the
resource belongs to

• committed resource demand hours are the hours from demand items that resource has
already been committed to

You also specify that the planned start and/or planned finish dates should be calculated
automatically:

• Planned start date only – planned hours are allocated starting from the planned finish date
and then to each working day before the finish date until all of the planned hours are
allocated. The earliest date for which planned hours are allocated becomes the planned
start date.

• Planned finish date only – planned hours are allocated starting from the planned start date
and then to each working day after the planned start date until all of the planned hours are
allocated.

• Both planned start and planned finish – the first date that the resource has hours available
and which is on or after the current date or the earliest planned start date (whichever is
later) becomes the planned start date.

Planned hours are allocated starting from the planned start date and then to each working
day after it until all of the planned hours are allocated. The latest working day for which
planned hours have been allocated becomes the planned finish date.

In all cases, if the calculated planned start date is earlier than the original planned start date or
the calculated planned finish date is later than the original planned finish date for the task, then
the original planned dates for the task are changed accordingly.
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Note: If project-level resource requests are enabled, then the hours can be allocated only
within the planned start and finish dates in the approved resource request.

Allocating effort for a task assignment automatically

1. Access the task.

2. Click Actions > Edit.

The edit task view appears.

3. Expand the Assignments section.

4. In the Resource list, select the resource.

5. Select the Allocate effort based on Resource’s current committed workload check
box.

6. To specify the earliest date that the task assignment can start:

a. Select the Calculate start date check box. The Planned start field changes to No
earlier than.

b. Enter the earliest acceptable start date.

7. To specify the latest date that the task assignment can end:

a. Select the Calculate finish date check box. The Planned finish field changes to
No later than.

b. In the No later than field, enter the latest acceptable finish date.

8. Click Allocate effort.

The dates in the Planned start field and Planned finish fields are updated based on the
allocation calculation.

Submitting resource requests for tasks
If resource requests have been enabled for tasks, you cannot assign a resource to a task
directly. You must first submit a resource request, which must be approved by a resource
manager.

1. Access the task.

2. Click Actions > Edit.

Project Management | 65



5. Managing Tasks

The edit task view appears.

3. Expand the Assignments section.

4. In the Planned hours field, enter the estimated number of hours required to complete the
task.

5. In the Planned start field, enter the planned start date for the task assignment.

6. In the Planned finish field, enter the planned finish date.

7. In the Staffing Level type-ahead field, enter a staffing level for the task assignment.

8. To request a specific job function, in the Function list, select the function.

The qualifications for the function appear in the Qualifications field.

9. To request a specific resource, in the Requested resource type-ahead field, enter the
name of the resource.

10. In the Number of resource requests field, enter the number of resources that you
require.

11. If no function and no resource is specified, in the Qualifications field, you can select
specific skills and competencies for the resource request.

12. To mark a qualification as preferred, right-click the qualification and then select Set as
preferred.

13. In the Assignment comments field, enter instructions for the resource manager.

14. In the Assignments section, click Actions > Save.

The resource request is added to the assignment table and is marked as soft-booked.

15. At the top of the task editing view, click Actions > Save.

The request is submitted to the resource manager for approval.

Deleting resources from task assignments

You can delete resources from task assignments provided that none of the following conditions
exist:

• the resource has entered time or expenses for the task assignment

• the parent task is associated with a subproject
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• there are outstanding resource requests that have not been canceled

If any of the above conditions exist for a resource, the delete option will not be available.

1. Access the task editing view.

2. Expand the Assignments section.

3. Select the resource in the assignments table.

4. In the Assignments section, click Actions > Delete.

5. Click OK to confirm.

6. In the task editing view, click Actions > Save.

About saving task baselines
You can save baselines for summary tasks, subtasks and tasks. When you save a baseline for a
task, the planned information is first rolled up to the project level. If the option to roll up
planned information from subprojects to parent tasks has been enabled for the parent project,
then summary tasks will be updated to include the rolled up information from subtasks and
subprojects. The system does not check whether resources have access to the subprojects
before performing the rollup.

After the rollup, the baseline information for the task and its task assignments and the
subprojects and projects above it in the WBS is saved. If the task is a summary task, then the
baseline information for all tasks below the summary task and the project above it is also
saved. If the task is a subtask, then the baseline information for all tasks and task assignments
below the subtask, and the summary task and project above it is saved.

When you save a task baseline, the system uses the previous (most recent) baseline values for
the other project tasks and task assignments when they are required to calculate summary task
and project baselines.

Example of saving task baselines

In the following table, the Initial baseline column shows the baseline planned hours for a
project after an initial baseline. The Updated column shows that the planned hours for
subtask 1.1 and 1.2 were changed to 7 hours each. The Baseline subtask 1.1 column shows the
baseline planned hours after a baseline was saved for subtask 1.1, which the system calculated
by using:
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• the updated planned hours for subtask 1.1 and the previous baseline planned hours for
subtask 1.2, to calculate the baseline planned hours for task 1

• the previous baseline planned hours for subtask 2.1 to calculate the baseline planned hours
for task 2

• the previous baseline planned hours for task 2 and the updated planned hours for task 1 to
calculate the baseline planned hours for project 1

Project item

Initial
baseline
planned
hours

Updated
planned
hours

Baseline
subtask 1.1
planned hours

Project 1 (rolled up from tasks 1 and 2) 21 22

Task 1 (rolled up from subtasks 1.1 and

1.2)

11 12

Subtask 1.1 6 7 7

Subtask 1.2 5 7 5

Task 2 (rolled up from subtask 2.1) 10 10

Subtask 2.1 10 10

After a baseline is saved, the following information is displayed in the task profile and task
assignment profile:

• Baseline start – the earliest planned start date of the tasks

• Baseline finish – the latest planned finish date of the tasks

• Baseline hours – total planned hours for the tasks

Note: For some example project and task baseline scenarios, see "Scenarios for saving
baselines" on page 229.

You can save a task baseline at any time. When you save a new task baseline, the previous
baseline information is stored in the database. All stored baseline information can be accessed
by creating custom reports using Report Designer.
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Saving a task baseline

1. Access the task.

2. Click Actions > Baseline.

The Baseline start, Baseline finish, and Baseline hours are updated based on the current
planned start date, finish date and hours of the task or subtasks.

3. Refresh the details view to display the baseline information for the task and task
assignments.

About saving a task baseline without affecting higher level tasks

Normally when a task baseline is saved, the system rolls up the baseline for all affected tasks
below the selected task to the selected task itself, and then up to the appropriate project level
above the selected task in the WBS. For more information, see "About saving task baselines"
on page 67.

However, the project manager can enable the option to save a task baseline without affecting
higher level tasks. If this option has been enabled for a project, when resources save a task
baseline, they have the option to save the task baseline as usual, or up to the selected task level
only.

Warning: Saving a baseline without affecting higher-level tasks can result in the project
and task baselines being out of balance.

If the option to roll up planned information from subprojects to parent task is enabled, it takes
precedence over the option to save a baseline without affecting higher level tasks. In this case,
if you baseline a subtask of a subproject, the baseline will be rolled up to the parent task even
if you select the option to baseline without affecting higher level tasks.

For some example project and task baseline scenarios, see "Scenarios for saving baselines" on
page 229.

Saving a task baseline without affecting higher level tasks

1. Access the task.

2. Click Actions > Baseline.

A dialog box appears.

3. Select one of the following options:
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• To save the baseline as usual, select Baseline all tasks above and below the selected
task.

• To save the baseline without affecting higher level tasks, select Baseline only the
selected task and tasks below it.

4. Click OK.

5. Refresh the details view to display the baseline information for the task and task
assignments.

Restricting access to an open task

You can restrict access to open tasks to specific workgroups and roles. However, the
resources who have been assigned to an open task can enter time for the task regardless of any
access restrictions.

1. Access the task.

2. Click Actions > Edit.

The edit task view appears.

3. Expand the Restrict access for open tasks section.

4. To enable access restrictions, select the Changepoint users allowed to enter time
against this task check box.

5. Select the check boxes for the workgroups and roles that can enter time for the task.

6. To automatically include the workgroups that are below the selected workgroups in the
hierarchy, select Include children.

7. Click Actions > Save.

Note: The access restrictions are automatically removed if the Open task check box is
cleared on the task editing view.

About task dependencies (linked tasks)
You can create the following types of task dependencies between tasks in the same project or
in different projects:

• finish-to-start – successor task cannot start until on or after the predecessor task finish
date
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• start-to-start – successor task cannot start until on or after the predecessor task start date

• finish-to-finish – successor task cannot finish until on or after the predecessor task finish
date

• start-to-finish – successor task cannot finish until on or after the predecessor task start date

Note: Changepoint handles start-to-finish dependencies slightly differently than Microsoft
Project. In Changepoint, the predecessor finish date is the working day before the
successor start date, whereas in Microsoft Project, the predecessor finish date is the same
date as the successor start date.

You can link tasks from the same or different projects in the task profile. You can link tasks in
the project worksheet or PPW, but both tasks must be in the same project.

You cannot change the start date of the successor task directly if the start date is determined
by the predecessor task. Similarly you cannot change the finish date of a successor task
directly if the finish date is determined by the predecessor task.

Task dependency options

Field Description

Dependency type field Dependency type. Options are:

• Finish-to-start (default)

• Start-to-start

• Finish-to-finish

• Start-to-finish

Lag time field Number of days between planned start date or finish date of

the predecessor task and the planned start date or finish

date of the successor task, according to the dependency

type. Default value is 0 days.

Move successor task date check
box

When enabled, does the following:

• allows the successor task dates to bemoved when the

predecessor task is moved

• when the predecessor task is moved, removes any gap

between the linked tasks according to the constraints

of the dependency type

Selected by default.
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Field Description

Successor can start anytime
after the predecessor check box

When enabled, if a predecessor task is moved, the

successor task dates aremoved only when required to

ensure that the successor starts after the predecessor.

Cleared by default.

Send notification check box When enabled, sends an email notification to the project

manager when the planned dates aremoved due to task

dependencies. Selected by default.

Linking tasks from the task profile

In the Create Task Dependency dialog box, the Successor tasks tab displays a table of the
tasks that are already linked to the current task. When the View selected tasks option is
selected, a project tree view displays under the options that shows the hierarchy of linked
tasks. On the Successor tasks tab, you configure dependencies in which the current task is a
predecessor task. On the Predecessor tasks tab you configure dependencies in which the
current task is a successor task.

1. Access the task.

2. Click Actions > Create > Task dependency.

The Create Task Dependency dialog box appears.

3. In the Successor tasks tab, selectModify selected tasks.

A project tree view displays all of the projects and related tasks to which you have edit
access rights.

4. Expand the tree view to locate the successor task. Tasks that are already successor tasks
of the current task are displayed in bold font.

5. Double-click the successor task.

The task is added to the table.

6. Specify the options as required. For more information, see "Task dependency options" on
page 71.

7. To save the link, click in the table, but outside of the current row.

8. Click OK to confirm.
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9. Click OK.

10. To specify a predecessor task:

a. Click the Predecessor tasks tab.

b. Create the link as described above.

11. Click Close.

Unlinking tasks from the task profile

1. Access the task.

2. Click Actions > Create > Task dependency.

The Create Task Dependency dialog box appears.

3. Do one of the following:

• Right-click the successor task in the table and select Delete.

• Click the Predecessor tab and then right-click the predecessor task in the table and
click Delete.

The task is unlinked and removed from the table.

4. You can unlink tasks from tree view at the bottom of the dialog:

a. Select the Modify selected tasks option.

b. Search for the task or expand the tree view to locate the linked task. The names of
linked tasks are in bold text.

c. Right-click the linked task and select Remove from successor task or Remove from
predecessor task. The task is unlinked and removed from the table.

5. Click Close.

Accessing the task editing view
1. Click General > Projects.

The Projects tree view appears.

2. Expand the project that the task belongs to.

3. Do one of the following:
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• Double-click the task name.

• Right-click the task name and select Edit.

• Select the task to open the task profile and then click the Actions menu and select
Edit.

The task editing view appears.

About editing the Chargeable status of a task

If you change the chargeable status of a task, the Effective date check box appears.

If you specify an effective date, then the time records from the effective date and later use the
new chargeable status. All cross charges created before the effective date use the previous
chargeable status.

If you do not specify an effective date, all time records that have not been cross charged use
the new chargeable status.

If an effective date was previously entered for the chargeable status, and you do not specify an
effective date, then all of the time records use the new chargeable status.

For example, a new task is marked as chargeable, and time is entered for May 1 to 5. If the
chargeable option is later cleared and an effective date of May 3 is specified, then time for
May 1 and 2 would be chargeable, but time for May 3, 4 and 5 would be non-chargeable.
However, if the chargeable option is cleared and an effective date is not specified, time for
May 1 to 5 would be non-chargeable.

You cannot change the Chargeable task option if any of the following conditions exist:

• the initiative has not been configured to allow project managers to override the chargeable
status

• the split charges option has been enabled on the initiative, and cross charges exist under
the initiative or phantom initiative which is in Archive status

• the split charges option has been enabled on the initiative, and all cross charges have been
committed but there is time under the initiative or phantom initiative that has not been fully
cross charged
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About editing configurable fields on tasks

When you create a task, the values of the configurable fields for the task are automatically
applied to task assignments, even if you create the task assignments at the same time as you
are creating the task. However, if you edit the values for a configurable field and you want the
new value to be applied to new task assignments, you must save the task first before creating
the new task assignments.

Changing the staffing level for a task

When you change a staffing level, you must also specify an effective date for the change. You
must ensure that the appropriate staffing level is in effect when time records for the task
assignment are cross charged. Changes made to the staffing level are tracked in the task
assignment history.

Note: You cannot change the effective date for a staffing level once you have saved it,
and subsequent changes to staffing levels must have an effective date that is later than the
current effective date.

1. Access the task.

2. Click Actions > Edit.

The edit task view appears.

3. Expand the Assignments section.

4. Select the row for the resource whose staffing level is being changed.

5. In the Assignments section, click Actions > Change staffing level.

The Change Staffing Level dialog box appears.

6. In the Staffing level list, select the new staffing level.

7. In the Effective date field, enter the effective date of the new staffing level.

8. Click Save.

9. Click OK to confirm.

10. In the Assignments section, click Actions > Apply.

11. At the top of the task editing view, click Actions > Save.
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Changing the work location and work code settings for a task

The default work locations and work codes come from the project, but you can change them
for tasks. You can also allow resources to choose a different work location or code when they
enter time for a task.

1. Access the task.

2. Click Actions > Edit.

The edit task view appears.

3. Expand the Work locations/work codes section.

4. In the Work location group list, select the general location where the work will be
performed.

5. In the Work location list, select the specific work location where the work will be
performed.

6. From the Work code category list, select the work code category.

7. From the Work code list, select the work code.

8. To allow resources to choose a different work location when they enter time for the task,
select the Allow work location override check box.

9. To allow resources to choose a different work code when they enter time for the task,
select the Allow work code override check box.

10. Click Actions > Save.

Deleting a task

You cannot delete a task if either of the following conditions exist:

• chargeable time has been entered for the task and that time has not been cross charged

• an expense has been associated to the task

Also, if the Add to calendar option is enabled on the task when it is deleted, the planned
hours for the task are removed from the personal calendar of the assigned resources and from
the resource scheduling calendar.

1. Access the task.

2. Click Actions > Edit.
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The edit task view appears.

3. Click Actions > Delete.

4. Click OK to confirm.

About reopening a completed task

Project managers, and the resources that are assigned to a completed task, can reopen the task
provided that the project is still active. If the task has locked task assignments, you must
unlock them first.

When you reopen a task, all of its task assignments are reopened with the following settings:

• percentage complete is set to 99

• remaining hours is set to 1.00

• actual finish date is cleared

When you reopen a subtask, the summary task is also reopened. Reopening a subtask
automatically opens all related tasks up to the highest level.

Reopening a completed task (for project managers)

This procedure applies to project managers. For the procedure for resources, see "Updating the
Status of a Task" in the Time and Expense Management User Guide.

1. Access the task.

2. Click Actions > Edit.

The edit task view appears.

3. Expand the Assignments section.

4. If there are locked task assignments that you want to reopen, you must unlock them.

a. Select the task assignment.

b. Clear the Locked task check box.

c. In the Assignments section, click Actions > Save.

d. Repeat for each locked task assignment.

5. In the General section, clear the Completed check box.

Project Management | 77



5. Managing Tasks

6. Click Actions > Save.

A message appears, asking if you want to reset the forecast dates.

7. Do one of the following:

• To reset the forecast start and finish dates to the planned start and finish dates for all
reopened task assignments, click OK.

• To leave the dates unchanged, click Cancel.

Sorting tasks

You must use the project worksheet to change the order of tasks. For more information, see
"About moving tasks in the project worksheet" on page 96.
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Project worksheet basics

The project worksheet provides a complete view of the tasks, task assignments and
subprojects associated with a project in a spreadsheet format. The fields that are in the task
editing view are displayed as columns in the project worksheet. You can do everything in the
project worksheet that you can do in the task editing view, with a few exceptions. The
exceptions are described in the corresponding topics.

When you access the project worksheet for the first time, the system default view displays,
which lists the project tasks in WBS order with the following columns:

• Edit (indicates when the task is locked for editing)

• Task name

• Planned start

• Planned finish

• Planned hours

• Staffing level

• Fiscal period, which displays up to 24 fiscal period or up to 31 daily periods

The Edit and Task name columns are frozen, that is, they remain displayed when you scroll
to the right to view the other columns. Up to 24 fiscal periods or up to 31 daily periods are
displayed in chronological order, starting with the fiscal period or daily period that includes
the current date.

You can temporarily rearrange the columns by dragging them into a different order.
However, to save changes to the column order, you must create a project worksheet view. In
the project worksheet view you can change the order of the columns, add additional columns,
and change the columns that are frozen. For more information, see "Creating a project
worksheet view" on page 85.

You can adjust the width of the columns by dragging the line between the column headings.
The column widths that you set for each project worksheet view are saved automatically.

Accessing the project worksheet

1. Click General > Projects.
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The Projects tree view appears.

2. In the tree view, do one of the following:

• Right-click the project and select Project worksheet.

• Click the project to open the project profile, and then click Actions > Project
worksheet.

The project worksheet appears.

Expanding and collapsing tasks in the project worksheet

You can show and hide the task assignments and subtasks under a task by expanding and
collapsing tasks, subtasks or the entire project as follows:

• To expand a single task or subtask, click the plus sign (+) next to the task or subtask name.

• To collapse a single task or subtask, click the minus sign (–) next to the task or subtask
name.

• To expand or collapse all subtasks under a task or subtask, click the task or subtask row
and then click  or  .

• To expand or collapse all tasks and subtasks in a project, click the project row and then
click  or  .

Note: If the project is large, it may take a while for all tasks to be expanded.

Switching between fiscal and daily periods in the project worksheet

When fiscal periods have been selected for a project, you can display either fiscal or daily
periods on the project worksheet.

1. To switch from fiscal periods to daily periods:

a. To start the daily periods from the first date of a specific fiscal period, click the
column header for the fiscal period. Otherwise the daily periods start from the first
date of the first fiscal period.

b. Click  .

2. To switch from daily periods to fiscal periods
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a. To start the fiscal periods from the fiscal period that includes a specific daily period,
click the column header for the daily period. Otherwise the fiscal periods start from
the fiscal period that includes the first daily period.

b. Click  .

Displaying time periods that start from a specific date in the project
worksheet

Do one of the following:

• Click in the date field  , enter a date, and then press Enter.

• Click  and then select a date.

The range of fiscal periods, starting with the fiscal period that includes the specified date or
the range of daily periods, starting with the daily period for the date, is displayed. If you select
a date for which no fiscal or daily periods have been configured, then no periods are displayed
at all.

Displaying the previous or next specified number of periods in the project
worksheet

1. Access the project worksheet.

2. In the number of periods field  , do one of the following:

• for fiscal periods, type the number between 1 and 24 (x) for the number of fiscal
periods that you want the starting fiscal period to change by

• for daily periods, type the number between 1 and 31 (x) for the number of daily periods
that you want the starting fiscal period to change by

3. To display the range of periods that starts with the x number of periods before the current
starting period, click  .

4. To display the range of periods that starts with the x number of periods after the current
starting period, click  .
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Running reports in the project worksheet

You can run reports that have been configured to appear in the Actions menu of the project
and/or task profiles.

1. Access the project in the project worksheet.

2. To run a project report, click Reports > Project > [report name].

3. To run a project report for a subproject:

a. Click the subproject row.

b. Click Reports > Project > [report name].

4. To run a task report:

a. Click the task that you want to base the report on.

b. Click Reports > Task > [report name].

5. If a report filter page appears, complete the fields, and then click Run.

Performing searches in the project worksheet

You can do searches to locate tasks and task assignments. The search starts from the currently
selected row and goes down to the bottom of the project worksheet. You can search all
columns or a single column.

1. Access the project worksheet.

2. In the Search field, enter the first few characters of the information that you want to
search for.

3. Click the row that you want to start the search from.

4. To limit the search to a column, click the column heading.

Tip: You can identify the scope of the search by pointing to the search  icon. A tooltip

indicates whether the search is for all columns or a specific column.

5. Click  .

The first row (below the selected row) that includes information that starts with the search
text is highlighted.
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6. To continue the search, click  again.

Note: The search stops at the bottom of the project worksheet.

About errors in the project worksheet

Errors in the values entered for tasks are indicated in the following ways:

• Red cell – indicates an error. You cannot save the task until the error is corrected. Point to
the cell to display a tool tip with the reason for the error.

• Yellow cell – indicates a warning that there may be a potential problem with the value, but
you can still save the task. Point to the cell to display a tool tip with the reason for the
error.

• Messages about errors in hidden columns – You must first edit the worksheet view to show
the hidden column, and then fix the error before you can save the task.

About printing the project worksheet

You can print the project worksheet by clicking  . This print option prints a default print

area that is determined by the page size and margins, and cannot be adjusted. The printout
includes each row from the project worksheet, but will only include as many columns that will
fit in the default margins for the printout page.

To print the entire project worksheet, try the following options:

• In the Print dialog box, change the paper orientation to landscape to print more columns.
For more information, see the Microsoft Windows or Print dialog box online help.

• Remove some of the columns from the project worksheet view. For more information, see
"Creating a project worksheet view" on page 85.

• Export the project worksheet data to Microsoft Excel and then print from Excel. For more
information about exporting to Excel, see the "About exporting the project worksheet data
to Microsoft Excel" section on page 84.

Printing the project worksheet

1. Access the project worksheet.

2. Click  .

The Print dialog box appears.
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3. Click OK.

The project worksheet is printed.

About exporting the project worksheet data to Microsoft Excel

You can export the data in the project worksheet to a Microsoft Excel file. All of the data in
the project worksheet is exported exactly as it is displayed, including unsaved changes and
columns that you would need to scroll to view, but excluding the Edit column. Also, the
project items in the Task name column are not indented.

If a row is collapsed, then only the row is exported and not the tasks, subtasks or task
assignments under it. If any changes that affect the WBS have been made to the project by
other resources, the project worksheet will be refreshed before it is exported. The Excel
spreadsheet includes a Type column, which indicates the type of project item in the row as
follows:

• p – project

• t – task

• ta – task assignment

The Excel file is named according to the format: Export-[date and time].xls.

Exporting the project worksheet data to Microsoft Excel

1. Access the project worksheet.

2. Click  .

The File Download dialog box appears.

3. Do one of the following:

• To view the Microsoft Excel file with the exported project data, click Open. Excel
launches and displays the spreadsheet.

• To save the Microsoft Excel file, click Save and then specify where you want to save
the file.

About working on linked MSP projects in the project worksheet

For linked MSP projects, all of the columns that must be updated in Microsoft Project are
disabled in the project worksheet. This includes planned start, planned finish, planned hours
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(including fiscal and daily period allocations), creating and deleting tasks or assignments,
linking tasks, re-ordering tasks, etc.

You can edit the Changepoint-specific columns that do not affect the project plan or structure,
for example: configurable fields, Add to calendar, Locked, etc. These edits will be updated
in the linked MSP project.

Note: The task assignment options to allow work location and work code overrides can
only be changed in MSP, and not in the project worksheet.

About creating project worksheet views
You can create, copy and save views of the project worksheet and specify a view as your
default view. In these views you can show or hide columns, change the order that the columns
are displayed, and add columns to, and remove them from, the frozen pane. You can also share
these views with other resources.

Note: You cannot move the Task name column from the frozen pane or the Fiscal period
column to the frozen pane.

About related columns

The following pairs of columns are related and either must be updated at the same time, or the
value in one affects the value in the other. Therefore it is best to display both columns in the
worksheet if you plan to work with them:

• Staffing level and Staffing level expiry date. If you change the staffing level, you must
specify the date after which the new staffing level becomes effective.

• Chargeable task and Effective date

• Cross charged to fixed-fee portion of the initiative and Fixed fee

• Work code category andWork code

• Work location group andWork location

• Locked and Include in resource demand

• Open task and Assignment planned hours

Creating a project worksheet view

1. Access the project worksheet.
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2. Click  .

The Manage Views dialog box appears.

3. From the View list, select New view.

4. In the Name field, enter a name for the view.

5. To allow other resources to use this view, select the Share the view check box.

6. To set this view as your default view, select the Set as default check box.

7. To display a column in the view, in the Show/hide columns list, select the column check
box.

8. To remove a column from the view, clear the column check box.

9. To check or clear all of the columns at once, click the check box in the top row of the
Show/hide columns list. The check box switches between options to select all and clear
all columns.

10. To add a column to the frozen columns, select the column in the Show/hide columns list
and then drag it to the Frozen columns list. Columns in the Frozen columns list are
automatically selected for display.

11. To add all columns to the Frozen columns list, click the left double arrow button.

All columns except Fiscal period are moved to the Frozen columns list.

12. To remove all columns from the Frozen columns list, click the right double arrow button.

13. The columns display left to right on the project worksheet in the order that they are listed
in the Frozen columns and Show/hide columns lists. To change the order of the columns,
select a column name and drag it to the desired position in the list.

14. When you are finished, do one of the following:

• To save the view and edit another view, click Apply.

• To save and display the view in the worksheet, click Save.

Copying a project worksheet view

You can create a project worksheet view by copying any existing worksheet view, including
your own worksheet views, shared worksheet views and the system default view. You can
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then edit the project worksheet view as required.

1. Access the project worksheet.

2. Click  .

The Manage Views dialog box appears.

3. From the View list, select the worksheet view that you want to copy.

The worksheet view settings are displayed. If the worksheet view is a shared view or the
default system view, the settings are not editable unless you have the access rights to
manage views.

4. From the View list, select New view.

The information in the View and Name field changes and the remaining settings from the
project worksheet view become editable.

5. In the Name field, enter a name for the view.

6. Edit the remaining fields as required. For more information, see "Creating a project
worksheet view" on page 85.

7. When you are finished, do one of the following:

• To save the view and edit another view, click Apply.

• To save and display the view, click Save.

Editing a project worksheet view

You can change most of the settings in a view, including the view name. However, you cannot
move the Task name column from the frozen pane or the Fiscal period column to the frozen
pane.

1. Access the project worksheet.

2. Click  .

The Manage Views dialog box appears.

3. From the View list, select the view that you want to edit.

4. To change the name of the view, type the new name in the Name field.
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5. Make the necessary changes. For more information, see "Creating a project worksheet
view" on page 85.

6. When you are finished, do one of the following:

• To save the view and edit another view, click Apply.

• To save and display the view, click Save.

Deleting a project worksheet view

1. Access the project worksheet.

2. Click  .

The Manage Views dialog box appears.

3. From the View list, select the view that you want to delete.

4. Click Delete.

5. Click Yes to confirm.

6. Click OK to acknowledge.

About filtering the information displayed in the project worksheet
You can create filters in the project worksheet so that only the tasks and task assignments that
match the criteria that you specify are displayed on the project worksheet. In a filter, you add
criteria based on the data in the worksheet columns. There are also logical AND and OR
operators and parentheses that you can use to create more complex filter criteria.

When you apply a filter, only the information that is displayed on the project worksheet is
affected. For example, if all of the tasks in your project worksheet are collapsed so that no
task assignments are visible and you apply a filter that affects task assignments, then nothing
will display.

Note: Once you apply a filter, it is not reapplied automatically when you make changes to
the worksheet. This filter behavior allows you to filter on summary tasks and then display
everything below them. For example, you could use a filter to display only the summary
task in a given project phase, and then expand the subtasks and task assignments under the
summary task.
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Manage Filters (PW) dialog box options

Option Description

Information column Provides information about warnings and errors:

• Yellow cell – indicates a warning for the row

• Red cell – indicates there is an error in the row

Point to the cell to display the warning or error message.

Blank columns Four drop-down lists for selecting operators (AND, OR) or

parentheses to create complex filter criteria.

Filters list Specifies a filter to edit, or [New filter] to create a new filter.

Name field Specifies a new filter name or edits an existing filter name.

Set as default check box When enabled, applies the currently selected filter

automatically to all of the projects that you view in the project

worksheet.

Show summary task
check box

When enabled, displays the summary task when one or more

of its subtasks are displayed when the filter is applied.

New criteria button Adds a new criteria row to the table, above the row that you

have selected.

Delete criteria button Deletes the selected criteria row. Note that you cannot delete

the last row.

Type column Drop-down list from which you select the type of project item

for the criteria row. The options are:

• Task – columns for tasks only
• Task assignment – columns for task assignments only
• Task and assignment – columns that are common to both

tasks and their task assignments

Filter on column Specifies the worksheet column that the filter criteria applies

to.

Condition column Specifies the condition for the criteria row.

Value column Specifies the value for the condition.
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About calculated columns

There are some calculated columns that you can use in the filter criteria. These columns
include some basic calculations to provide additional filter criteria. The calculated columns
are provided for use in filters only and are not available for display on the project worksheet.

Calculated Column Description

Actual variance Calculates the variance of task assignments from planned

hours as follows:

planned hours minus actual hours

Cross charge rate minus
cost rate

Calculates themargins for task assignments as follows:

cross charge rateminus cost rate

Note however, that if the cross charge rates are in different

currencies, the currencies are not converted.

Forecast variance Calculates the variance of task assignments from forecast

hours as follows:

planned hours minus actual hours minus remaining hours

Number of days late For task assignments that are not completed, calculates the

number of days late as follows:

• if forecast finish date is in the past: current dateminus

planned finish

• if forecast finish is in the future: forecast finishminus

planned finish

Status is not current Identifies task assignments for which the status is due to be

updated. You can use this column in a filter to gauge how

current the project information is.

Filter examples

This section includes some examples of filters:

• Task assignments with remaining hours over 40 hours.
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• Task assignments with planned start dates in October.

• Task assignments with remaining hours over 40, and planned start dates in October

• Task assignments where:

• the actual variance (calculated column that calculates planned hours minus actual
hours) is less than 0 or the number of days late is greater than 0 (tasks that have
slipped)

• and the function is either Developer or DBA

• and the workgroup is Changepoint Development.

Creating a project worksheet filter

1. Access the project worksheet.

2. Click  .

The Manage Filters dialog box appears. For more information, see "Manage Filters (PW)
dialog box options" on page 89.
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3. In the Filter list, select [New filter].

4. In the Name field, enter a name for the filter.

5. To apply the filter automatically to all projects that you view in the project worksheet,
select the Set as default check box.

6. To display summary tasks when the filter is applied, select the Show summary task
check box.

7. In the Type column, select the type of project item for the criteria row.

Note: If you select Task and assignments, then the filter criteria must be met by both the
task and its task assignment.

8. In the Filter on column, select the column that the criteria row applies to.

9. In the Condition column, select the condition for the information in the column.

10. In the Value column, select the values that the condition must meet.

11. To add a criteria row, click New criteria.

Note:When you add a criteria row to the worksheet filter, a new blank row is
automatically added by the system. Do not attempt to delete it.

12. To add an AND or OR operator, or an opening or closing parentheses, click a blank
column in the row and then select the item from the list.

13. When you are finished, do one of the following:

• To save the filter and edit another filter, click Apply.

• To save and display the filter in the worksheet, click Save.

Editing a project worksheet filter

You can edit any of the options in a filter, including the filter name.

1. Access the project worksheet.

2. Click  .

3. The Manage Filters dialog box appears.

4. In the Filter list, select the filter.
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5. Make the necessary changes. For more information, see "Manage Filters (PW) dialog box
options" on page 89.

6. When you are finished, do one of the following:

• To save the filter and edit another filter, click Apply.

• To save and display the filter in the worksheet, click Save.

Deleting a project worksheet filter

1. Access the project worksheet.

2. Click  .

3. The Manage Filters dialog box appears.

4. In the Filter list, select the filter.

5. Click Delete.

6. Click Yes to confirm.

7. Click OK to acknowledge.

Applying a project worksheet filter

When you apply a project worksheet filter, only the tasks and task assignments that match the
filter criteria are displayed. If there are no matches, then only the main project row is
displayed.

1. Access the project worksheet.

2. From the Filter list in the toolbar, select a filter.

The filter is applied to the information that is currently displayed.

Clearing a project worksheet filter from the view

From the Filter list in the toolbar, select the blank row at the top of the list. The filter is
cleared from the view.

About managing tasks in the project worksheet
You can perform all task-related procedures using the project worksheet, except for the
following procedures, which you must perform using the task editing view:
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• associating applications with tasks

• specifying security access for open tasks

• viewing the task assignment staffing level history

• setting up and working with baselines

Also, when task-level resource requests are enabled for the project, you must create task
assignments and edit planned information of task assignments in the task editing view or on the
resource request.

About open tasks in the project worksheet

For open tasks, the planned start, planned finish and planned hours from task assignments are
not rolled up to the task level. Also, the planned hours for open tasks are displayed distributed
evenly across fiscal periods, but no values (zeroes) are displayed across daily periods.

About summary tasks in the project worksheet

When daily periods are displayed in the project worksheet, the planned hour totals are
displayed for subtasks and projects, but not for summary tasks.

About locking tasks for editing in the project worksheet

You must lock tasks when creating, editing, moving and deleting tasks. Locks are required to
prevent other resources from making changes to the same tasks at the same time and because
these changes can affect settings on other tasks, as well as the work breakdown structure of
the overall project.

Therefore, it is recommended that you lock the entire task hierarchy within the WBS that you
will be working in so that you can avoid conflicts with changes made by other resources.
Otherwise, the worksheet may have to be refreshed to display changes made by other
resources before you can lock additional tasks or perform actions that affect other tasks. In
some cases, tasks are automatically locked, in particular when your changes affect the WBS.

Project plan editors and summary task managers can only lock the tasks that are currently not
locked by other resources. Project managers can release the locks that other resources have on
tasks and take over editing control of the tasks. Keep in mind that when you release the locks
on a task, all unsaved changes that the other resource has made to the task will be lost.

If you unlock a task without saving it, the task will revert to the values that were last saved for
it.
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Locking a task for editing in the project worksheet

When you lock a task, a check mark displays in the Edit column, and all task assignments
under the task are also automatically locked. However, check marks are not displayed for
locked task assignments. You cannot lock individual task assignments.

Tip: To see the names of resources who have locked the tasks, add the Locked by column
to your worksheet view.

1. Access the project worksheet.

2. Select one or more tasks that you want to lock for editing.

3. Click  .

Check marks display in the Edit column for the tasks that are locked.

Unlocking a task in the project worksheet

Locked tasks are unlocked automatically when you navigate away from the project worksheet
and when you refresh the project worksheet by clicking  .

To unlock tasks manually, select them and then click  . The check marks in the Edit

column are cleared for the tasks that are unlocked.

Selecting multiple tasks or task assignments in the project worksheet

You can select a range of tasks or multiple nonconsecutive tasks while working in the project
worksheet. You can do the same with task assignments.

1. Access the project worksheet.

2. To select a range of tasks or task assignments:

a. Select the first task in the range by clicking in the task row.

b. While holding the Shift key, click the last task in the range. The range of tasks is
highlighted.

3. To select nonconsecutive tasks or task assignments:

a. Select the first task.

b. While holding the Ctrl key, click the other tasks. The selected tasks are highlighted.
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About moving tasks in the project worksheet

You can change the order of tasks within the WBS structure on the project worksheet by
dragging tasks to new positions. Tasks are automatically locked when you move them, and all
tasks that are affected by the move are automatically locked as well, provided that you have
access to lock the tasks. If you do not have access to lock one or more of the tasks that will be
affected by the move, you will not be able to move the task.

As you drag a task, the task name displays by the pointer and the row that you are pointing to
is highlighted. When you drop the task on a highlighted task row, the task is placed in the row
above the highlighted task row, and at the same WBS level as the highlighted task. If you drop
the task onto a row that it cannot be moved to, for example, a task assignment or subproject or
a summary task that you do not have access to, then the task will return to its original position.

You can select multiple tasks and drag all of them at once. Note that all tasks will be inserted
at the same WBS level as the task that they are dragged to, regardless of the original WBS
level of the individual tasks.

If you move a summary task, all of its subtasks are moved with it and retain their WBS levels,
but the summary task will be at the same WBS level as the task that you drop it on. If you
move an individual subtask, it is inserted at the same WBS level as the highlighted task that
you drag it to.

Moving multiple tasks in the project worksheet

1. Access the project worksheet.

2. Select the tasks that you want to move.

3. While pressing the Ctrl key, click the task icon to the left of one of the selected task
names.

The names of all of the selected tasks are displayed in a tooltip.

4. Drag the tasks to the row above which you want them to be moved.

Moving a single task in the project worksheet

1. Access the project worksheet.

2. Click the task icon to the left of the task name. The task name is displayed in a tooltip.

3. Drag the task to the row above which you want it to be moved.
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Tip: You can also click in the information  column to select a task.

About creating summary tasks and subtasks in the project worksheet

You create subtasks and summary tasks on the project worksheet by outdenting and indenting
tasks. When you indent a task, it becomes a subtask of the task directly above it that is at the
same level as it in the worksheet.

When you outdent a task, it becomes a summary task of the tasks directly below it that are at
the same level as it in the worksheet. If you outdent a task that is directly below a summary
task, the summary task becomes a regular task. Neither open tasks nor dependent tasks can be
summary tasks.

Note:When you indent or outdent a summary task, its subtasks move with it.

Indenting and outdenting tasks in the project worksheet

You can indent or outdent one or more tasks at a time.

1. Access the project worksheet.

2. Select one or more tasks.

3. To indent the tasks, click  .

4. To outdent the tasks, click  .

About creating tasks in the project worksheet
You can create tasks in the project worksheet by either adding a new task and then specifying
the task details, or by copying and pasting an existing task.

When you add a new task, it is inserted into a new row that is above, but at the same level as,
an existing task. If there are no existing tasks, or you want to add a new task at the top task
level, you can add a task by clicking the project row, in which case the new task is inserted in
to a new row at the bottom of the project worksheet.

You cannot add tasks to a subproject row, which is a summary-level, information-only row that
cannot be edited or added to. You must manage subprojects separately by launching the project
worksheet from the subprojects in the projects tree view.

Tip: To minimize the effect on other resources who could be editing other parts of the
project, it is good practice to insert tasks where they are least likely to affect the WBS.

Project Management | 97



6. Project Worksheet

Examples include at the bottom of the task hierarchy or project worksheet or within a
summary task.

About summary task managers creating tasks

Summary task managers must select an insertion point that is below the summary task because
they do not have edit access to the summary task itself. If the insertion point is a task, the new
task will be inserted above the task. If the insertion point is a task assignment of the summary
task, the new task will be inserted below the last task under the summary task. If summary
task managers have rights to create tasks but not edit them, then they must use task
assignments as the insertion point.

About validation, rollup, and critical path calculations in the project
worksheet

By default, validation of data that you enter into the project worksheet, rollup of the task
assignment and task data, and critical path calculations are performed only when you request
them or when you save the project worksheet, which reduces processing time and therefore
improves the performance of the project worksheet.

However, you can change the setting to validate and rollup the data, and calculate critical path
every time that you edit and then move from a task or task assignment row. You can set
critical path to be calculated upon change only if validation and rollup is set to be performed
upon change. These settings apply to all projects that you access in the project worksheet,
regardless of which project you change the setting from.

Note: You must enable critical path for the project to view it in the project worksheet. For
more information, see "About viewing critical path information in the project worksheet"
on page 129.

To request validation and roll up

Click .

To request critical path calculations

Click . When you request critical path calculations, any outstanding validations and rollup

are also performed.

To change the validation and rollup, and critical path calculation settings
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1. To access the settings, click in the top right corner of the project worksheet.

2. To change the Validate and roll up setting:

• To perform validation and rollup every time that you edit a row and then click outside
of the row, select Upon change.

• To perform validation and rollup only when you request it, select Upon request.

3. To change the Calculate critical path setting:

• To calculate critical path every time that you edit a row and then click outside of the
row, select Upon change.

• To calculate critical path only when you request it, select Upon request.

Creating a task in the project worksheet

1. Access the project worksheet.

2. Lock the tasks that you will be working with.

3. Select an insertion point by doing one of the following:

• To add a task at the same level as an existing task, select the task

• To add a task at the top task level, select the project row

4. Insert the task by doing one of the following:

• Click 

• Press the Insert key

The new task is added to the project worksheet.

5. In the Task name column, type the name.

6. Complete the remaining fields as required. For more information about the task fields, see
"Task editing view, General section options" on page 53.

7. You can move and indent or outdent the task, if required.

8. Click  .
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About copying tasks in the project worksheet

You can create new tasks in the project worksheet by copying and pasting existing tasks. The
following rules apply:

• copying a task will copy the task and all of its task assignments, even if you select only
some of the task assignments

• you can copy multiple tasks or task assignments, but not both at once

• copying a summary task will copy all of its subtasks and task assignments

• you can neither copy subprojects nor copy tasks or task assignments to them

• if the start date of the copied task is in the past:

• the start date of the pasted task will be changed to the current date, but the duration
will remain the same

• if the copied task is a summary task, all of its tasks and task assignments will start on
the current date

Note: If a task assignment for the same resource already exists on the target task, then the
task assignment will not be pasted.

Copying a task in the project worksheet

1. Access the project worksheet.

2. Lock the tasks that you will be working with.

3. Select the task that you want to copy and then click  .

4. Select the task above which you want to paste the copied task, then click  .

5. In the Task name column, enter the new name for the task.

6. Complete the remaining fields as required. For more information about the task fields, see
"Task editing view, General section options" on page 53.

7. You can move and indent or outdent the task, if required.

8. Click  .
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About linking tasks in the project worksheet

In the project worksheet, you can link tasks within the same project to create dependencies
between them.

Note: You can link tasks in different projects from the task profile. For information about
linking tasks in different projects, see the "Linking tasks from the task profile" section on
page 72.

To link tasks, you select two or more tasks to be linked and then click  . The dependencies

between the tasks are created as follows:

• If you select a range of tasks, then each task immediately above a task in the range is its
predecessor, and each task immediately below a task in the range is its successor.

• If you select multiple non-consecutive tasks, then the first task that you select is a
predecessor and each task you select after is a successor of the task that you select
immediately before it.

• The planned start dates of the successor tasks are moved to start one day after the finish
date of the predecessor tasks.

Linking tasks in the project worksheet

If you link tasks and then before saving the worksheet you unlink them or unlock the
predecessor task, the link is removed but the dates for the successor task (if moved due to the
dependency) do not revert back automatically. To roll back the changes to the successor task
dates, you can unlock the successor task.

1. Access the project worksheet.

2. Lock the tasks that you will be working with.

3. Press and hold the Ctrl key and then select the tasks that you want to link.

4. Click  .

Link graphics are displayed in the information  column for the linked tasks.

5. Click  .
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Note: If you get an error when linking tasks in the project worksheet, you must first unlink
the tasks and then unlock the successor task to clear the error from the worksheet.

Identifying predecessor and successor tasks in the project worksheet
Linked tasks are marked in the project worksheet by a link graphic in the information 

column.

To identify the predecessor and successor tasks, add the Predecessors and Successors
columns to your worksheet view. These columns display the WBS number of the predecessor
and successor tasks. If one or more predecessor or successor tasks is from a different project,
then an asterisk is displayed in the column. You can then use the Manage Link Settings
dialog box to identify the project and task.

About editing settings for linked tasks in the project worksheet

The default settings for dependencies in linked tasks are as follows:

• Lag time – 0

• Lag time in working days – selected

• Move successor task date – selected

• Successor task can start anytime after the finish date of the predecessor task –
cleared

• Send notification – selected

However, you can edit the settings and/or delete task dependencies between tasks in the same
project or in different projects if you have edit access to the successor tasks.

You cannot edit or delete dependencies if the project in the worksheet is a linked MSP project.
If the successor task is from a linked MSP project, then you can edit the dependency, except
for the Move successor task date option.

Editing settings for linked tasks in the project worksheet

1. Access the project worksheet.

2. Lock the tasks that you will be working with.

3. Do one of the following:

• To view all of the dependencies for the project, select the project row.
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• To view some of the dependencies, select the linked tasks.

4. Click  .

The Manage Link Settings dialog box appears. There is a row for each predecessor-
successor task dependency that you selected.

5. Select the task dependency that you want to edit. For more information, see "Task
dependency options" on page 71.

6. Make the necessary changes.

7. Repeat for each task dependency, as required.

8. Click Save.

Unlinking tasks in the project worksheet

You can unlink tasks that are in the same project by selecting the predecessor and successor
tasks and then clicking  .

You can unlink multiple tasks and tasks in different projects in the Manage Link Settings
dialog box.

1. Access the project worksheet.

2. Lock the tasks that you will be working with.

3. Do one of the following:

• To view all of the dependencies for the project, select the project row.

• To view some of the dependencies, select the tasks whose dependencies you want to
edit.

4. Click  .

The Manage Task Links dialog box appears. There is a row for each predecessor-
successor task dependency that you selected.

5. Select the task dependency that you want to remove and then click Delete.

6. Click Save.
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About creating task assignments in the project worksheet
You create task assignments in the project worksheet by either adding a new task assignment
and then specifying the details, or by copying and pasting an existing task assignment.

You can add a task assignment to a task or an existing task assignment:

• If you add a task assignment to a task, the task assignment is inserted into a new row
below the task and any existing task assignments.

• If you add a task assignment to an existing task assignment, then the task assignment is
inserted into a new row above the existing task assignment.

If resource requests are not enabled, your preferred resources are available. You can add
resources and personal groups to your preferred resources list directly from the project
worksheet by clicking  .

Creating a task assignment in the project worksheet

1. Access the project worksheet.

2. Select a task or task assignment as the insertion point.

3. Click  .

The new task assignment is added to the project worksheet.

Tip: If the insertion point is a task assignment, you can also press the Insert key to insert
the task assignment.

4. To assign a resource or personal group:

a. Click in the Task name column, type the first few letters of the resource’s first name
or group’s name and then press Enter or click the arrow.

b. Select the resource or group from the list. If you select a resource, the resource name
is added to task assignment. If you select a group, then a task assignment for each
resource in the group is created.

5. Complete the remaining fields as required. For more information, see "Task editing view,
Assignments section options" on page 58.

6. Click  .
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About using resource searches for task assignments in the project
worksheet

When assigning a task in the project worksheet, you can search for resources based on
workgroups, qualifications, functions and availability. You can then assign one or more
resources to the task directly from the resource search results. If you specify the planned
hours, planned start, planned finish, and function fields for the task assignment, the
corresponding fields are automatically populated on the Search for Available Resources
dialog box as follows:

• planned hours – Available for Hours >= [number of hours], Availability section

• planned start – Period Start, Availability section

• planned finish – Period End, Availability section

• function – Function section

Using resource searches for task assignments in the project worksheet

1. Create the task assignment, with or without specifying the resource. For more information,
see "About creating task assignments in the project worksheet" on page 104.

2. Click  .

The Search for Available Resources dialog box appears.

3. Perform the resource search. For more information, see "Resource Searches" in the
Resource Management User Guide.

The resources that match your search criteria are displayed in the Resource search
results list.

4. Select one or more resources by selecting the check box beside the resource name.

5. Click Actions > Create > Task assignment.

If you selected a single resource, the resource is added to the task assignment.

If you selected more than one resource, the first selected resource in the Resource search
results list is assigned to the current task assignment (with the total planned hours amount)
and a new task assignment is automatically created for each remaining resource in the list
(with 0 planned hours each). You can then edit the planned hours for each task assignment
as necessary.
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About copying task assignments in the project worksheet

You can add new task assignments to tasks by copying and pasting existing task assignments.
You can copy multiple task assignments at once. The planned start and finish dates come from
the target task. If the start date of the source task assignment is in the past, the start date of the
target task assignment will be changed to the current date, but the end date will be taken from
the source task. If the target task finish date is also in the past, it will be set to the current
date.

The planned hours are copied and the effort is redistributed into fiscal periods, unless the
source task assignment has a manual loading method, in which case the planned hours are not
copied. The Completed flag and the start and finish dates are never copied.

You cannot paste a task assignment when the following conditions exist:

• a task assignment for the same resource already exists on the target task

• the task assignment is not valid for the target task; for example, a resource request is
required, or the resource is not in the project team or projected resources list (where
applicable)

• task-level resource requests are enabled for the project

Note: If you paste multiple task assignments, the valid task assignments will be pasted to
the target task even if one or more task assignments cannot be pasted.

Copying a task assignment in the project worksheet

1. Access the project worksheet.

2. Lock the tasks that you will be working with.

3. Select the task assignments that you want to copy and then click  .

4. Select the task or task assignment that you want to add the task assignments to, and then
click  .

5. Complete the remaining fields as required. For more information, see "Assigning a
resource to a task assignment" on page 57.

6. You can move and indent or outdent the task, if required.

7. Click  .
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About resource requests and task assignments in the project worksheet

If your organization uses resource requests, there are restrictions on how you can edit task
assignments in the project worksheet, depending on how the resource requests are submitted.

If resource requests are submitted from the initiative, then you can create or copy a task
assignment for a resource on the project worksheet only if there is a resource request for the
resource in the Projected resources tab of the initiative.

If resource requests are submitted from the Project dialog box, then the following restrictions
apply to the project worksheet:

• you can only assign a resource to a task assignment if there is a resource request for the
resource that covers the planned start, planned finish and planned hours for the task
assignment.

• you can copy and paste a task assignment, but you can save it only if there is a resource
request for the resource that covers the planned start, planned finish and planned hours for
the task assignment

If resource requests are submitted from the task editing view, then the following restrictions
apply to the project worksheet:

• you cannot create or copy and paste task assignments

• you can only reopen resource requests from the task editing view

• the following columns are not editable on the project worksheet:

• Resource

• Planned start

• Planned finish

• Planned hours

• Fiscal periods

• Daily periods

• Loading method

• Open task
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Adding resources to your preferred resources from the project worksheet

You can add resources and personal groups to your preferred resources list directly from the
project worksheet by clicking  . For more information, see "Adding a resource to your

preferred resources" in the User Basics User Guide.

About editing tasks in the project worksheet
In the project worksheet, you can edit tasks, including draft tasks that were created in PPW.
Before you can edit a task, you must lock it and you must ensure that the field columns that
you want to edit are displayed in the project worksheet. If the task has task assignments, the
values that you change on the task are also changed on its task assignments, except for:

• staffing level – must be changed on the task assignment because of the effective date

• function – if a resource has already been assigned to the task assignment, the function will
not be changed

However, you can edit the task assignments later, if required.

If you edit a parent task, the values that are inherited by subtasks (such as the Completed
flag) are updated on the worksheet. However, the values that are updated on the worksheet are
not saved to the database until you click  .

Editing draft tasks in the project worksheet

In the project worksheet you can edit the draft tasks that are created in PPW.

Tip: To identify draft tasks, add the Draft column to the project worksheet view. To filter
draft tasks from the project worksheet, create a filter based on the Draft column.

Unlike in PPW, when you edit a draft task in the project worksheet, it must validated and
saved before the worksheet can be saved. Once a task is edited, validated and saved in the
project worksheet, it becomes a regular task. Note: the new ‘duration’ field will not be
available in the PW. The PW will continue to display the old ‘duration’ field that is used only
for effort and date calculations and is not stored. Behind the scenes, the ‘duration’ will be set
to the working days value of the task assignment.

Warning: If the project contains tasks for which planned hours have been manually
allocated to nonworking days, the planned hours will be reallocated to working days when
you save the project worksheet.
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Related columns in the project worksheet

The following pairs of columns are related and either must be updated at the same time, or the
value in one affects the value in the other. Therefore it is best to display both columns in the
worksheet if you plan to work with them:

• Staffing level and Staffing level expiry date. If you change the staffing level, you must
specify the date after which the new staffing level becomes effective.

• Chargeable task and Effective date

• Cross charged to fixed-fee portion of the initiative and Fixed fee

• Work code category andWork code

• Work location group andWork location

• Locked and Include in resource demand

• Open task and Assignment planned hours

Editing a task in the project worksheet

1. Access the project worksheet.

2. Lock the tasks that you want to edit.

3. Click the cell that you want to edit.

4. Make the necessary changes.

5. Click  .

About deleting a task in the project worksheet

When you delete a task, all of its task assignments are also deleted. When you delete a
summary task, all summary tasks, tasks and task assignments below it are also deleted.

You cannot delete a task if any of the following conditions exist:

• expenses or chargeable time that has not been cross charged are entered for the task

• the planned finish date for the task is in the past and fiscal periods have been selected for
the project, which means changes to data in past fiscal periods is not allowed
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• any of the task assignments under this task or any of its subtasks has a subproject
associated to it

Deleting a task in the project worksheet

1. Access the project worksheet.

2. Select the task that you want to delete.

3. Do one of the following:

• Click  .

• Press the Delete key.

4. Click OK to confirm.

The task is removed from the project worksheet.

5. Click  .

The task is deleted.

About deleting task assignments in the project worksheet

You can delete tasks assignments from a task without deleting the task. You cannot delete a
task assignment if any of the following conditions exist:

• expenses or time have been entered for the task

• the planned finish date for the task is in the past and fiscal periods have been selected for
the project, which means changes to data in past fiscal periods is not allowed

• the task assignment has a subproject associated to it

Deleting a task assignment in the project worksheet

1. Access the project worksheet.

2. Select the task assignment that you want to delete.

3. Do one of the following:

• Click  .

• Press the Delete key.
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4. Click OK to confirm.

The task assignment is removed from display on the project worksheet.

5. Click  .

The task assignment is deleted.

Editing a check box in the project worksheet

1. Access the project worksheet.

2. Lock the tasks that you want to edit.

3. Click the cell with the check box.

The cell becomes editable.

4. To select or clear the check box, you can either click the check box or press the spacebar.

Specifying multiple values in a list in the project worksheet

1. Access the project worksheet.

2. Click the cell.

The cell becomes editable.

3. Do one of the following:

• To display the complete list of values, press Enter. The list is displayed.

• To refine your search criteria, type the first characters of a value and press Enter.
The list of values that begin with the characters that you typed is displayed.

4. To select a range of consecutive values:

a. Click the starting value for the range.

b. While holding the Shift key, click the value for the end of the range. The range of
values is highlighted.

c. Click anywhere outside the list.

5. To select multiple, nonconsecutive values:

a. Click the first value that you want to select.
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b. While holding the Ctrl key, click the additional values that you want to select. Each
value that you select is highlighted.

c. Click anywhere outside the list.

Tip: To deselect a value, click it again. If there are too many selected values to display in
a cell, you can point to the cell to display a tool tip that displays the complete list.

6. To select additional values, repeat steps 2 to 4 as required, but press and hold the Ctrl key
while selecting the first value. The values that you have previously selected are displayed
at the top of the list and are highlighted.

7. Click  .

Editing multiple values in a list in the project worksheet

You can add additional values to, and remove values from, multiple values that have been
selected from a list.

1. Access the project worksheet.

2. Click the cell whose value you want to specify.

3. Do one of the following:

• To display the complete list of values, press Enter. The list of values is displayed
with the previously selected values highlighted at the top of the list.

• To filter the list of values, type the first characters of a value and then press Enter.
The list of values that begin with those characters is displayed. All values that were
previously specified are highlighted at the top of the list, followed by the values that
start with the letter or number that you specified.

4. To add a value, press and hold the Ctrl key and click the value that you want to add.

5. To remove a value, press and hold the Ctrl key and click the value that you want to
remove.

6. To remove all values, select the empty value at the top of the list.

7. Click anywhere outside the list.

8. Click  .
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Clearing values selected from a list in the project worksheet

To clear a value in the project worksheet that has been selected from a list, select the blank
row at the top of the list. If the list has too many records to display at once, you must first
specify search criteria to display a smaller list of records and then select the blank row.

1. Access the project worksheet.

2. Click the cell.

The cell becomes editable.

3. Click the arrow.

4. If the list of values displays, select the blank row at the top of the list.

5. If a message displays, advising you to refine your search criteria:

a. Click the cell to make it editable.

b. Type the first few letters of one of the existing values, and then click the arrow. A list
of the values that match your search criteria displays.

c. Select the blank row at the top of the list.

6. Click anywhere outside the list.

The value is removed.

7. Click  .

Specifying dates in the project worksheet

You specify dates in the project worksheet by using the date field or the project worksheet
calendar icon.

Specifying dates by using the date field in the project worksheet

The date format is determined by the setting in the Internet Explorer, Tools > Internet
Options > Languages setting, and therefore may be different than the dates shown in this
procedure, which is English (United States). In all cases, the characters that separate the date,
and the first two digits of the year can be omitted.

1. Access the project worksheet.

2. Click in the date field  .
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3. Type the new date using one of the following formats:

• MM/dd/yy

• MM/dd/yyyy

• mmddyy

• mmddyyyy

4. Press Enter or Tab.

The date is changed.

5. Click  .

Specifying dates by using the calendar in the project worksheet

1. Access the project worksheet.

2. Click  .

The calendar displays the month with the date from the date field highlighted, or the
current month and date if there is no date in the date field.

3. To change the date to another date in the same month, select the date.

The date is changed.

4. To change to the next or previous month:

a. To display the previous month, click the left arrow beside the <Month, Year>.

b. To display the following month, click the right arrow beside the <Month, Year>.

c. Repeat step a or b until the month you want is displayed.

d. Select the date. The date is changed.

5. To navigate quickly to another month and/or year:

a. Click the <Month, Year>. A table of the month names is displayed for the current
year.

b. To change to another year, click the arrows beside the year.

c. Click the month that includes the date you want. A calendar of the month appears.
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d. Select the date. The date is changed.

6. Click  .

Copying a value to multiple tasks and task assignments in the project
worksheet

You can copy a value from one task or task assignment to multiple tasks and task assignments.
For example, you can copy the planned start date from one task to all of the task and task
assignments that you want to have the same start date. The task with the value that you want to
copy must be in a higher row; that is, closer to the top of the worksheet, than the tasks that you
want to copy the value to.

Note: You cannot assign resources or copy task assignments using this procedure.

1. Access the project worksheet.

2. Lock the tasks that you want to edit, including the task whose value is being copied.

3. Select the cell that has the task or task assignment value that you want to copy to other
tasks and/or task assignments.

4. Within the same column, select the cells in the tasks and/or task assignments that you want
to copy the value to.

5. Press Ctrl+Alt+U.

The value is copied to the selected tasks and task assignments. If the value is not valid for
a row, it will not be copied.

About allocating planned hours in PPW and the project worksheet
The methods that you can use to allocate planned hours depend on whether or not fiscal periods
have been selected for the project, and the loading methods that are specified for tasks.

If you select fiscal periods for the project:

• you can allocate planned hours to fiscal periods and edit planned start, planned finish and
planned hours, provided that they are in current or future fiscal periods. You require the
appropriate security feature to edit information in past fiscal periods.

• the default loading method for tasks is 1 - Auto distribute - update past and future.
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Note: If you do not want planned hours in past fiscal periods to be updated with actual
hours, then you must change the loading method for each task to loading method 3 or 4. For
more information, see "About selecting loading methods" on page 181

If you do not select fiscal periods for the project, then only the following loading methods are
available:

• 3 - Manually distribute – no update

• 4 - Auto-distribute – no update to past (default)

Differences between PPW and project worksheet

Using PPW, you can do the following, which is not possible in project worksheet.

Manually allocate planned hours to nonworking days

In PPW only, you can allocate planned hours to nonworking days if the loading method is a
manually distribute method.

Note: Planned hours allocated to nonworking days are moved to working days if you
change the planned start, planned finish or planned hours for the task assignment in the
project worksheet or RMW.

Change a planned start date in the past when using a loading method that
replaces planned hours in past periods

You can change a planned start date that is the past when the loading method is one that
replaces planned hours in past periods with actual hours, provided that you have access rights
to edit data in past fiscal periods.

Note: If you change a planned start date this way, keep in mind that existing actual hours
can cause the date to revert back to the original date upon saving. Also, if there are no
actual hours at the time that you change the date, actual hours on a future date can change
the date automatically.

About selecting loading methods

The default loading method for tasks is:

• if fiscal periods are selected for the project – 1 - Auto-distribute – update past and future

• if fiscal periods are not selected for the project – 4 - Auto-distribute – no update to past
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The loading method applies to each task assignment for the task. In PPW, you can change the
loading method for task assignments. In project worksheet, you can change the loading method
for tasks as well as individual task assignments.

To allocate planned hours, you can select the loading method to specify how planned hours are
distributed across fiscal periods, and how (or whether) actual hours are applied to past fiscal
periods when the project is rolled up.

When you select a manually distribute loading method, you can manually allocate the planned
hours in the current and future fiscal periods. However, you cannot edit the total planned hours
for the task assignment.

When you select one of the auto-distribute loading methods, you can update planned start,
planned finish and planned hours for the task assignment, but the system automatically
allocates the hours to the fiscal periods.

Note:When open tasks are rolled up, the planned hours for the task are evenly distributed
to each fiscal period between the planned start and planned finish dates, and planned hours
are not rolled up from task assignments. Therefore the total planned hours for open tasks
might not balance with the total task assignment hours.

The loading method affects how planned and actual information is rolled up for each task
assignment.

0 - Manually distribute – update past only

• Planned hours in past periods are replaced by actual hours

• Planned start and planned finish in past periods are replaced if time records are earlier
than the planned start or later than the planned finish. For more information, see "About
replacing planned start and finish dates with actuals" on page 118.

• Current and future planned hours are not changed

• Total planned hours are set to: past period hours + current and future planned hours

• Resources can manually update current and future periods

1 - Auto-distribute – update past and future

• Planned hours in past periods are replaced by actual hours
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• Planned start and planned finish in past periods are replaced if time records are earlier
than the planned start or later than the planned finish. For more information, see "About
replacing planned start and finish dates with actuals" on page 118.

• Total planned hours minus planned hours from past periods, are distributed evenly to
current and future periods

2 - Auto-distribute – update past only

• Planned hours in past periods are replaced by actual hours

• Planned start and planned finish in past periods are replaced if time records are earlier
than the planned start or later than the planned finish. For more information, see "About
replacing planned start and finish dates with actuals" on page 118.

• Current and future periods are not changed (unless the resource changes the planned start,
planned finish or planned hours)

• Total planned hours are set to: past period planned hours + current and future planned
hours

3 - Manually distribute – no update

• Planned hours in past periods are not replaced by actual hours

• Resources can manually update current and future periods

• Resources with the required access rights can manually update past periods

4 - Auto-distribute – no update to past

• Planned hours in past periods are not replaced by actual hours, but can change when
planned start, planned finish or total planned hours are changed

• Total planned hours are evenly distributed across the working days between the planned
start and finish dates, and the planned hours for fiscal periods (including past fiscal
periods) are updated accordingly

About replacing planned start and finish dates with actuals

If the loading method for a task assignment is one that includes “update past”, then if a time
record is entered before the planned start date in a past period, the planned start date is
changed to the date of the time record. Similarly, the planned finish date in a past period is
changed to the date of a time record that is later than the planned finish date.
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When the planned start date for a task assignment is changed in this way, then all effort that is
allocated to daily periods for the task assignment is deleted.

However, the planned start and finish dates for task-level or project-level resource requests
that have resource restrictions enabled will not be replaced with dates of time records if the
new dates are outside of the dates for the original resource request item.

Loading method examples

The following table shows the results after a project rollup, of the different loading methods on
a task assignment with the following conditions:

• Planned start: September 1

• Planned finish: October 31

• Planned hours: 50

• Fiscal periods selected for the project, and the fiscal periods are months (September,
October)

• 20 actual hours were entered during the September fiscal period

• The current fiscal period is October

Note: All of the tables in the loading method examples show the results after the project
has been rolled up. However on the project worksheet, you may see method 2 providing the
same results as method 1 if you update the planned hours and loading method for a task
that has planned hours in a past period.

Loading Method
Total
Planned
Hours

Fiscal
Period
September

Fiscal
Period
October

Original task assignment 50 25 25

0 - Manually distribute – update past only 45 20 25

1 - Auto-distribute – update past and future 50 20 30

2 - Auto-distribute – update past only 45 20 25
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Loading Method
Total
Planned
Hours

Fiscal
Period
September

Fiscal
Period
October

3 - Manually distribute – no update 50 25 25

4 - Auto-distribute – no update to past 50 25 25

The following table shows the results of the loading methods on the same original task
assignment, but with 60 actual hours entered during the September fiscal period.

Loading Method
Total
Planned
Hours

Fiscal
Period
September

Fiscal
Period
October

Original task assignment 50 25 25

0 - Manually distribute – update past only 85 60 25

1 - Auto-distribute – update past and future 60 60 0

2 - Auto-distribute – update past only 85 60 25

3 - Manually distribute – no update 50 25 25

4 - Auto-distribute – no update to past 50 25 25

The following table shows the results of the loading methods on the same original task
assignment, but with 40 actual hours entered in the September fiscal period and the planned
hours changed to 60. You can only change planned hours on task assignments that have auto-
distribute methods, therefore this example applies to the auto-distribute methods only.
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Loading Method
Total
Planned
Hours

Fiscal
Period
September

Fiscal
Period
October

Original task assignment 50 25 25

1 - Auto-distribute – update past and future 60 40 20

2 - Auto-distribute – update past only 70 40 30

4 - Auto-distribute – no update to past 60 30 30

Selecting a loading method for a task or task assignment in the project
worksheet

You can select a loading method for a task only if it has task assignments. Loading methods
are prefixed with a number to make selections easier. For more information, see "About
selecting loading methods" on page 181.

1. Access the project worksheet.

2. Lock the tasks that you will be working with.

3. Click the Loading method cell.

The current loading method is selected.

4. If you know the number of the loading method that you want to select:

a. Type the number and press Enter.

b. Click outside of the cell.

5. To view a list of the loading methods:

a. Delete the current entry by pressing the Delete key.

b. Press the green arrow. The list of loading methods appears.

c. Select the loading method.

d. Click outside of the cell.

6. Click  .

Project Management | 121



6. Project Worksheet

About automatically allocating planned hours in the project worksheet

When the loading method for a task assignment is auto-distribute, you can edit the planned
start, planned finish and total planned hours for each task assignment, provided that the
information is not in the past, and fiscal periods have been selected for the project. The
planned hours are allocated automatically to the working days for the duration of the task
assignment. If you are working with fiscal periods, each fiscal period displays the total
planned hours that correspond to the working days (daily periods) within the fiscal period.

If resource leveling is enabled for the workgroup, then planned hours for the current task
assignment are allocated so that the total of the committed and current planned hours are even
for the duration of the task assignment, without overbooking the resource.

However, if the current task assignment is soft-booked, and soft-booked is not considered as
committed time in your organization, then the planned hours are allocated evenly across the
working days for the duration of the task assignment. Because the soft-booked hours are not
considered committed, the allocation of these hours cannot result in the resource being
overbooked.

About manually allocating planned hours in the project worksheet

You can allocate planned hours manually to fiscal or daily periods for task assignments
provided that:

• the task assignments have a manually distribute loading method

• the Fiscal period and Loading methods columns are displayed in the project worksheet

When you allocate planned hours to a task assignment, the planned information for the task
assignment is rolled up accordingly. Also, if you allocate planned hours to daily periods that
are before the planned start date or later than the planned finish date, the planned dates for the
task assignment will be adjusted accordingly. In all cases, changes are not actually saved until
you save the project worksheet.

Warning: If you allocate hours to daily periods that fall within a certain fiscal period and
then you or another resource switches to the fiscal period view and changes the hours for
the same fiscal period, the daily period hours will be deleted.

Manually allocating planned hours in the project worksheet

1. Access the project worksheet.
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2. If the appropriate time periods are not displayed, click  .

3. Lock the tasks that you will be working with.

4. Click in a fiscal or daily period cell and then enter the planned hours.

5. Click  .

Allocating recurring planned hours in the project worksheet

You can allocate recurring planned hours for one or more task assignments in the project
worksheet within a date range. There are weekly and monthly options. For example, you can
allocate planned hours for a meeting that occurs every day during the length of a project, or for
a town hall meeting that occurs at the end of every quarter.

Note: The recurring planned hours replace the existing planned hours within the specified
date range. Existing planned hours after the recurring planned hours end date are removed.

If the first date that the recurring planned hours are allocated is earlier than the start date of
the task assignment, then the start date of the task assignment is changed to the first date of the
recurring planned hours. Similarly if the last date that the recurring planned hours are allocated
is later than the task assignment end date, the task assignment end date is changed.

You can allocate recurring planned hours for tasks that have either an manual or automatic
loading method. However, an automatic loading method will be switched to a manual loading
method after recurring planned hours are allocated.

1. In the project worksheet, ensure that daily periods are displayed.

2. Lock the tasks that you want to work with.

3. Select the task assignments that the recurring planned hours will be allocated to.

4. Click .

The Recurring Allocations dialog box appears.

5. Enter the date range, and the number of hours for the recurring allocation.

6. In the Recurrence Pattern section, select the weekly or monthly options.

7. Click Save.
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Editing recurring planned hours in the project worksheet

After you allocate recurring planned hours in the project worksheet, the only way that you can
edit the recurring demand settings all at once is by first clearing out the planned hours (planned
effort) for the task assignment, and then reallocating the recurring planned hours. You can
always edit the individual entries manually.

1. In the project worksheet, ensure that daily periods are displayed.

2. Lock the task assignments that you want to work with.

3. Change the loading method to an automatic distribute method.

4. In the Planned hours column, enter 0.

5. Click outside of the row.

6. Click .

The Recurring Allocations dialog box appears.

7. Enter the date range, and the number of hours for the recurring allocation.

8. In the Recurrence Pattern section, select either the weekly or monthly options.

9. Click Save.

About displaying resource availability in the project worksheet

You can display the availability of a resource for the duration of a task assignment.

You enter the resource, planned start, planned finish and the system displays the total hours
that the resource has available for the duration of the task, as well as the hours available for
each individual fiscal period or daily period, from the current date forward. You can then
allocate planned hours for the task assignment based precisely on the time that the resource
has available.

If you also specify the planned hours for the task assignment, then the system includes the
planned hours when providing the resource’s availability.

Keep the following in mind when using this functionality:

• Resource availability is provided only from the current date forward, but planned hours are
allocated across the duration of the task assignment, even if the planned start is in the past.
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Therefore changing planned start dates in the past can change the allocation of planned
hours, which in turn changes the resource availability.

• Overallocations can distort the resource availability. For example, the duration of a task
assignment is two weeks, and a resource is overallocated for the first week, but is
completely available for the second. Because the total resource availability will be
reduced by the number of overallocated hours, it will appear that the resource has less
availability than they do.

The resource’s availability is calculated by the system as follows:

Daily capacity * Percent available for planned work – Committed hours

Where:

• Daily capacity is the amount specified for the resource in user setup. If an amount is not
specified for the resource, then the amount specified for the system is used. If a system
amount is not specified, then the default value of 8 hours is used.

• Percent available for planned work is set by the system administrator for the resource’s
workgroup.

• Committed hours includes all demand for all items in this project, other projects and in all
other items where demand is configured as committed

Displaying resource availability in the project worksheet

1. Access the project worksheet.

2. Create or select the task assignment and specify the following information:

• resource

• planned start

• planned finish

• planned hours (optional)

3. Click  .

The total availability for the task assignment is displayed in blue in the planned hours
column, and the availability per fiscal period or daily periods is displayed in the respective
columns.
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4. If you make changes to the worksheet, click  again to refresh the information.

Allocating planned hours to match resource availability

If you have displayed the resource availability in daily periods and you want to allocate the
planned hours according to the resource availability, you must use the calculate function.

1. Set up the project worksheet view for the calculate function. For more information see
"About date and effort calculations in the project worksheet" on page 134.

2. Display the resource availability for the task. For more information, see "About displaying
resource availability in the project worksheet" on page 124.

3. Set the Work percentage to 100.

4. Enter the planned hours.

5. Select the Level check box.

6. Click  .

Replacing planned information with forecast and actual information

You can replace planned information for task assignments with forecast information or actual
information (when actual information is available). The planned information is replaced as
follows:

• Planned start is replaced with the forecast start date

• Planned finish is replaced with the forecast finish date

• Planned effort is replaced with the total of forecast effort + actual effort that was entered
prior to the current date

The planned information cannot be replaced if the loading method is a manually distribute
loading method. Also, if the task assignment is for a successor task, then the planned start
cannot be replaced.

1. Lock the tasks that you want to work with.

2. Select the task assignments, and then click  .

The planned information is replaced with forecast and actual information.
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Editing the forecast information for task assignments in the project
worksheet

Project manager, project plan editors, and summary task editors can edit the following forecast
information for the task assignments that they have access to:

• forecast start and forecast finish

• remaining effort

• percent complete

For tasks that require status updates, the remaining effort and percent complete are calculated
according to the standard rules.

1. Add the following fields to the project worksheet view:

• Forecast start

• Forecast finish

• Remaining effort

• Percent complete

• Status not required (Add this field so that you can identify the tasks that do not require
status updates and therefore cannot be updated.)

2. Lock the tasks that you want to work with.

3. To update the remaining effort and percent complete based on actual effort, select the task
assignments, and then click  .

4. Edit the forecast information as required.

5. To mark a task assignment as complete, do one of the following:

• Change the percent complete to 100.

• Change the remaining effort to 0.

6. To reopen a closed task assignment, do one of the following:

• Change the percent complete to a value less than 100.

• Change the remaining effort to a value greater than 0.

7. To view the results of your changes, click outside of the current row.
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8. To save your changes, click  .

About updating remaining effort and percent complete based on actual
effort

You can update the remaining effort or percent complete for selected task assignments in the
project worksheet based on the actual effort that was entered by resources.

Task assignments that require status updates

Remaining effort is calculated as follows:

remaining effort = planned effort – actual effort

If actual effort is greater than planned effort, then the remaining effort cannot be calculated,
and a message appears.

Percent complete is calculated as follows:

percent complete = actual effort / planned effort * 100

Task assignments that do not require status updates

Remaining effort is calculated as follows:

remaining effort = planned effort – actual effort

If actual effort is greater than planned effort, then the remaining effort is set to 1.

Percent complete is calculated as follows:

percent complete = actual effort / (actual effort + remaining effort) * 100

Updating remaining effort and percent complete based on actual effort

1. Lock the tasks that you want to work with.

2. Select the task assignments, and then click  .

The remaining effort and percent complete are updated.

Viewing task status information in the project worksheet

To view whether the status of a task assignment is up to date

Add the Status up to date field to the project worksheet view.
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To view the last date that the status was updated.

Add the Last status field to the project worksheet view.

About viewing critical path information in the project worksheet

You can track the critical path for a project, and view the following information in the project
worksheet:

• critical tasks

• slack for the tasks that are not on the critical path, which is the number of days that the
planned finish for the task can be delayed before the task becomes critical

When you make changes to tasks that affect the critical path, the critical path and slack values
are recalculated for the current project only. Changes to a predecessor task in the current
project will automatically update a successor task in another project. However, the critical
path and slack for the other project is recalculated only when the other project is rolled up.

Note: In order for a predecessor task to be considered critical, the Move successor task
date option must be selected in the task dependency options.

Critical path information in linked MSP projects

For linked MSP projects, the slack in Changepoint is calculated similarly to total slack in
Microsoft Project.

However, there are differences in how critical path and slack are calculated:

• critical path – in Changepoint, inter-project dependencies are taken into account, whereas
in Microsoft Project, the critical path calculation is based on the current project only.
Therefore, the critical tasks can be different between the two applications.

• slack – in Changepoint, when the planned finish date is on a nonworking day, the working
day immediately before the nonworking day is used to calculate slack. Microsoft Project
treats the nonworking day as a working day.

Viewing critical path information in the project worksheet

Before you can view the critical path information, you must enable it for the project.

To enable critical path information for a project

1. Access the project for editing.
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2. Select the Calculate critical path check box.

3. Click Save.

To view critical path information in the project worksheet

You can view the critical tasks, and the slack information for tasks that are not on the critical
path.

1. Access the project in the project worksheet.

2. Add the following columns to the project worksheet view:

• Critical

• Slack

3. To update the critical path information after you make changes, click  .

4. To save the changes, click  .

Examples of allocating planned hours in the project worksheet

The planned start for all of these examples is August 24 (8/24). The daily capacity for the
resource is 8, and the percent available for planned work for the resource’s workgroup is 75%.

For each new task assignment, there is a pre-existing task assignment (for a different task) for
the same resource.

Planned hours entered and leveling selected

Resource enters the following information:

• planned start: 8/24

• planned hours: 12

• Level option selected

Planned finish is 8/27 and work percentage is calculated at 50%. Because leveling was
selected, the total effort for both tasks for each day is equal to 6 hours (resource daily capacity
* workgroup percentage).
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8/24 8/25 8/26 8/27 8/28
Planned
Hours

Existing task 3 3 2 4 0 12

New task 3 3 4 2 0 12

Planned hours and work percentage entered

Resource enters the following information and then clicks  :

• planned start: 8/24

• planned hours: 12

• work percentage: 50

Planned finish of 8/27 is calculated. Planned hours are allocated evenly up to the maximum of
50%, regardless of whether the total assigned hours for the resource exceed the resource’s
available hours of 6 hours.

8/24 8/25 8/26 8/27 8/28
Planned
Hours

Existing task 3 3 2 4 0 12

New task 3 3 3 3 12

Planned hours, work percentage entered and leveling selected

Resource enters the following information and then clicks  :

• planned start: 8/24

• planned hours: 12

• work percentage: 50

• Level option selected
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Planned finish of 8/28 is calculated. Planned hours are allocated up to a maximum of 50% of
available working hours per working day, but not if the total assigned hours exceed the
resource’s available hours of 6 hours.

8/24 8/25 8/26 8/27 8/28
Planned
Hours

Existing task 3 3 2 4 0 12

New task 3 3 3 2 1 12

Planned hours and duration entered

Resource enters the following information and then clicks  :

• planned start: 8/24

• planned hours: 12

• duration: 2

Planned finish of 8/25 is calculated. Planned hours are distributed to each day evenly for the
duration, regardless of whether the total assigned hours exceed the resource’s available hours
(6 hours).

8/24 8/25 8/26 8/27 8/28
Planned
Hours

Existing task 3 3 2 4 0 12

New task 6 6 12

Planned hours, work percentage and duration entered with leveling

Resource enters the following information and then clicks  :

• planned start: 8/24

• planned hours: 12

• work percentage: 50
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• duration: 4

• Level option selected

Because the planned hours cannot be allocated according to the work percentage and duration
that was specified, a warning message is displayed, and the system divides the combined sum
of the planned hours and committed work by the duration of the current task and then allocates
the planned hours so that the total hours for each day is more or less even, even if the total
hours for a day exceeds the specified work percentage or the available hours. If the available
hours for the resource is exceeded, a second warning message is displayed.

8/24 8/25 8/26 8/27 8/28
Planned
Hours

Existing task 3 3 2 4 0 12

New task 3 3 4 2 12

Planned hours entered with leveling, with and without work percentage

This example illustrates the difference of using leveling with and without specifying a work
percentage.

Resource enters the following information and then clicks  :

• planned start: 8/24

• planned hours: 15

• Level option selected

If the resource does not specify a work percentage, then the system allocates the planned hours
so that the total hours for each day is more or less equal for the duration of the task. The
system also calculates a work percentage of 50% (planned hours / (available hours per day *
duration)).
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8/24 8/25 8/26 8/27 8/28
Planned
Hours

Existing task 3 3 2 4 0 12

New task 2.38 2.38 3.35 1.35 5.54 15

If the resource enters the same information, plus a work percentage of 100, then the system
allocates the planned hours up to the amount of the work percentage, but not exceeding the
resource’s available hours.

8/24 8/25 8/26 8/27 8/28
Planned
Hours

Existing task 3 3 2 4 0 12

New task 3 3 4 2 3 15

About date and effort calculations in the project worksheet
After you apply the project worksheet view with the required columns to your project, you add
task assignments and enter various combinations of the information in some of the columns and
have the system calculate the rest and allocate the planned hours.

For example, you can specify two values out of: duration, planned start and planned finish, and
the system calculates the remaining value as follows:

• duration – number of working days between the planned start and planned finish dates

• planned start – starts at the planned finish, and then counts back the number of days in the
duration

• planned finish – starts at the planned start, and then counts forward the number of working
days in the duration

Similarly you can specify either work percentage or planned hours, and the system can
calculate the remaining value and duration as follows:

• work percentage – effort / (available hours per day * duration)
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• effort – available hours per day * duration * work percentage

• duration – effort / available hours per day / work percentage

For more detailed examples, see "Examples of project worksheet calculations" on page 137.

You can select single or multiple rows to be calculated. When you select multiple rows, the
order of calculation is based on dependencies first and then WBS. Predecessor tasks are
calculated first, then their successor tasks, and then the remainder of tasks in WBS order.
Therefore, tasks at the bottom of the WBS may have their dates moved because the planned
hours were allocated to the other tasks in the time period.

About using the Level option in project worksheet calculations

When selected, the Level option applies resource leveling, which means that all other
committed work for the resource is taken into consideration, including:

• demand items from other projects

• all other demand items that are configured as committed demand

• task assignments that have been updated but not yet saved in the current project worksheet

When selected and a work percentage is specified, allocates the planned hours up to the work
percentage for each day, taking into consideration all committed work for the resource.

If a Duration or No later than planned finish date is also specified, and the planned hours
cannot be allocated within the work percentage or time period constraints, then the system will
allocate the planned hours within the time constraints. The system divides the combined sum of
the planned hours and committed work by the duration of the current task and then allocates the
planned hours so that the total hours for each day is even.

Note: The Level option is available in the project worksheet even when resource leveling
is not enabled for the user’s workgroup. Also, this option includes all planned hours for the
current task assignment, regardless of whether or not they are configured as committed.

Performing date and effort calculations in the project worksheet

The values in the columns that are used during calculations are updated only when you click 
. If you perform calculations and then save and exit the project worksheet, the next time

you view the worksheet, the values will be the same as they were previously, regardless of
whether any of the information has changed in the meantime.
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1. Access the project worksheet.

2. Create a project worksheet view for calculations. For more information, see "Project
worksheet view for calculations, required columns" on page 136.

3. Apply the view to the project worksheet.

4. Create a task assignment and select a resource.

5. Specify the known values.

6. For the values that you want the system to calculate, you must clear the cells by clicking
the cells and deleting the existing values, including zeros.

Note: At this point, you can disregard errors for required fields.

7. Click  .

8. If the cell in the first column turns yellow, point to it to display the warning message.
Make the corrections and try again.

Project worksheet view for calculations, required columns

The project worksheet view for calculations must include the following columns in the
following order.

Column name Description

Planned start Planned start date for the task assignment. Must be specified if

No earlier than planned start check box is selected.

No earlier than
planned start

Check box. When selected, specifies that the planned start date

cannot bemoved earlier.

Duration Number of working days between planned start and planned

finish.

Planned finish Planned finish date for the task assignment. Must be specified if

No later than planned finish check box is selected.

No later than planned
finish

Check box. When selected, specifies that the planned finish date

cannot bemoved later.
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Column name Description

Work percentage Used only for project worksheet calculations. When specified by

a resource, it is themaximum percentage of daily capacity that

the assigned resource can be allocated to the task. When

calculated by the system, it is the percentage of the resource’s

gross available time (daily capacity * number of working days,

without taking into consideration any other demand on the

resource) that they have been allocated to the task.

Planned hours Estimated effort in hours that is required to complete the task.

Level Check box. Used only for project worksheet calculations. When

selected, applies resource leveling to the calculation. For more

information, see "About using the Level option in project

worksheet calculations" on page 135.

Fiscal periods Fiscal or daily periods for viewing and allocating planned hours.

Examples of project worksheet calculations

These examples apply to an organization that has a five-day work week from Monday to
Friday, and Saturday and Sunday are nonworking days. The daily capacity for the resource
is 8, and the percent available for planned work for the resource’s workgroup is 75%.

Information for examples

The following table provides some examples of project worksheet calculations:

• bold text indicates information entered by the resource

• [square brackets] indicates information that is calculated by the system

• planned start date for all examples is September 14 (9/14)
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Planned
Start

No
earlier
than
planned
start

Duration
Planned
Finish

No later
than
planned
finish

Work
Percentage

Planned
Hours

Level

Example 1 9/14 10 [9/25] 50 [30]

Example 2 9/14 10 [9/25] [50] 30

Example 3 9/14 [10] [9/25] 50 30

Example 4 9/14 [13] [9/30] 50 30 Y

Example 5 9/14 [9] [9/24] [55.56] 30 Y

For each of the examples, do the following:

1. Enter the values in bold text as provided in the table.

2. Clear (delete) the values that are to be calculated.

3. Click  .

The first example is explained in detail. The results for the remaining examples are explained
in the following sections.

Example 1: Calculate planned finish and planned hours

The system calculates the planned finish based on the planned start and duration:

9/14 + 10 days = 9/25

The system calculates the planned hours based on the duration and work percentage:

10 days * (6 hours per day * 50% = 3 hours per day) = 30 hours
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The planned hours are allocated at 3 hours per day for 10 days.

Example 2: Calculate planned finish and work percentage

The planned finish date is calculated based on the planned start and duration:

9/14 + 10 days = 9/25

The work percentage is then calculated based on the planned hours and duration:

work percentage = effort / (available hours per day * duration)

30 / (6 * 10) = 50%

The planned hours are allocated at 3 hours per day for 10 days.

Example 3: Calculate duration and planned finish

The duration is calculated based on the planned hours and work percentage:
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planned hours / (available hours per day * percent available for planned work) / work
percentage

30 / (8 * 75%) / 50% = 10

The planned finish is calculated based on the planned start and duration.

Example 4: Calculate duration and planned finish with resource leveling

The duration and planned finish is calculated based on the resource’s available hours for each
day (taking into account all other committed demand), and is restricted to the work percentage
specified.

available hours per day * work percentage

6 * 50% = 3 hours per day maximum

The planned hours are allocated to a maximum of 3 hours per day, taking into account the
resource’s available hours.
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Example 5: Calculate duration, planned finish and work percentage with
leveling

If the work percentage is not specified, then the system calculates the duration and planned
finish based on the shortest possible duration that the planned hours can be allocated with the
overall committed hours and as evenly as possible.

About the project worksheet Gantt chart
When the Gantt chart is first displayed, the time frame starts at the current date. The project
items in the worksheet are represented in the chart as follows:

• project – gray bar

• tasks – blue bars

• task assignments – green bars

• summary tasks – black bars

When you point to a bar in the Gantt chart, a tool tip appears that includes the task or task
assignment name, planned (or forecast) start and finish dates, and effort.

In addition, you can display the following information in the Gantt chart by right-clicking and
selecting the following options:

• critical tasks – red task bars

• progress – black bars within the task and task assignment bars

• one of the following:

• forecast effort – orange bars on the task and task assignment bars

• baseline – gray bars on the task and task assignment bars
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Note: The project worksheet Gantt chart can be printed to a physical printer only. Printing
electronic output, for example to Adobe PDF, PDF Creator, and Microsoft XPS Document
Writer is not supported.

To scroll outside of the time frame that is currently displayed

There is a second set of arrows in the horizontal scroll bar of the Gantt chart that you can use
to scroll outside of the time frame that is currently displayed.

To scroll to dates prior to the earliest date displayed, click the arrow on the far left.

To scroll to dates after the latest date displayed, click the arrow on the far right.

To scroll vertically on theGantt chart

If the number of rows cannot be displayed in the worksheet, a vertical scroll bar is available
on the far right side of the Gantt chart. You must scroll to the right to access this scroll bar.

Accessing the project worksheet Gantt chart

Before you access the Gantt chart, it is best to expand the section of the project that you want
to work with. Expanding one or more rows when the Gantt chart is displayed can take a long
time, especially for larger projects.

1. Access the project worksheet.

2. Expand the tasks that you want to work with.

3. Lock the tasks.

4. Click  .

Changing the timescale in the project worksheet Gantt chart

By default, the timescale in the Gantt chart shows months and weeks (the first day of each
week). You can zoom in to show less information in greater detail, or zoom out to show more
information in less detail. Every time that you click to zoom in or out, the level of detail
changes.

When you click to zoom in (or out) three times consecutively, the timescale changes. For
example as you zoom in, the timescale changes from showing months and weeks to showing
months and every three days, then months and every day. Conversely as you zoom out, the

142 | Changepoint PPM2017 SP1



About the project worksheet Gantt chart

timescale changes from months and weeks to quarters and months, and then to years and
quarters.

To change the timescale in the Gantt chart

To zoom in, click  .

To zoom out, click  .

To start the time frame at a specific date, specify the date in the Gantt chart date field 
.

To start the time frame at the planned start date of a project item, click the project item row
and then click  .

About managing tasks using the project worksheet Gantt chart

You access the Gantt chart from the project worksheet. You can move tasks, change task
durations, and create or delete task dependencies within the same project in the Gantt chart.

Before you can manage tasks, you must lock the tasks that you want to work with.

Changing the duration of a task in the project worksheet Gantt chart

You can change the planned finish date of a task as well as shorten or lengthen its duration by
moving the finish end of the task bar.

1. Point to the right (finish) end of the task bar, and when the double-sided arrow appears,
drag the end to the desired date.

2. Click .

Moving a task in the project worksheet Gantt chart

You can move tasks by dragging them forward or backward in the row. The start and end dates
of the task change, but the duration remains the same. Linked tasks move together as a group
to maintain their dependencies.

1. Click the task and then drag it to the desired date.

2. Click  .
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About task dependencies in the project worksheet Gantt chart

You can create dependencies between tasks that are displayed in the Gantt chart.

There is a line that links the predecessor and successor task when both tasks are displayed in
the Gantt chart. However, when only one of the linked tasks is displayed in the Gantt chart,
then only the arrowhead is displayed at the end of the task. Predecessor tasks have arrowheads
at the finish end, and successor tasks have arrowheads at the start end.

Note: Dependencies between tasks from different projects cannot be created or displayed
in the Gantt chart.

You can edit the settings for linked tasks such as the lag time, or whether the dependent task
must start on a working day. For more information, see "Editing settings for linked tasks in the
project worksheet" on page 102.

Linking tasks in the project worksheet Gantt chart

1. Click the predecessor task, and then drag it down towards the successor task.

A tooltip indicates the potential successor tasks as you point to them.

2. Release the predecessor task on the successor task.

The dependency is created, and the successor task is moved to start on the first working
day after the finish date of the predecessor task.

3. Click  .

Unlinking tasks in the project worksheet Gantt chart

1. Right-click the dependency line, and then select Delete dependency.

2. Click  .

Showing the progress of tasks and task assignments in the project worksheet
Gantt chart

In the Gantt chart, you can view the progress of tasks and task assignments that have had
status updates. On task assignments, the progress is displayed as a black bar that represents
the percent complete of the task assignment.

On tasks, the progress bar represents the percent complete of the task, which is calculated
using the following formula:

actual effort / (actual effort + remaining effort) * 100
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Progress bars are not available for summary tasks and milestone tasks.

To show progress in the Gantt chart

Right-click in the Gantt chart, and then select Show progress.

Showing the critical path in the project worksheet Gantt chart

You can show the critical path in the Gantt chart provided that the critical path option has been
enabled for the project. The critical tasks are displayed as red bars instead of the usual blue.

Tip: To verify whether the critical path option has been enabled for the project, you can
add the Calculate critical path column to the project worksheet view.

To show the critical path in the Gantt chart

Right-click in the Gantt chart, and then select Show critical path.

Showing forecast or baseline information in the project worksheet Gantt
chart

You can show either the forecast information or the baseline information, but not both at the
same time.

To show forecast information in the Gantt chart

Right-click in the Gantt chart, and then select Show forecast. The forecast start date, finish
date, and effort appear as orange bars against the task and task assignment bars in the Gantt
chart.

To show the baseline information

Right-click in the Gantt chart, and then select Show baseline. The baseline appears as gray
bars against the task and task assignment bars.

Print Setup dialog box options for the project worksheet Gantt chart

When the Gantt chart is displayed, a different set of printing options are available when you
click  .

Note: The project worksheet Gantt chart can be printed to a physical printer only. Printing
electronic output, for example to Adobe PDF, PDF Creator, and Microsoft XPS Document
Writer is not supported.
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Option Description

Grid check box When selected, prints the information in the grid.

Gantt chart check box When selected, prints the Gantt chart.

Area displayed in
worksheet option

When selected, prints only the portion of the worksheet that is

currently displayed onscreen. Any information that you have to

scroll to view is not printed.

Time range option
When selected, prints only the information that is within the

specified start and end date. Available only when theGantt
chart check box is selected.

Start date field
Start date of the time range. Available only when theGantt
chart check box is selected.

End date field
End date of the time range. Available only when theGantt chart
check box is selected.

Entire project option When selected, the entire project is printed.

wide list

The number of pages to print the worksheet on horizontally:

• Single page – prints the width of the worksheet on a single
page

• Multiple pages – prints the width of the worksheet on as
many pages as are required.

tall list

The number of pages to print the worksheet on vertically:

• Single page – fits all rows of the worksheet to print on a
single page

• Multiple pages – prints the worksheet on as many pages
as are required.
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PPW basics

The project planning worksheet (PPW) is a spreadsheet-like application that will replace the
project worksheet. You use PPW to do the following:

• create tasks and edit all task fields

• assign resources to tasks

• create task assignments and edit all task assignment fields

• allocate planned effort to daily or fiscal periods

The tasks that you create in PPW are draft, and must be activated before they appear in the
projects tree view and the timesheet. You can edit both draft and active tasks in PPW and
the project worksheet. However, draft tasks that are edited in the project worksheet must
pass all validation that is required to save the project worksheet.

Tip: To identify the draft tasks in the project worksheet, add the Draft field to the
project worksheet view. If you prefer not to view the draft tasks in the project
worksheet, create a filter to exclude the draft tasks.

The Gantt chart appears by default, but you can hide it or display only the Gantt chart and
not the table rows.

PPW settings

You can set default settings for PPW. For more information, see the following topics:

• "Specifying a default dependency type and lag time" on page 172

• "Setting up a warning when effort distribution on task assignments is overridden" on page
176

• "Specifying the default settings for replacing past effort in PPW" on page 1

PPW best practices

For the best results when using PPW, the following best practices are strongly
recommended.
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Add only the required resources to your preferred resources list

It is not good practice to add all of the resources in your organization to your preferred
resources. Add only the resources that you assign to tasks regularly. A long list of preferred
resources increases the loading time of PPW because the nonworking days data for each
resource is preloaded.

Use task assignment views for detailed assignment work

It is best to use a task assignment view for doing detailed work such as the following:

• manually distributing effort to daily or fiscal periods

• using different loading methods for assignments for the same task

• assigning different planned start and planned finish dates to different resources who are
assigned to the same task.

• adding additional resources to a task once one or more of the previous points apply to it

Limit the length of task durations

Limit the length of task durations, ideally to a year or less. It is not good practice to have an
open task with a duration that spans many years. The nonworking day information is preloaded
for each task based on the date range within the worksheet. Tasks that have long durations
require years of data to be preloaded.

Limit the number of tasks, and resources assigned to a task

Keep the number of tasks within a project, and the number of assignments for each task to a
reasonable level. Having a single open task that hundreds or thousands of resources enter time
for can cause serious performance issues in PPW. If you use open tasks for year-long
activities such as training and development, non-chargeable work, or meetings, consider doing
the following:

• creating a new project for each fiscal year

• creating separate projects for different parts of the organization

• restricting access to open tasks by workgroups or functions
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Keep projects at a manageable size

Keep project size from 400 – 1200 task or task assignment rows, and do not have more than
100 rows under any given level.

Create at least three levels of hierarchy in projects

Projects with a flat list of tasks are difficult to manage and take longer to be displayed in PPW
because all of the tasks must be displayed each time you access the worksheet. In contrast,
when the tasks in a project are organized in a hierarchy, you can expand and collapse sections
to focus on the data that you need to modify.

Grant "view project" access to summary task managers

Grant View project access to summary task managers so that they can view the entire project
in PPW. Otherwise summary task managers can only view the tasks under their summary
tasks, and if they make changes, the values will be rolled up to include only the amounts from
their summary tasks and not the project totals.

Avoid saving the worksheet frequently

Doing work in batches and then saving will result in better performance and less waiting.

Use Firefox or Chrome browsers

The Firefox and Chrome browsers are recommended, especially to perform actions such as
copying and pasting many tasks at once. Firefox and Chrome are more efficient at processing
data than other browsers.

Do not access different versions of Changepoint at the same time

If you have access to different versions of Changepoint for example, in test and production
environments, do not access them at the same time because you might encounter issues due to
the caching of files. Ensure that you clear your browser cache before signing into a different
environment.

Ensure all time records are actual time before marking tasks or task
assignments as completed.

The point at which time records are considered actual time by your organization is controlled
by a setting in Changepoint Administration. The setting options are:

• when the time is entered in the time sheet
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• when the time records are submitted in the time sheet

• when the time records have been approved

The actual finish date is determined based on the actual time for the tasks or task assignments
at that time that the task or task assignment is marked as completed. If time records are
considered actual time only after time is submitted or approved, and a task or task assignment
is marked as completed before the time records have been submitted or approved, there might
be an actual finish date, but no true actual hours.

As a best practice, ensure all time records are actual time before marking tasks or task
assignments as completed.

Accessing PPW

If you are the project manager, project plan editor, or summary task manager with the required
access rights, the project and all of its tasks are locked automatically when you access PPW,
unless one or more project tasks are locked by other resources. The project manager can
remove the locks from other resources, but those resources will lose any unsaved changes.

Summary task managers can view the subtasks under their summary tasks, the task hierarchy
above their tasks, and the hierarchy of tasks that are linked to their tasks. However, they can
only edit tasks under the summary tasks to which they are assigned.

A message beside the project name indicates whether you or another user has the project
locked. If the project is locked, you will receive a notification when it becomes unlocked.

Resources with view access to the project can view a read-only version of PPW.

1. Click General > Projects.

The Projects tree view appears.

2. In the tree view, do one of the following:

• Right-click the project and select Project planning worksheet.

• Click the project to open the project profile, and then click Actions > Project
planning worksheet.

The project planning worksheet appears.

3. To unlock the project so that other resources can edit tasks, click .
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PPW keyboard shortcuts

Action Key combination

Add a task row Insert key

Copy selected tasks Ctrl+C

Go to next cell Tab

Go back to previous cell Shift+Tab

Go to row or item above Up Arrow key

Go to row or item below Down Arrow key

Expand tasks Alt+Shift+Plus sign (+)

Collapse tasks Alt+Shift+Minus sign (-)

Indent selected tasks Alt+Shift+Right Arrow

Outdent selected tasks Alt+Shift+Left Arrow

Paste selected tasks Ctrl+V

Select or clear a check box Spacebar

Expanding and collapsing tasks in PPW

You can show and hide the subtasks under a task by expanding and collapsing tasks, subtasks,
or the entire project as follows:

• To expand a single task or subtask, click the right arrow next to the task or subtask name.

• To collapse a single task or subtask, click the down arrow next to the task or subtask
name.

• To expand or collapse all subtasks under a task, click the task row, and then click  or 

.

• To expand or collapse all tasks in a project, do one of the following:
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• ensure no tasks are selected and then click  or 

• select all tasks, and then click  or 

Note: If the project is large, it may take a while for all tasks to be expanded.

Indenting and outdenting tasks in PPW

You can indent or outdent one or more tasks at a time.

1. Access PPW.

2. Select one or more tasks.

3. To indent the tasks, click  .

4. To outdent the tasks, click  .

Moving a task in PPW

You can move one or more tasks to a different row in PPW. When you move a task, all of its
subtasks are moved, and the row IDs are adjusted accordingly, including in the Predecessor
column of dependent tasks.

1. Select the tasks that you want to move.

2. Point to the first blank column on the left.

3. When the cursor changes to a four-headed arrow, drag it to the desired row. A line
appears above the row where the tasks will be inserted.

About printing in PPW

You can print PPW by clicking  . The printout includes each row, but only includes the

columns and portion of the Gantt chart that are displayed in the current view.

About switching PPW views and filters

You can temporarily switch the PPW view by clicking the down arrow next to the view icon
, and then selecting a different view.
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Similarly you can temporarily switch the PPW filter by clicking the down arrow next to the
filter icon , and then selecting a different filter.

Note: Both the view and filter must be of the same type (task or task assignment). Also if
you have set a default view or filter, the currently selected view or filter applies only until
the next time you access PPW.

To permanently switch to a different view or filter, you must select it as the default when you
edit the view or filter.

Running a report from PPW

You can run reports from PPW. Both Cognos and Report Designer reports that are configured
to be launched from either the project or task profile page will be available.

When a report is run from PPW, the following differences apply:

• links to entity records are not available

• draft tasks do not appear in reports unless the report is based on the unsecured Cognos data
model

To run a project report

Click , and then select the project or task report.

To run a task report

1. Select a task row, and then click .

2. Select a task report from the list that appears.

Exporting PPW to Microsoft Excel

1. Access PPW.

2. Click  .

The worksheet data is displayed in an Excel spreadsheet.

Tip: Include the WBS field in the view if you want to sort the rows by WBS order.
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Copying values in rows in PPW

You can copy a value from a column in a source row to one or more target rows that are
below the source row. You can copy a value from any of the columns in the current PPW
view, except for the Resources column.

1. In PPW, select the source row that contains the value that you want to copy.

2. Select one or more target rows that are below the source row.

3. Click , and then select the column that contains the value that you want to copy.

The value is copied to each of the target rows.

About PPW views
PPW views control the data that is displayed in PPW. There is a default view for tasks, which
contain a subset of the task fields. You can edit the default task view as well as create your
own task and task assignment views.

Task views

You use task views to do the following:

• create tasks

• edit task fields

• create task assignments that use the default loading method

In general, task assignments that are created in the task view automatically inherit the values
of the task fields that are displayed in the task view when the task assignment is created.

In some cases, you might not be able to edit the planned start, planned finish, or planned effort
in a task view (for example, if any assignments have a manual loading method). In these
cases, you must switch to a task assignment view.

Task assignment views

You use task assignment views to do more detailed assignment work such as:

• manually distribute effort to daily or fiscal periods

• use different loading methods for assignments for the same task

• assign different planned start and planned finish dates to assignments for the same task
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• add additional resources to a task once one or more of the points above apply to it

Note: Only task assignments are displayed in a task assignment view. Therefore there
must be at least one existing task assignment for a task before you can assign additional
resources to the task.

You add a new task assignment or copy a task assignment based on an existing task
assignment. New task assignments have current dates and inherit the default loading method
only. Copied task assignments are the same as the original task assignments but do not have
the assigned resources.

Note: To change the resource for a task assignment, you must copy the task assignment,
assign the new resource to it, and then delete the original task assignment.

About creating PPW views

You can create your own task views or task assignment views, where you do the following:

• include either task or task assignment fields

• specify the standard and configurable fields that are displayed as columns in PPW

• add columns to, and remove columns from, the frozen pane

• change the order of the columns

• specify a view as your default view

• share your views with other resources

• specify a sort order for the rows

About related columns

The following pairs of columns are related and either must be updated at the same time, or the
value in one affects the value in the other. Therefore it is best to display both columns in the
worksheet if you plan to work with them:

• Staffing level and Staffing level expiry date. If you change the staffing level, you must
specify the date after which the new staffing level becomes effective.

• Chargeable task and Effective date

• Cross charged to fixed-fee portion of the initiative and Fixed fee

• Work code category andWork code
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• Work location group andWork location

• Locked and Include in resource demand

• Open task and Assignment planned hours

Creating a PPW view

1. Access PPW.

2. Click  . The Manage Views dialog box appears.

3. Do one of the following:

• To create a new view, click New.

• To copy an existing view:

• In the Views list, select the view that you want to copy.
• Click Copy.

4. Complete the fields as required. For more information, see:

• "Manage Views (PPW) dialog box options" on the facing page

• "Available columns for PPW task views" on page 158

• "Available columns for PPW task assignment views" on page 163

5. To add columns to the view, in the Available columns list, select one or more columns
and then drag them to the Frozen columns or Columns list.

Note: Do not add the Effort distribution column to the frozen columns due to its size.

6. To remove a column from the view, drag it to the Available Columns section.

7. To move all of the columns in a section at once, click Select all, and then drag the
columns to the desired list.

8. To change the order of the columns, select a column name and then drag it to the desired
position in the list. The columns display left to right in PPW in the order that they are listed
in the Frozen columns and Columns lists.

9. When you are finished, click Save.
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Manage Views (PPW) dialog box options

Option Description

Views list Current view.

Name field Name for the view.

Type of view field Option to select whether the view displays tasks or task

assignments.

Shared check box When selected, allows other resources to use the view.

Available only if you have the access rights to share views.

Default check box When selected, makes the current view the default view for the

current resource and removes the default status from the view

that was previously specified as the default, if applicable.

Selected Columns section

Frozen columns list List of columns that remain in place even when you scroll

horizontally. The order of the columns from top to bottom in the

list is the order that the columns display in PPW from left to

right.

Columns list List of columns that are displayed in PPW. The order of the

columns from top to bottom in the list is the order that the

columns are displayed in PPW from left to right.

Available Columns section

All columns list List of available entity fields to be displayed as columns.

Step 2: Specify sort order of rows section

Sort by column data list Determines the sort order for the rows. For more information,

see "Sorting the rows in PPW " on page 167.
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Available columns for PPW task views

Column name Description

Actual finish date field Date of the latest time record or the date that the task is marked

as completed.

Actual hours field Total number of hours of work that have been entered for the

task.

Actual start date field Earliest date that hours have been entered for work done for a

task.

Add to calendar check
box

When selected, the planned hours for the task are included in the

personal calendars of the assigned resources and the resource

scheduling calendar.

Allow work code
override check box

When selected, resources can choose a different work code

when they enter time for the task.

Allow work location
override check box

When selected, resources can choose a different work location

when they enter time for the task.

Assignment planned
hours field

For open tasks only. Planned hours for new task assignments

that are created when a resource enters time for the open task.

This field is not available when resource restrictions or resource

leveling is enabled.

Baseline finish date
field

Latest planned finish date of all task assignments and subtasks,

as at the last time a baseline was created for the project or task.

Baseline hours field Total planned hours for project tasks.

Baseline start date field Earliest planned start date of all task assignments and subtasks,

as at the last time that a baseline was created for the project or

task.

Capital check box When selected, designates the task as a capital cost.

Chargeable task check
box

When selected, indicates that the task is chargeable.
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Column name Description

Comments field Additional information about the task.

Completed check box When selected, sets the task to completed status. Typically

used for tasks that are not assigned to resources, such as

milestone tasks. When a task is set to complete, the status for

the task assignments is automatically set to complete.

The task is automatically set as completed when all of its task

assignments are completed.

Critical check box Read-only. When selected, the task is a critical task. Available

only if the option for calculating critical is selected on the project.

Cross-charged to
fixed-fee portion of the
initiative check box

When selected, cross charges the task to a fixed-fee portion of

the initiative. The time entered for this task does not display on

the cross charge.Note: Changing the setting affects all
uncharged time.

Draft check box Read-only. When selected, indicates the task is draft.

Duration field Number of working days between planned start and planned

finish dates of the assignment. If no assignments exist or

multiple assignments exist, the working days come from the

staffing workgroup of the initiative.

Effective date field The date of the new chargeable status for the task if the

chargeable status of the task has been changed. The new status

is applied to all uncharged time records dated on or after the

specified date.

Tip: To clear all existing history of changes to the chargeable
status and apply the new status to all uncharged time records,

you can leave the field blank.

Effort Distribution
columns

Displays daily or fiscal period columns for allocating planned

effort manually.

First blank column Used for moving tasks.

Project Management | 159



7. Project PlanningWorksheet (PPW)

Column name Description

Fixed fee list Deliverable to which the task is associated, if theCross
charged to fixed-fee portion of the initiative option is
selected. Specifying a deliverable allows costs and revenues to

be tracked against fixed fees.

Forecast finish date
field

Estimated date that the task will be completed.

Forecast start date field Estimated date that work will begin for a task.

Function list Default job function for resources that are assigned to the task.

You can override the default for task assignments.

ID Row identifier for use in task dependencies.

Include in resource
demand check box

When selected, new task assignments created for this task are

included in resource demand analysis by default. Selected by

default on new tasks.

The setting for this field is also used as filter criteria for task

assignments in the resourcemanagement worksheet.

You can override the default for task assignments.

Initiative non-labor
item ready to cross-
charge check box

When selected, the initiative non-labor items that are associated

with the task become available for cross charging.

Initiative non-labor
items field

Non-labor items that are associated with theinitiative and for

which theAllow selection on tasks option has been selected.
When an initiative non-labor item is associated with a task, it can

be cross charged based on the status of the task.

Locked by field Read-only. Resource who has locked the task.

Locked task check box When selected, prevents resources from entering time for the

task assignments for the task. However, you can change the

setting for individual task assignments.
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Column name Description

Milestone check box When selected, indicates that the task is amilestone.

Milestones are displayed as diamond-shaped icons in the Gantt

chart.

MSP WBS number
field

For MSP projects only. TheMicrosoft Project work breakdown

structure number for the task.

Non-labor item list Non-labor item associated with the task for reporting purposes.

That is, you can create reports based on the e non-labor items

that are associated with the tasks.

If you associate more than one non-labor item with a task, thee

non-labor item that is closest to the top of the list alphabetically is

designated as the primary e non-labor item. If required, you can

change the primary non-labor item in the task editing view.

Open task check box When selected, makes the task an open task and the

Assignment planned hours field appears.
For more information, see "Open tasks" on page 51.

Open task restriction
check box

Read-only. When selected, access to the current open task has

been restricted.

Phase Specifies the project phase that the task belongs to.

Planned finish Date that work for the task is scheduled to finish.

Planned hours Estimated effort that is required to complete the task. If you use

theResources list on a task view to assignmore than one

resource, the effort is initially split evenly among the resources.

Planned start Date that work for the task is scheduled to start.

Predecessors Task ID of the task on which the current task has a dependency.

Remaining hours field Number of planned hours remaining to complete the task, based

on resource status updates.
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Column name Description

Request type-ahead
field

Resource number of the request that is associated with the task.

Resources list Resources who are assigned to the task.

Staffing role field Default staffing level for resources that are assigned to the task.

The staffing levels come from the initiative.

Status not required
check box

When selected, resources are not required to update the status

of their task assignments. When selected, resources are not

required to update the status of their task assignments. The

project rollup calculates the remaining hours as planned hours

minus actual hours. If the actual hours are greater than the

planned hours, remaining hours will be set to 1. The option can be

overridden on the task assignments.

Task name field Name of the task.

Utilization eligible
check box

When enabled, the task time is included in the utilization for

assigned resources.

WBS field Work breakdown structure for the task.

Work code category
list

Work code list

Work code category and work code of the task. Can be used for

taxation and reporting purposes. Can be used for reports and

calculating taxes.

Work location group
list

Work location list

Work location group and work location where the work will be

performed. Can be used for reports and calculating taxes.
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Available columns for PPW task assignment views

Option Description

Actual finish date field Date of the latest time record or the date that the task is

marked as completed.

Actual hours field Total number of hours of work that have been entered for

the task.

Actual start date field Earliest date that hours have been entered for work done

for a task.

Allow work code override
check box

When selected, resources can choose a different work

code when they enter time for the task.

Allow work location
override check box

When selected, resources can choose a different work

location when they enter time for the task.

Assignment comments field Additional information about the task assignment.

Baseline finish date field The finish date of the last baseline that was saved for the

task assignment.

Baseline hours field The planned hours of the last baseline that was saved for

the task assignment.

Baseline start date field The start date of the last baseline that was saved for the

task assignment.

Completed check box Read-only. When selected, the task has been set to

completed status. Typically used for tasks that are not

assigned to resources, such as milestone tasks. When a

task is set to complete, the status for the task

assignments is automatically set to complete.

The task is automatically set as completed when all of its

task assignments are completed.
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Option Description

Cost rate field Read-only. The staffing level-based or resource-based

cost rate that applies to the task assignment and which is

in effect as at the planned start date of the task

assignment.

Cross charge rate field Read-only. Cross charge rate for the assignment and

which is in effect as at the planned start date for the

assignment. For more information, see "About cross

charge rates for initiatives" in the InitiativeManagement
User Guide .

Draft check box Read-only. When selected, indicates the task is draft.

Duration field Number of working days between planned start and

planned finish dates.

Effort Distribution columns Displays daily or fiscal period columns for allocating

planned effort manually.

Forecast finish date field Estimated date that the task will be completed.

Forecast start date field Estimated date that work will begin for a task.

Function list Job function for the task assignment. The default function

comes from the task, but you can override the function on

task assignments.

Include in resource demand
check box

When selected, the task assignment is included in

resource demand. You can override the setting for task

assignments.

The setting for this field is also used as filter criteria for

task assignments in the resourcemanagement worksheet.

Last status date field Most recent date that the status was updated for the task

assignment.

Loading method field Loadingmethod for the task assignment.
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Option Description

Locked task check box When selected, prevents the resource from entering time

for the task assignment. The setting is inherited from the

task but can be changed on task assignments.

Percent complete field Percentage of the planned effort for the task that has been

completed.

Planned finish date field Estimated date that the assignment will be completed. The

default date is the day after the planned start date. For

manual loadingmethods, the planned finish datemust be

on or later than the last date that contains effort.

Planned hours field Estimated number of hours required to complete the

assignment. If the loadingmethod is manual, then the

planned hours cannot be edited. If the loadingmethod is

one that updates past periods, then the planned hours must

be equal to or greater than the total number of actual hours

in past periods.

Planned start date field Date that the work should begin. The default date is the

date that the task assignment is created. If the loading

method is manual, then the datemust be on or before the

earliest date that contains effort.

Remaining hours field Number of hours remaining to complete the task.

Requested Resource field Read-only. Resource that was requested on the

associated resource request.

Resource comment field Resource's comment from the task status update.

Resource list Resource who is assigned to the task.

Resource Request number
field

Number of the resource request.
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Option Description

Soft-booked check box When selected, the resource is tentatively booked for

planning purposes. Soft-booked time is shown as flexible

on the resource schedule calendar.

When cleared, the resource is committed to the project.

Staffing role expiry date If the staffing level is changed, the date after which the
new staffing level becomes effective.

Staffing role field Staffing level for the task assignment. The available

staffing levels come from the initiative.

Status not required check
box

When selected, resources are not required to update the

status of their task assignments. The project rollup

calculates the remaining hours for assignments that do not

require updates as planned hours minus actual hours. If the

actual hours are greater than the planned hours, the

remaining hours is set to 1.

Status up to date check box Read-only. When selected, indicates the task status is

current.

Task name field Read-only. Name of the task.

WBS order field Read-only. Number for the task that corresponds to the

order of the work breakdown structure. It can be used for

sorting purposes in views and when exporting data to

Excel.

Work code category list
Work code list

Work code category and work code of the task. Used in

reports and for calculating taxes.

Work location group list
Work location list

Work location group and work location where the work will

be performed. Used in reports and for calculating taxes.

About sorting rows in PPW

By default, rows in PPW are in WBS order, but you can define a different sort order for rows
based on the data in one or more columns. However, changing from the default sort order
affects how items are displayed and limits the functionality in the view as follows:
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• items are listed in a flat list

• some column data might be repeated

• you cannot add or remove rows or reorder rows

• you cannot indent or outdent rows

• Gantt chart is not available

Sorting the rows in PPW

You can specify a sort order for the rows based on the data in one or more columns. For
example, you can sort task assignments by resource, then by planned start date.

1. Click  . The Manage Views dialog box appears.

2. In the Step 2: Specify sort order for rows section, drag the column that you want to sort
by first to the top of the Sort by column data list.

3. To specify the sort order, do one of the following:

• To sort in ascending order, click the up arrow next to the column name.

• To sort in descending order, click the down arrow next to the column name.

4. To sort by additional columns:

a. Drag the column that you want to sort by second to just below the first column.

b. Specify the sort order by clicking the up arrow (ascending) or down arrow
(descending).

Note:When both the up and down arrows appear next to the column name, sorting is not
applied.

5. To remove sorting from a column, click the arrows until both the up and down arrows
appear.

6. Click Save.

Editing a PPW view

You can edit all of the settings for a view except for the view type.

1. Access PPW.
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2. Click  .

The Manage Views dialog box appears.

3. From the View list, select the view that you want to edit.

4. To delete the view, click Delete, and then confirm the deletion.

5. To change the name of the view, type the new name in the Name field.

6. Make the necessary changes. For more information, see "Creating a PPW view" on page
156.

7. When you are finished, click Save.

About filtering data in PPW
You filter the data in PPW by creating a filter and then applying it to PPW so that only the
tasks or task assignments that match the filter criteria are displayed. For example, you can
create a filter that displays only the tasks that were created after a specific date, or only the
task assignments that have fewer than 8 planned hours.

You base the filter criteria on the data in the task or task assignment fields (columns). There
are logical AND and OR operators and parentheses that you can use to create more complex
filter criteria.

You can apply a filter only if it is for the same entity type as the current view. The names of
the current view and filter are displayed at the bottom left corner of PPW.

Note: Filter criteria is applied to the values for configurable fields only after the
configurable field has been saved, whereas filter criteria is applied to standard field values
as soon as the value is entered in PPW.

Creating a PPW filter

1. Access PPW.

2. Click  . The Manage Filters dialog box appears.

3. Click New.

4. Complete the fields as required. For more information, see "Manage Filters (PPW) dialog
box options" on page 169.
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5. To specify filter criteria:

a. In the Filter on column, select the column that the criteria row applies to.

b. In the Condition column, select the condition for the information in the column.

c. In the Value column, select the values that the condition must meet.

6. To add an AND or OR operator, or parentheses, click a blank column in the row and then
select the item from the list.

7. To add (or delete) a criteria row, right-click in the table, and then select Insert (or
Delete).

8. Click Save.

Manage Filters (PPW) dialog box options

Option Description

Filter list Current filter.

Name field Name of the filter.

Type of filter options Option to select whether the filter displays task or task

assignments.

Default check box When selected, the current filter is automatically applied each

time that you access PPW.

Shared check box When selected, other resources can use the filter.

Blank columns Lists of operators (AND, OR) and parentheses for complex

filter criteria.

Filter on column Column or field that the filter criteria applies to.

Condition column Condition for the criteria row.

Value column Value for the condition.

Editing a PPW filter

You can edit the settings for a filter except for the type of filter.

1. Access PPW.
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2. Click  . The Manage Filters dialog box appears.

3. In the Filter list, select the filter.

4. Make the necessary changes. For more information, see "Creating a PPW filter" on page
168.

5. To delete the filter, click Delete, and then click OK to confirm the deletion.

6. When you are finished, click Save.

Creating a task in PPW
1. Access PPW.

2. If necessary, lock the project for task editing by clicking .

The project is locked and additional icons appear on the worksheet.

3. Ensure that a task view is displayed.

4. To create a top-level task, click . The new task row appears on the bottom row.

5. To insert a task into a specific row, click the task row under which you want the new task
to be, and then click (or press the Insert key). The new task row appears after the

subordinate tasks of the task that you clicked.

6. For information about assigning resources, see "Assigning resources to a task in PPW" on
page 174.

7. Complete the fields as required.

For more information, see "Available columns for PPW task views" on page 158.

8. You can create a summary task by indenting tasks under a task, or outdenting a task over
other tasks:

• To indent a task, select the task and then click  (or press Alt+Shift+Right Arrow).

• To outdent a task, select the task and then click  (or press Alt+Shift+Left Arrow).

9. Click Save.

The draft task is created.
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10. To activate tasks, see "Activating a task in PPW" on page 187

Tip: To work with task assignment details such as allocating different planned effort to
daily or fiscal periods manually to assigned resources, switch to a task assignment view.

About rollup in PPW

In PPW, the project data is rolled up automatically as you work so that you can view the
effects of your changes to the project totals. Note however, that the totals include only the
tasks or task assignments that are currently displayed in PPW and are not saved until you save
PPW.

For general information about how project data is rolled up, see "About rolling up projects" on
page 48.

Note: Only a portion of the project is displayed when a filter has been applied, or if the
resource is a summary task manager who does not have view access to the project. Also,
summary task totals are not displayed when a sort order is defined in a PPW view.

About linking tasks in PPW

You link tasks in PPW by specifying the dependency information in the Predecessors column
of the successor task, using the following format:

[task ID][dependency type][+/–lag time]

Where:

• [task ID] is the number from the ID column

• [dependency type] is the two-letter abbreviation (case-insensitive) for the type:

• FS – finish-to-start (default type)

Note: Because finish-to-start is the default dependency type, the “FS” is not required, and
will be removed if you enter it.

• SS – start-to-start

• FF – finish-to-finish

• SF – start-to-finish

• [+/– lag time] – plus sign for lag time, or minus sign for lead time, and the number of
working days
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For example, if the [task ID] is “3”, dependency type is start-to-start, and [lag time] is two
days, then you would enter:

3SS+2

You can add multiple predecessor tasks by separating them with a comma, for example:

3SS+2, 5SF-3

Specifying a default dependency type and lag time

The default dependency type for linking tasks is finish-to-start, but you can specify a different
dependency type as well as a lag time. If you specify a different default dependency type and
lag time, when you enter the task ID in the Predecessors field, the dependency type and lag
time are added automatically.

For example, you specify Start-To-Start as the dependency type and "4" as the lag time, and
you want to create a dependency for task ID 3. You can simply enter 3 in the Predecessors
field. When you click out of the cell, "3SS+4" appears automatically. You can specify other
dependency types and lag periods as required.

1. Access PPW.

2. Click . The Project Planning Worksheet Settings dialog box appears.

3. In the Lag time field, specify the number of lag days between the tasks.

4. In the Dependency type list, select the dependency type.

5. Click Save.

Copying a task in PPW

You can copy one or more tasks and then paste them into PPW. When you copy a task, all of
its subtasks are included. If you copy tasks from different WBS levels, the tasks are pasted
into the row below the task that you select as the insertion point, but into the same WBS level
as the task.

Values for fields that are included in your view are copied. In some cases, default values are
applied to fields that are missing from your view.

1. Access PPW.

2. If required, lock the project for task editing by clicking .
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3. Select one or more tasks

4. Click (or press Ctrl+C).

5. Select the row above where you want to insert the tasks, and then click (or press

Ctrl+V).

6. Edit the tasks, if required.

7. Click Save.

About assigning resources to tasks in PPW
You can assign one or more resources and/or personal groups to a single task or to multiple
tasks all at once. You can split the planned effort equally among the resources or specify
different effort amounts or percentages for each resource. Percentages of planned effort are
calculated based on the total planned effort for the task.

About the preferred resources list in PPW

The preferred resources list includes the resources that are assigned to tasks in the current
project in addition to the resources that you added to the list.

Assigning personal groups to tasks

When you assign a personal group to a task using the Resources list, all resources in the
personal group are assigned to the task, and the planned effort is distributed evenly among the
resources. You can edit the planned effort amounts manually if required.

Assigning multiple resources to a task

When you assign more than one resource to a task, either individually or by assigning a
personal group, you can add, edit and delete resources and specify the effort amounts for each
resource all in one dialog box. If the total of the planned effort that is allocated to resources is
different from the total planned effort for a task, you must either update the task total, or adjust
the allocated amounts to equal the task total.

If you select a group using the Assign Resources dialog box, the planned effort or percentage
that you specify in the row will be assigned to each member of the group, but can be changed
later.
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Assigning resources to multiple tasks

If you select multiple tasks, each resource that you assign will be assigned to all of the
selected tasks. If a resource is already assigned to one or more of the tasks, you can either add
the new planned effort amount to the resource’s existing planned effort amount for the task, or
leave the resource’s existing planned effort amount as-is.

If you select the option to evenly distribute the planned effort, the planned effort is distributed
evenly among the newly assigned resources and previously assigned resources that use loading
method 4.

Assigning resources to summary tasks

When you use the Resources list to assign resources to summary tasks, the planned effort is
automatically set to 0 because time cannot be entered for summary tasks.

However, you can assign effort to a summary task in the Assign Resources dialog box or in a
task assignment view. Planned effort for a summary task includes the assignments to the
summary task as well as its subtasks.

About duration calculations in PPW

The duration of a task is calculated based on the number of working days between the planned
start and the planned finish dates. If no resources are assigned to the task, then the working
days of the staffing workgroup of the initiative are used. If only one resource is assigned to the
task, then the working days of the resource are used.

If more than one resource is assigned to a task, then the working days of the staffing
workgroup of the initiative are used. The planned start date will be the earliest planned start
date of the resources that are assigned to the task, and the planned finish date will be the latest
planned finish date.

Note: If you make changes in a task assignment view, the duration is not recalculated for
summary tasks. It will be calculated when the project is saved and a rollup occurs.
However the rollup values are updated on summary tasks when you make changes in a
task view.

Assigning resources to a task in PPW

1. Access PPW.

2. In the Resources column of the task, select one or more resources or personal groups to
be assigned to the task.
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If you assigned personal groups or multiple resources, the planned effort is distributed
evenly to each resource that has loading method 4.

If all of the existing assignments have a manual loading method, new resources are
assigned 0 planned effort and the existing assignments are not changed.

3. To change the distribution amounts, click .

a. The Assign Resources dialog box appears.

b. In the Effort column for the resource, change the effort amount as required.

c. Click Save.

Assigning resources to multiple tasks in PPW

Different options are available depending on whether resources have been assigned to one or
more of the selected tasks.

1. Access PPW.

2. Select the tasks that you want to assign resources to.

3. Click .

The Assign Resources dialog box appears.

To assign resourceswhen no resources are assigned to the tasks

1. Do one of the following:

• To allocate effort based on a percentage of the total effort for the task, select the
Percentage option.

• To allocate effort based on the planned effort amounts that you specify, select the
Effort option.

2. To assign a resource:

a. In the Resource type-ahead field, select a resource.

b. In the Effort (or Percentage) column, enter the planned effort (or percentage).

3. To distribute the planned effort evenly for multiple resources:

a. Select the Percentage option.
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b. Select the resources.

c. Right-click and then select Distribute evenly.

4. Click Save.

To assign resourceswhen resources are already assigned to the tasks

1. To distribute the planned effort evenly to all new resources being assigned and the
resources that were previously assigned to the tasks:

a. Click Distribute evenly.

b. In the Resource type-ahead fields, select the resources.

Note: If any of the existing assignments have a manual loading method the planned effort
is not changed. The planned effort is distributed among all assignments that have loading
method 4.

2. To add the planned effort only to the new resources being assigned to the tasks:

a. Click Add effort.

b. To also add the planned effort to the existing resources that were previously assigned
to the tasks, select the Update existing assignments check box.

c. To select resources:

• In the Resource type-ahead field, select the resource.
• In the Effort column, enter the planned effort amount.

3. Click Save.

Setting up a warning when effort distribution on task assignments is
overridden

You can set up a warning so that you receive a message when you a change you make results
in a change to the existing distribution of effort on task assignments.

For example, selecting another resource from the Resources list will evenly split the planned
effort among resources. If effort is different for task assignments, a warning message appears.
The effort amounts are compared up to 2 decimal places.

1. Access PPW.

2. Click . The Project Planning Worksheet Settings dialog box appears.
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3. Select the Display warnings before planned effort is overridden check box.

About reenabling the planned effort is different message

You can reenable the message that appears in the Assign Resources dialog box when the
planned effort is different than the task planned effort by deleting the server cookies in
Preferences.

Creating a task assignment in PPW

You can create new task assignments or copy existing ones. In general, data is copied from
fields that exist in your view.

1. Access PPW and select a task assignment view.

2. To add a new task assignment, select an existing task assignment for the same task and
then click .

3. To copy a task assignment:

a. Select the task assignment that you want to copy, and then click .

b. Click .

4. Complete the fields as required. For more information, see "Available columns for PPW
task assignment views" on page 163.

5. Click Save.

Editing a task assignment in PPW

1. Access PPW and select a task assignment view.

2. To assign a different resource to a task assignment:

a. Copy-paste the task assignment.

b. Assign the resource to the new task assignment.

c. Delete the old task assignment.

3. To delete a task assignment, select the task assignment and then click
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4. Edit the fields as required. For more information, see "Available columns for PPW task
assignment views" on page 163.

5. Click Save.

About marking task assignments as completed in PPW

In a task assignment view, you mark an assignment as completed by setting the percent
complete to 100 or remaining effort to 0.

When time has been entered for a task assignment:

• The actual start date is set to the date of the earliest time record and the actual finish date
is set to the date of the latest time record.

• If the completed task assignment is later reopened, the actual finish date is cleared, and
the actual start date will remain unchanged.

If there are no actual hours for the task assignment:

• The actual finish date is automatically set to the current date, but you can change the date.

• The actual start date is set to the same date as the actual finish date and these dates both
roll up to the task and summary tasks normally.

• If the completed task assignment is later reopened, both the actual start and actual finish
dates are cleared.

Note: If you change the actual finish date in a task assignment view, the revised actual
start and actual finish dates will not appear in a task view until PPW has been saved and
reloaded.

Best practice regarding actual time

The point at which time records are considered actual time by your organization is controlled
by a setting in Changepoint Administration. The setting options are:

• when the time is entered in the time sheet

• when the time records are submitted in the time sheet

• when the time records have been approved

The actual finish date is determined based on the actual time for the tasks or task assignments
at that time that the task or task assignment is marked as completed. If time records are
considered actual time only after time is submitted or approved, and a task or task assignment
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is marked as completed before the time records have been submitted or approved, there might
be an actual finish date, but no true actual hours.

As a best practice, ensure all time records are actual time before marking tasks or task
assignments as completed.

About replacing assigned resources in PPW

In PPW you can replace a resource with one or more resources on all tasks in the project or
only selected tasks. This functionality is useful for replacing a resource who is leaving the
company or has been removed from a project, or for replacing generic resources with actual
resources when template projects are used as a starting point.

When replacing a source resource, you select one or more target resources and specify the
percentage of the effort amount that is to be reassigned to each target resource.

A new assignment is created for each target resource based on the information from the source
task assignment. Daily effort distributions are multiplied by the percentage, and the total of the
daily distributions becomes the total planned effort for the target resource.

• If the percentage is 100% or higher, the source resource is removed from the task, unless
there is actual effort for the source resource, in which case the source resource remains
assigned to the task with effort set to 0.

• If the percentage is 100% and there are multiple target resources, a slightly higher amount
might be assigned to one of the target resources due to rounding.

• If a target resource is already assigned to the source task, the effort will be added to the
existing effort for the target task.

Note: For performance reasons, some processing is not done immediately in PPW, such as
replacing effort in past periods with actual effort. As a result, there may be changes in
effort amounts after you save changes or switch to another view.

Replacing an assigned resource in PPW

1. In a task view or task assignment view, do one of the following:

• To replace a resource on all tasks in the project, click .

• To replace a resource on one or more selected tasks, select the tasks and then click the
.
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2. In the Assign/Replace Resources dialog box, click the Replace resource option.

3. In the From field, select the source resource (resource that you want to replace).

4. Add one or more target resources in the Resource table.

5. Specify a percentage for each target resource.

6. Click Save.

About allocating planned hours in PPW and the project worksheet
The methods that you can use to allocate planned hours depend on whether or not fiscal
periods have been selected for the project, and the loading methods that are specified for
tasks.

If you select fiscal periods for the project:

• you can allocate planned hours to fiscal periods and edit planned start, planned finish and
planned hours, provided that they are in current or future fiscal periods. You require the
appropriate security feature to edit information in past fiscal periods.

• the default loading method for tasks is 1 - Auto distribute - update past and future.

Note: If you do not want planned hours in past fiscal periods to be updated with actual
hours, then you must change the loading method for each task to loading method 3 or 4. For
more information, see "About selecting loading methods" on page 181

If you do not select fiscal periods for the project, then only the following loading methods are
available:

• 3 - Manually distribute – no update

• 4 - Auto-distribute – no update to past (default)

Differences between PPW and project worksheet

Using PPW, you can do the following, which is not possible in project worksheet.

Manually allocate planned hours to nonworking days

In PPW only, you can allocate planned hours to nonworking days if the loading method is a
manually distribute method.
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Note: Planned hours allocated to nonworking days are moved to working days if you
change the planned start, planned finish or planned hours for the task assignment in the
project worksheet or RMW.

Change a planned start date in the past when using a loading method that
replaces planned hours in past periods

You can change a planned start date that is the past when the loading method is one that
replaces planned hours in past periods with actual hours, provided that you have access rights
to edit data in past fiscal periods.

Note: If you change a planned start date this way, keep in mind that existing actual hours
can cause the date to revert back to the original date upon saving. Also, if there are no
actual hours at the time that you change the date, actual hours on a future date can change
the date automatically.

About selecting loading methods

The default loading method for tasks is:

• if fiscal periods are selected for the project – 1 - Auto-distribute – update past and future

• if fiscal periods are not selected for the project – 4 - Auto-distribute – no update to past

The loading method applies to each task assignment for the task. In PPW, you can change the
loading method for task assignments. In project worksheet, you can change the loading method
for tasks as well as individual task assignments.

To allocate planned hours, you can select the loading method to specify how planned hours are
distributed across fiscal periods, and how (or whether) actual hours are applied to past fiscal
periods when the project is rolled up.

When you select a manually distribute loading method, you can manually allocate the planned
hours in the current and future fiscal periods. However, you cannot edit the total planned hours
for the task assignment.

When you select one of the auto-distribute loading methods, you can update planned start,
planned finish and planned hours for the task assignment, but the system automatically
allocates the hours to the fiscal periods.

Note:When open tasks are rolled up, the planned hours for the task are evenly distributed
to each fiscal period between the planned start and planned finish dates, and planned hours
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are not rolled up from task assignments. Therefore the total planned hours for open tasks
might not balance with the total task assignment hours.

The loading method affects how planned and actual information is rolled up for each task
assignment.

0 - Manually distribute – update past only

• Planned hours in past periods are replaced by actual hours

• Planned start and planned finish in past periods are replaced if time records are earlier
than the planned start or later than the planned finish. For more information, see "About
replacing planned start and finish dates with actuals" on page 183.

• Current and future planned hours are not changed

• Total planned hours are set to: past period hours + current and future planned hours

• Resources can manually update current and future periods

1 - Auto-distribute – update past and future

• Planned hours in past periods are replaced by actual hours

• Planned start and planned finish in past periods are replaced if time records are earlier
than the planned start or later than the planned finish. For more information, see "About
replacing planned start and finish dates with actuals" on page 183.

• Total planned hours minus planned hours from past periods, are distributed evenly to
current and future periods

2 - Auto-distribute – update past only

• Planned hours in past periods are replaced by actual hours

• Planned start and planned finish in past periods are replaced if time records are earlier
than the planned start or later than the planned finish. For more information, see "About
replacing planned start and finish dates with actuals" on page 183.

• Current and future periods are not changed (unless the resource changes the planned start,
planned finish or planned hours)

• Total planned hours are set to: past period planned hours + current and future planned
hours
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3 - Manually distribute – no update

• Planned hours in past periods are not replaced by actual hours

• Resources can manually update current and future periods

• Resources with the required access rights can manually update past periods

4 - Auto-distribute – no update to past

• Planned hours in past periods are not replaced by actual hours, but can change when
planned start, planned finish or total planned hours are changed

• Total planned hours are evenly distributed across the working days between the planned
start and finish dates, and the planned hours for fiscal periods (including past fiscal
periods) are updated accordingly

About replacing planned start and finish dates with actuals

If the loading method for a task assignment is one that includes “update past”, then if a time
record is entered before the planned start date in a past period, the planned start date is
changed to the date of the time record. Similarly, the planned finish date in a past period is
changed to the date of a time record that is later than the planned finish date.

When the planned start date for a task assignment is changed in this way, then all effort that is
allocated to daily periods for the task assignment is deleted.

However, the planned start and finish dates for task-level or project-level resource requests
that have resource restrictions enabled will not be replaced with dates of time records if the
new dates are outside of the dates for the original resource request item.

Loading method examples

The following table shows the results after a project rollup, of the different loading methods on
a task assignment with the following conditions:

• Planned start: September 1

• Planned finish: October 31

• Planned hours: 50

• Fiscal periods selected for the project, and the fiscal periods are months (September,
October)

• 20 actual hours were entered during the September fiscal period
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• The current fiscal period is October

Note: All of the tables in the loading method examples show the results after the project
has been rolled up. However on the project worksheet, you may see method 2 providing
the same results as method 1 if you update the planned hours and loading method for a task
that has planned hours in a past period.

Loading Method
Total
Planned
Hours

Fiscal
Period
September

Fiscal
Period
October

Original task assignment 50 25 25

0 - Manually distribute – update past only 45 20 25

1 - Auto-distribute – update past and future 50 20 30

2 - Auto-distribute – update past only 45 20 25

3 - Manually distribute – no update 50 25 25

4 - Auto-distribute – no update to past 50 25 25

The following table shows the results of the loading methods on the same original task
assignment, but with 60 actual hours entered during the September fiscal period.

Loading Method
Total
Planned
Hours

Fiscal
Period
September

Fiscal
Period
October

Original task assignment 50 25 25

0 - Manually distribute – update past only 85 60 25

1 - Auto-distribute – update past and future 60 60 0

2 - Auto-distribute – update past only 85 60 25

3 - Manually distribute – no update 50 25 25

4 - Auto-distribute – no update to past 50 25 25
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The following table shows the results of the loading methods on the same original task
assignment, but with 40 actual hours entered in the September fiscal period and the planned
hours changed to 60. You can only change planned hours on task assignments that have auto-
distribute methods, therefore this example applies to the auto-distribute methods only.

Loading Method
Total
Planned
Hours

Fiscal
Period
September

Fiscal
Period
October

Original task assignment 50 25 25

1 - Auto-distribute – update past and future 60 40 20

2 - Auto-distribute – update past only 70 40 30

4 - Auto-distribute – no update to past 60 30 30

About allocating planned hours to daily or fiscal periods in PPW

You can allocate planned hours to fiscal or daily periods to individual resources in a task
assignment view:

• for fiscal periods, one year of fiscal periods starting from the fiscal period that contains the
current date is displayed

• for daily periods, 31 days from the current date are displayed initially

You can scroll backward and forward within the fiscal periods, or set a different start date for
them.

To display daily or fiscal periods in PPW you must add the Effort distribution column to the
view.

Using different fiscal periods in PPW

By default, the fiscal periods come from the cost structure for the project. You can use
different fiscal periods (if available) in PPW without changing the project cost structure. For
example, you might want to use daily or weekly periods for the current time period, and then
switch to monthly periods for future time periods.

When you switch from fiscal periods to daily periods, the daily periods start at the first date of
the first fiscal period that was in the view prior to switching. When you switch from daily
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periods to fiscal periods, the fiscal periods start at the one that contains the first date of the
daily periods that were in the view prior to switching.

Whichever periods that you use last are saved in PPW until you switch them again.

Note: Regardless of which periods you use in the view, the project data is always rolled
up and stored in the fiscal periods that come from the cost structure for the project.

About activating tasks in PPW
You must activate tasks in PPW before they are available to resources in the time sheet and
Projects tree-view.

To activate a task, you must first mark it for activation. When you mark a task for activation,
all of the tasks in the same task hierarchy and all of the tasks linked to the tasks in the
hierarchy are marked as well. For this reason, tasks can be activated only from a task view
that has no sorting or filter applied.

Once you have marked tasks for activation, you cannot make any edits to the tasks that affect
the WBS or task dependencies.

When you click Save:

• all active tasks that you modified and all draft tasks that you marked for activation will be
validated in a background process

• draft tasks that pass validation are activated

• active tasks that pass validation are saved

• warnings are cleared

• PPW is closed and errors appear the next time you access PPW

When you click Apply, everything is the same as Save except PPW is not closed and therefore
error and warning messages are immediately available.

Tasks that pass validation are activated and can be viewed and edited in all the usual ways.
Tasks that fail validation are flagged and the error messages are available in the information
column. You can either correct the errors and activate the tasks, or delete them.

Note: Tasks that fail validation appear in the project worksheet, but you must correct all
errors before saving the project worksheet.
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Activating a task in PPW

To activate a task, you first mark it for activation and then submit it for activation. You can
remove a task from being marked for activation, but you cannot revert an activated task to draft
status.

1. To mark tasks for activation, select one or more draft tasks, and then click .

The cell in the Draft column turns green.

2. To remove a task from being activated, select the task and then click .

3. To activate the marked tasks, click Save or Apply.

Validating changes in PPW

Because only basic validation is performed when you create and edit tasks and task
assignments in PPW, it is possible that you unknowingly introduce errors as you work. You can
validate your work to check it for errors so that you can view and correct the errors before
activating or saving.

1. Select the draft tasks that you want to validate, and then click .

Note: Active tasks that have been edited are automatically included.

2. Click .

About editing tasks in PPW

Changing the loading method

If you change the loading method for a task assignment from one that does not replace planned
hours in past fiscal periods with actual hours to one that does, the planned hours in past fiscal
periods will initially be replaced with an even distribution of the total actual hours. To see the
true distribution of actual hours in the past, you must save the project in PPW. Saving the
project saves the daily distribution of the task assignment and initiates a project rollup.

Editing the planned start date

When you change the planned start date of a task, the start dates of its task assignments are
moved to maintain the same relationship to the task start date. That is, if the original start date
of the task assignment was 5 days after the original task start date, then the new start date of
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the task assignment will be 5 days after the new task start date. The duration remains the
same, and the finish date is changed based on the duration.

If the new start date for a task assignment is on a nonworking day, the effort is moved to the
next available working day and the new finish date is determined based on the duration, which
can move the task finish date. Planned start and planned finish dates can be on nonworking
days, but effort can only be allocated to nonworking days manually.

When you change the planned finish date of a task, the dates of its task assignments are moved
relative to the new finish date. The planned start date remains the same and the duration is
recalculated.

If dependencies on other tasks prevent the finish date from being moved, or the new finish date
is earlier than the planned start date of the task assignment, the task assignment dates are set
to same date as the task start date.

Editing a task in PPW

1. Access PPW.

2. If necessary, lock the project for task editing by clicking .

3. Make the necessary changes.

4. Click Save.

About marking tasks and task assignments as completed in PPW

In a task view, you mark a task as completed by selecting the Completed check box.

If there are actual hours for the task, the following occurs:

• the actual start date is set to the date of the earliest time record and the actual finish date
is set to the date of the latest time record.

• The actual start date, finish date, and completed status are applied to all subtasks and task
assignments that are not completed and have no actual hours.

• If a task assignment has actual hours, the actual start date is set to the date of the earliest
time record and the actual finish date is set to the date of the latest time record.

• If the completed task is later reopened, the actual finish date is cleared.

If there are no actual hours for the task,
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• the actual start date is set to the same date as the actual finish date and the actual finish
date is automatically set to the current date. You can change the actual finish date.

• If a completed task is later reopened, both the actual start and actual finish dates are
cleared and will be updated during the save and project rollup.

About the Gantt chart in PPW
You can move tasks, change task durations, and create or delete task dependencies within the
same project in the Gantt chart.

The items in PPW are represented in the chart as follows:

• tasks – blue bars

• summary tasks – dark gray bars

• milestone tasks – black diamonds

To show/hide theGantt chart

Click .

To show/hide the worksheet

Click the darker bar in the divider bar between the worksheet and the Gantt chart.

To scroll outside of the time frame that is currently displayed

There is a second set of arrows in the horizontal scroll bar of the Gantt chart that you can use
to scroll outside of the time frame that is currently displayed.

To scroll to dates prior to the earliest date displayed, click the arrow on the far left.
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To scroll to dates after the latest date displayed, click the arrow on the far right.

To scroll vertically on theGantt chart

To scroll up or down in the Gantt chart, you use the scroll bar that is between the worksheet
area and the Gantt chart.

Changing the timescale in the Gantt chart in PPW

You can zoom in to show less information in greater detail, or zoom out to show more
information in less detail.

To change the timescale in the Gantt chart

To zoom in, click  . The lowest zoom level shows the timescale in days per week.

To zoom out, click  . The highest zoom level shows the timescale is semiannual.

To display the entire Gantt chart in the available space, click . The Gantt chart is scaled to

fit in the width of the pane.

To start the time frame displayed in the Gantt chart at the planned start date of a task, click
the task row and then click  .

Managing tasks in the Gantt chart in PPW

You can change the planned start date of a task by moving it forward or back in the timescale.
The duration for the task remains the same. If you move a predecessor task, its successor
tasks are moved automatically to maintain the constraints of the dependency type.

You can change the planned finish date of tasks as well as shorten or lengthen their duration
by moving the right (planned finish) end of the task bar.

Note: You cannot move a successor task, nor change its dates that are dependent on its
predecessor task.

To change the planned start date for a task

Point to the task, and when the four-sided arrow appears, move the task forward or back to the
desired date.

To change the planned finish date for a task
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Point to the right (planned finish) end of the task bar, and when the double-sided arrow
appears, drag the end to the desired date.

Linking tasks in the Gantt chart in PPW

Tasks that you link in the Gantt chart initially have a finish-to-start dependency by default, but
you can change the dependency type, and add a lag or lead time.

1. Click the predecessor task, and then drag it down towards the successor task.

A tooltip indicates the potential successor tasks as you point to them.

2. Release the predecessor task on the successor task.

A finish-to-start dependency is created by default, and the successor task is moved to start
on the first working day after the finish date of the predecessor task. A line links the
predecessor task to the successor task.

3. To change the dependency type, right-click the link and then select the dependency type.

4. To add a lag, in the Predecessors column, add +n, where n is the number of lag days (or -
n to specify lead time).

To unlink tasks

Right-click the dependency link, and then select Delete.
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Viewing the Task Status Compliance report

Project managers can access the Task Status Compliance report to view and update the
status of tasks in their projects.

1. Click General > Reports.

The Reports tree view appears.

2. Expand the Project Management folder.

3. Select the Task Status Compliance report.

The filter criteria window appears.

4. To include subprojects in the report, select the Include subprojects check box.

5. To include completed tasks, select the Include completed tasks check box.

6. In the Project list, select one or more projects.

7. Click Go.

The Task Status Compliance report appears.

8. To update the status of a task:

a. Click or the task name in the task row. The Update Task Status dialog box

appears.

b. Update the status. For more information, see "Update Task Status dialog box
options" in the Time and Expense Management User Guide.
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9. Creating quick plans and quick projects
Creating a project using the Create Quick Plan report

You can use the Create Quick Plan report to enter initiative, project, task, and resource
assignment information in one place. The report guides you through the required fields for
creating an initiative, project, task, and resource assignment.

1. Click General > Reports.

2. Expand the Project Management folder.

3. Click Create Quick Plan.

The Create Quick Plan opens in a new window.

4. Complete the initiative fields as required. For more information, see "Create Quick Plan
report, initiative options" on page 195.

5. Click Save.

6. To add other initiative information, click Initiative Details.

The Edit Initiative dialog box appears.

7. Complete the fields as required.

8. Complete the project fields as required. For more information, see "Create Quick Plan,
project options" on page 199.

Create Quick Plan report, initiative options

For detailed information about initiatives, see the Initiative Management User Guide.

General section

Field Description

Client type-ahead field Client of the initiative.

Client ID type-ahead field ID of the client.

Initiative name field Name of the initiative.
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Field Description

Alternate Name field Alternate name for the initiative.

Description field Description of the initiative.

Cost structure list Cost structure for the initiative.

Initiative status list Status of the initiative.

Manager type-ahead field Resource responsible for the initiative.

Staffing workgroup type-ahead
field

Workgroup for the initiative.The staffing workgroup is

used in resource demand calculations. Default is the

initiativemanager’s workgroup.

Main contact list Main client contact.

Candidate list Candidate that resulted in the initiative.

Additional contact list Additional contact.

Enable two-level approval check
box

When selected, a second level of approval after the

initiativemanager is required for all cross charges for

the initiative.

Enable two-level approval if
approved amount is exceeded
check box

When selected, a second level of approval after the

initiativemanager is required for cross charges with

net amounts that exceed the approved amount

specified on the initiative.

Second-level approver type-ahead
field

Resource who approves the cross charges after the

initiativemanager approves the cross charges.

Enable two-level approval for
write-offs/ups check box

When selected, a second level of approval after the

initiativemanager is required for cross charges that

contain write-offs.

T/E Approver field Resource who approves time and expenses.
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Field Description

Secondary T/E Approver field Resource who approves the time and expenses for

the resource specified in the T/E Approver field.

Operations center list Operations center that handles issues for the

initiative.

Reference section

Field Description

Reference number field Reference number for the initiative

Start date field Date that the initiative begins.

Approved amount field Total amount of the approved contract, excluding

taxes.

End date field Date that the initiative ends.

Cross Charge information section

Field Description

Currency list Cross charge currency for the initiative.

Chargeable check box When selected, the initiative is chargeable.

Cross charge type list Cross charge type.

Expense cross charge field Portion of the expenses for the initiative that will be

cross charged to the client. The options include:

• All expenses
• No expenses
• Percentage of expenses
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Field Description

% field Percentage of expenses to be cross charged.

Available only if Percentage of expenses is selected
in theExpense Charge.

Cross charge format list Cross charge format.

Remit-to address list Address to which the client sends remittances.

Default is the remit-to address specified for the cost

structure.

To display the full address, point to theRemit-to
Address field.

Expense GL account list Resource whose cost center is responsible for the

expenses associated with the initiative.

Cross charge-to location group
list

Location group where the work will be cross charged

(for taxation purposes)

Cross charge-to location list Location where the work will be cross charged (for

taxation purposes)

Details section

Field Description

Work code category list Work code category for taxation purposes.

Work code list Work code for taxation purposes.

Defining the project for a quick plan

The project section of a quick plan includes the mandatory project fields only. However, after
you save the project, you can edit it as required.

1. Click the Project tab.

2. Complete the fields as required. For more information, see "Create Quick Plan, project
options" on page 199.

3. To link the project with an application:
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a. Expand the tree view and select the primary application associated with the project.
The primary application is used for reporting purposes.

b. To change the primary application, select the name of the application instead of the
check box.

c. Select additional applications, as required.

4. Click Save.

Create Quick Plan, project options

Field Description

Project name field Name of the project.

Planned start date field Estimated start date of the project.

Client field Client for the project.

Planned finish field Estimated end date for the project.

Initiative name field Initiative for the project.

Planned hours field Estimated planned effort for the project.

First status field Date that resources must perform the first status

updates for their assigned tasks.

Status field Status of the project.

CP project type list Custom project type that represents how the

project is categorized within Changepoint.

Project plan editors field Project plan editor for the project.

Chargeable check box When selected, the project is chargeable.

Labor budget field Proposed labor budget for the project.

Expense budget field Proposed reimbursable expense budget for the

project
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Field Description

Other expense field Proposed budget for other expenses for the project.

Project value field and currency list Value and currency of the project.

Fiscal period type-ahead field Cost structure whose fiscal periods apply to the

project worksheet.

Comments field Comments regarding the project.

Work location group list Work location group for the project.

Work location list Work location for the project.

Work code category list Work code group for the project.

Work code list Work code for the project.

Applications list Applications associated with the project.

Adding and assigning tasks for a quick plan

You must enter and save all required information in the Project section before you can add the
task information.

1. Click the Task tab.

2. Complete the fields as required. For more information, see "Create Quick Plan, task
options" on page 201.

3. To link the task with an application:

a. Expand the tree view and select the primary application associated with the project.
The primary application is used for reporting purposes.

b. To change the primary application, select the name of the application instead of the
check box.

c. Select additional applications, as required.

4. Click Save.
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Create Quick Plan, task options

Field Description

Task name field Name of the task.

Planned start field Estimated start date for the task.

Project field Project name.

Planned finish field Estimated finish date for the task.

Planned hours field Estimated effort for the task. The valuemust equal

the total planned hours of the task assignments.

Staffing level list Staffing level for the task.

Function list Function for the task.

Chargeable task check box When selected, the task is chargeable.

Comments field Comments about the task.

Allow work location override check
box

When selected, resources can override the work

location when entering time for the task.

Allow work code override check
box

When selected, resources can override the work

code when entering time for the task.

Work location group field Work location group for the task.

Work location field Work location for the task.

Work code category field Work code category for the task.

Work code field Work code for the task.

Resource type-ahead field Resource who is assigned to the task.

Planned hours field Estimated hours that the resource requires to

complete the task.
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Field Description

Staffing level field Staffing level for the task assignment.

Application field Applications associated with the task assignment.

Creating a project based on the projected resources of an
initiative

You can create a project based on the projected resources of an initiative. A task is created
for each projected resource that you select. The project status is Draft and task status updates
are required once a week. The planned start date for the project is the earliest start date from
the tasks, and the planned finish date is the latest finish date from the tasks.

1. Access the initiative.

2. Click the Projected resources tab.

3. Select the projected resources for which tasks will be created in the project.

4. Right-click and select Create Quick Project.

The Project name field, which includes the initiative name, appears, and the following
columns are added to the table:

• Quick project – flag that indicates the projected resources to be created as project
tasks

• Task – includes the name of the staffing level of the projected resources as the task
names

5. Edit the project name and task names, if required.

6. Click Save.

The project is created. The project resources that have been created as tasks for the
project display a  in the first column of the Projected resources tab.
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About Microsoft Project integration

The integration of Changepoint Changepoint with Microsoft Project combines the benefits of
high-level planning options and detailed task lists from Microsoft Project with the capture of
time and status information in Changepoint Changepoint.

After a Changepoint project is linked to Microsoft Project (called a linked MSP project), the
project manager creates the tasks and resource assignments in the MSP project, and
resources update their task status in Changepoint Changepoint. The actual data from the task
status updates is transferred to the linked MSP project when the project manager updates the
linked MSP project.

Although Changepoint does not integrate with Microsoft Project calendar functionality, the
project manager can transfer nonworking days from Changepoint to the Microsoft Project
calendar and set the resource maximum units based on the resources’ available hours per
day. Also, if the option to update the calendar is enabled for a task in Changepoint, the
personal calendar will be updated for resources who are assigned to the task in the linked
MSP project.

Note: Depending on the Microsoft Project version used in your organization, procedures
may differ. For more information, see the Microsoft Project help.

About data transfer between linked MSP projects and Changepoint

The first time that you link a Changepoint project to Microsoft Project, the system creates a
new MSP project with the same name as the Changepoint project. The MSP project is stored
in a temporary Microsoft Project file (.mpp) on your computer while you are working with it.
When you save and exit from Microsoft Project, the linked MSP project is saved in
Changepoint.

The following information in the Changepoint project is transferred to the new MSP project:

• Project name

• Resources

• Resource cost information, if the project manager has access rights

• Planned, actual, remaining and baseline start and end dates

• Planned hours
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• Tasks and task dependencies within the project

All tasks automatically have the fixed duration task type, regardless of the Microsoft Project
default setting. The task duration, work start and finish match the values from Changepoint.
After the project is linked, you can change the task type to fixed work or fixed units in
Microsoft Project and the values will be recalculated.

When you edit and save a linked MSP project, the following information is transferred back to
the Changepoint project:

• Task names

• Project planned start date

• Planned start and finish dates of tasks

• Phase information for tasks

• Resource assignments

• Work breakdown structure

After the transfer, the information is automatically distributed to project resources. If resource
leveling is enabled for your organization, the system validates the task assignments and a
validation report is displayed if there are any conflicts.

Data transferred from Changepoint when updating a linked MSP project

Each time you access a linked MSP project, you can select whether you want to update the
following information from Changepoint:

• Actual hours spent on tasks

• Actual time by assignment, by date

• Actual start dates for assignments

• Task status (forecast to complete in hours)

• Estimated completion date of tasks (if not finished)

• Forecast start date of task assignments

Changepoint allows the status update requirement for projects to be overridden for specific
tasks and task assignments, but this capability is not supported in Microsoft Project. If you
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create a task or task assignment in Microsoft Project and then transfer the task to Changepoint,
Changepoint applies the project status requirement to the task or task assignment.

Data transferred between Changepoint and MSP

You can enter the following task-related information in either Changepoint or Microsoft
Project:

• Specification of whether a task is chargeable

• Text fields 1, 2, 3

• Code fields 1, 2, 3 (single values only)

• Utilization eligible

• Update resource calendar

• Associate with fixed fee

• Fixed-fee item

Steps required before linking a project
The following list describes the steps required before a Changepoint project can be linked with
Microsoft Project.

1. Creating a project in Changepoint, with or without tasks and task assignments. For more
information, see "About creating projects" on page 16.

2. Creating a list of resources for the project in Changepoint. For more information, see
"About creating a list of resources for a linked MSP project" on page 205.

3. Setting up exchange rates in Changepoint Administration.

If different currencies are used in Changepoint and Microsoft Project, ensure that the
appropriate exchange rate values have been set up and activated in Changepoint
Administration. Otherwise, an exchange rate value of 1 will be used during data transfers.

4. Installing the Changepoint MSP COM Add-in. For more information, see "Installing the
Changepoint MSP COM Add-in" on page 206.

About creating a list of resources for a linked MSP project

Before you link your Changepoint project to Microsoft Project, you must ensure that all of the
resources that you intend to assign to project tasks are specified in Changepoint. The type of
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resource list depends on how resource requests are used by your organization:

• If resource requests are not used, the resources from your Preferred resources list are
used.

• If resource requests are submitted from the initiative or task editing view, then the
projected resources from the initiative are used. If task restrictions have been set up for
the initiative to restrict assignments to projected resources, then these task restrictions are
also applied in Microsoft Project.

• If resource requests are submitted from the project, then the resources from the project
team are used.

Installing the Changepoint MSP COM Add-in

1. In Changepoint, click Preferences.

The Preferences view appears.

2. Expand the Add-in installations section, and click the Install Changepoint MSP COM
Add-in link.

A file download dialog box for Changepoint MSP COM Add-in installer appears.

3. Click Run to launch the installer.

Depending on your browser, you may have to save the installer first and then run it.

4. If a security warning displays, acknowledge the warning and continue with the installation.

5. Follow the installer prompts:

• When you are prompted to select a language, select your Windows operating system
language.

• When you are prompted for the URL of the Changepoint website, copy and paste the
URL from the MSP subsection of the Add-in installations section of the Preferences
view.

6. When the installation complete message displays, click Finish.

The following Changepoint-related items are added to the Microsoft Project interface:

• Changepoint command on the Add-Ins tab.

• CP Gantt view, accessible from the Gantt Chart command on the View tab.
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• Changepoint fields for selection, accessible from the Insert Columns command on the
Gantt Chart Tools Format tab.

Default schedule settings for Microsoft Project

It is recommended that you set the following schedule settings as default settings in Microsoft
Project, before linking to Changepoint. The options are in the Schedule tab of the Options
dialog box in Microsoft Project. For more information, refer to the Microsoft Project help.

MSP Schedule option Recommended setting

Show assignment units as a Percentage

Auto-scheduled tasks scheduled on Project Start Date

Duration is entered in Days

Work is entered in Hours

Default task type Fixed Duration

(All tasks in Changepoint are defined as fixed

duration.)

Show that scheduled tasks have estimated

durations

Clear the check box

Configuring the Changepoint website settings
If you access different Changepoint websites, for example, an internal website at the office
and an Internet website from home, then you must switch the Changepoint website settings in
Microsoft Project.

Tip:When you open a linked MSP project, the Changepoint URL displays in the bottom
left corner of the Microsoft Project window.

1. In Microsoft Project, click the Add-ins tab.

1. ClickChangepoint > Changepoint Setup.

The Changepoint Setup dialog box appears.

2. Enter the URL or website address for Changepoint.

3. Click OK.
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Your Changepoint website settings are validated and saved. These settings are used the
next time you link to Changepoint.

Accessing a linked MSP project
After a project is linked, you can view and edit it using Microsoft Project.

1. In Microsoft Project, click the Add-ins tab.

2. Click Changepoint > Link Changepoint Project.

3. If the Changepoint sign in dialog box displays, enter your Changepoint user ID and
password and click OK.

The Changepoint Project List dialog box appears.

4. Expand the Linked Projects folder and select a project.

5. Click OK.

The Link Changepoint Project dialog box appears.

6. Do one of the following:

• To access the linked project without transferring data from Changepoint, select the Do
not update the data in Microsoft Project option and then click OK.

• To update the linked project before accessing it, select the relevant update option and
then click OK. For more information, see "Link Changepoint Project dialog box
options" on page 209.

The linked project opens in Microsoft Project.

About linking Changepoint projects to Microsoft Project
If you do not select additional update options when first linking a project, the start date, finish
date and hours for tasks and task assignments in Microsoft Project will be preserved. If you
select additional update options (such as, Update the actual start date or Update actual
hours), it could cause Microsoft Project to recalculate the start date, finish date and effort,
which means that these values will be different than what was originally in Changepoint.
Changepoint will not interfere with the Microsoft Project calculations.

Note: Open tasks are not supported in linked MSP projects because entering time for open
tasks creates an assignment in Changepoint, which is not allowed in linked MSP projects.
Therefore, you cannot link a Changepoint project that includes open tasks.
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If you link an MSP project that already contains actual work, costs, start dates or finish dates,
this information is not transferred into Changepoint. Instead, the actual values are overwritten
with values from Changepoint when you link and update the project. However, you can choose
not to link certain tasks from the MSP project and the actual values for these tasks will not be
overwritten.

After an MSP project is linked to a Changepoint project:

• You must enter all planning and resource assignment changes in the linked MSP project.

• The project manager, project plan editor, or summary task manager for the task can do
limited editing on tasks in Changepoint, but cannot add tasks or modify the project
worksheet. However, you can make changes to the project that are not related to tasks. For
example, you can still change access rights in Changepoint.

• You cannot create open tasks for linked MSP projects.

• You cannot save baselines for linked MSP projects.

Link Changepoint Project dialog box options

In the Link Changepoint Project dialog box, you specify the options for transferring data
from Changepoint to the MSP project.

Option Description

Do not update the data
in Microsoft Project

When selected, data is not transferred from Changepoint to the

MSP project. Not available the first time the project is linked.

Update the modified
tasks in Microsoft
Project

When selected, transfers data only from tasks for which

resources have entered time or status updates. Not available

the first time the project is linked.

Update all tasks in
Microsoft Project

When selected, transfers all of the data. Use this option to

transfer all of the data from Changepoint if the linked project

gets out of sync, for example, if an update is interrupted or

there is a system crash. Not available the first time the project

is linked.

Update the rates for
Microsoft Project

When selected, transfers the cost rates for resources.
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Option Description

Update project and
resource-level
nonworking days and
calculate resource
maximum units

When selected, transfers the nonworking days from the project

and resource-level to MSP. Also, calculates themaximum

units for resources based on the percent available for planned

work from the Changepoint workgroup and the default hours per

day fromMSP.

Update the actual start
date

When selected, transfers the actual start dates of task

assignments.

Update actual hours When selected, transfers actual hours that resources entered

against tasks.

Update remaining hours When selected, transfers the remaining hours for tasks.

Project worksheet When selected, transfers allocated planned hours from the

project worksheet to theMSP project the first time that the
project is linked only. After the project is linked, time allocation
data is transferred only fromMicrosoft Project to Changepoint.

This option is set automatically and cannot be changed if a cost

structure has been associated with the Changepoint project.

Only update tasks with a
planned start date within
the following date range

When selected, transfers the actual hours and dates for the

tasks that have a planned start date that is within the date

range that you specify. Not available the first time a project is

linked.
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Option Description

Update the summary
time in Microsoft Project

When selected, transfers time at the task assignment level,

and only theActual Work column is updated inMicrosoft
Project.

For example, if time records for a task include 6 hours on

Monday and 8 hours on Tuesday, theActual Work column in
Microsoft Project displays a total of 14 hours. However,

Microsoft Project distributes the actual time based on the

planned hours for each day. If 8 hours were planned for Monday

and 8 hours for Tuesday, the actual time would be distributed

as 8 hours onMonday and 6 hours on Tuesday inMicrosoft

Project.

Available only whenUpdate actual hours is enabled and a
cost structure has been associated with the Changepoint

project.

Update the detailed time
in Microsoft Project

When selected, transfers actual data at a detailed level,

including a breakdown of task time by day. For example, if time

records for a task include 6 hours onMonday and 8 hours on

Tuesday, the actual time would be distributed in Microsoft

Project as 6 hours onMonday and 8 hours on Tuesday.

Available only whenUpdate actual hours is enabled and a
cost structure has been associated with the Changepoint

project.

Linking a Changepoint project to Microsoft Project

1. In Microsoft Project, click the Add-Ins tab.

2. Click Changepoint > Link Changepoint Project.

3. If the Changepoint sign-in dialog box displays, enter your Changepoint user ID and
password and then click OK.

The Changepoint Project List dialog box appears. The Available projects folder lists
projects for which you are a project manager. The Linked projects folder lists your
projects that are already linked with Microsoft Project.

4. Expand the Available projects folder, select the project, and then click OK.

The Link Changepoint Project dialog box appears.
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5. Do one of the following:

• To create the link to Microsoft Project without transferring actual data, or if no data
exists yet, do not select any options. You can always update the actual data at a later
time.

• To transfer data from the Changepoint project, select the relevant options. For more
information, see "Link Changepoint Project dialog box options" on page 209.

6. Click OK.

The new MSP project is created and linked to the Changepoint project.

About editing a linked MSP project
After a Changepoint project is linked to an MSP project, you must edit and create all tasks and
task assignments in the MSP project. You can also enter additional project information and
monitor project progress.

Note the following differences in behavior for working with linked MSP projects:

• When projects and tasks are linked through interproject dependencies, you cannot move
the start date of the successor task to an earlier date than the latest finish date for the
parent task plus lag time for all parent tasks.

• When adding a new task, you must enter values for fields that are mandatory in
Changepoint.

• If you change the staffing level for a task assignment, it is saved in Changepoint with the
current date as the effective date. If you want to specify a different effective date, you
must perform the change in Changepoint, which requires breaking the link to Microsoft
Project.

• When using the Insert project option to import an existing MSP project, you must clear
the Link to project check box. Otherwise, data will not be updated from Microsoft
Project to Changepoint . Also, keep in mind that actual times and dates in this plan will be
overwritten with actual data from Changepoint when the link is updated.

• When you create a task assignment in a linked MSP project, the effort amounts are
converted to hours, days, or FTEs based on the system-level Daily capacity setting and not
the Daily conversion factor that is normally used when task assignments are created in
Changepoint.
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Editing a linked MSP project

1. Access the linked project in Microsoft Project.

2. Make the necessary changes.

3. To update a task in the Changepoint project, select Yes in the Update CP column.

4. Click the Save icon.

5. Exit from Microsoft Project.

6. If a message appears, asking if you want to save the project, click Yes.

7. In Changepoint, roll up the project to update the planned hours, planned start and planned
finish dates. For more information, see "Rolling up a project" on page 49.

Deleting a task or task assignment from a linked MSP project

You cannot delete a task or task assignment that has actual time or expenses entered against it.
When you delete a task from a linked MSP project, the task is removed from Changepoint, but
remains in Microsoft Project. If the task is an integral part of the Projects tree view, it
remains in Changepoint but is inactive.

1. Access the linked project in Microsoft Project.

2. To delete a task in the Changepoint project only, select Yes in the Remove CP column.

3. Click the Save icon.

4. Exit from Microsoft Project.

5. If a message appears, asking if you want to save the project, click Yes.

Updating actual time and dates in a linked MSP project
Resources enter the time that they spend working on tasks into Changepoint, but this data is not
transferred to the linked MSP project until you update it.

1. Access the linked MSP project.

The Link Changepoint Project dialog box appears.

2. Select the Update the modified tasks in Microsoft Project check box.

3. Select the type of information you want to transfer to the MSP project. For more
information, see "Link Changepoint Project dialog box options" on page 209.
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4. Click OK.

The data is transferred to the MSP project, which opens.

About identifying Changepoint resources in a linked MSP project
In linked MSP projects, there is a custom Changepoint resource flag that you can use to
identify Changepoint resources. You can either insert the flag as a column into a resource
sheet, or insert a column in your linked MSP project. For more information, see the Microsoft
Project help.

About forecast start and finish dates in linked MSP projects
Only planned start and finish dates are updated from Microsoft Project to Changepoint, but not
forecast start and finish dates. In both Changepoint and Microsoft Project, the forecast start
and finish dates are the same as the planned start and finish dates until the first time that a
resource updates the status of a task. After a resource updates the status of a task, the forecast
start and finish dates are stored in separate fields in Changepoint and transferred to Microsoft
Project into the Start10/Finish10 fields for information purposes. Changes to the planned start
and finish dates, whether done in Microsoft Project or Changepoint, no longer affect the
forecast start and finish dates.

Forecast dates in Changepoint may be different than the start and end dates in Microsoft
Project. Forecast start and finish dates in Changepoint are updated when resources update the
task status. Start and end dates in Microsoft Project are updated when the project manager
changes planning information and by Microsoft Project calculations.

Viewing task usage information in a linked MSP project
Use the Task Usage view in Microsoft Project to view the distributed time information as it
has been entered in Changepoint. Actual time is exported from Changepoint to Microsoft
Project by assignment date.

1. Access the linked MSP project.

2. Click the View tab.

3. Click Task Usage > Task Usage.

About removing the MSP link
If you want to manage a linked MSP project in Changepoint without interfacing with Microsoft
Project, you can remove the MSP link. When the MSP link is removed:
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• All dependencies between Changepoint and Microsoft Project are removed. Reconnecting
the MSP link after will not re-establish the dependencies.

• A snapshot of the MSP project is saved as an .mpp file attachment in the Related
knowledge section of the project profile. The .mpp file is for information purposes only.

Removing the MSP link

You must use Microsoft Project to remove the link.

1. In Microsoft Project, click the Add-Ins tab.

2. Click Changepoint > Remove Changepoint project link.

3. If the Changepoint sign-in dialog box displays, enter your Changepoint user ID and
password and then click OK.

The Changepoint Project List dialog box appears.

4. Expand the Linked projects folder and select the project that you want to unlink.

5. Click OK.

A confirmation dialog box appears.

6. Click Yes.

The link is removed.

Microsoft Project and Changepoint field mappings
The following tables detail how the project, task and task assignment fields in Changepoint are
mapped to the corresponding fields in Microsoft Project, and how and when the fields are
updated automatically.

Note: The Changepoint Alternate Name field is not supported in Microsoft Project.

Restrictions with configurable fields in linked MSP projects

The Changepoint configurable fields Text 1, Text 2, and Text 3 for projects are mapped to the
Text 1, Text 2, and Text 3 fields in Microsoft Project, which are text only. To ensure that
these fields in linked MSP projects are updated properly, the field type of the Changepoint
configurable fields must be text. Do not change the field type to numeric or date.
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Project field mappings

Changepoint field Direction
During creation and/or
update

MSP column

Project name To Creation Project Name

Chargeable To Creation and Update Chargeable

First status To Creation Status date

Currency To Creation and Update Currency

Project start

(calculated)

To Creation Project Start

Cross charge type To and From Creation and Update Text 2

Task field mappings

Changepoint Field
Direction of
Feed

During Creation
and/or Update

Microsoft Project
Column

Task name To, during creation only. From, during

updates

Name

Description To and From Creation and Update Task Notes

Baseline start From Creation Baseline Start

Baseline finish To during creation only. From during updates Baseline Finish

Baseline hours To during creation only. From during updates BaselineWork

Forecast start To and From Creation and Update Start 10

Forecast finish To and From Creation and Update Finish 10

WBS To Creation Outline Level

WBS From Update Outline Number

216 | Changepoint PPM2017 SP1



Microsoft Project and Changepoint field mappings

Changepoint Field
Direction of
Feed

During Creation
and/or Update

Microsoft Project
Column

Chargeable task To and From Creation and Update Chargeable

Text 1 To and From Creation and Update Text 1

Text 2 To and From Creation and Update Text 2

Text 3 To and From Creation and Update Text 3

Cross charged to fixed-

fee portion of the

initiative

To and From Creation and Update Fixed Fee (Flag 5)

Fixed fee (deliverable

name)

To and From Creation and Update Fixed Fee Item

(Text 4)

Utilization eligible To and From Creation and Update Utilization Eligible

(Flag 6)

Capital To and From Creation and Update Capital (Flag 10)

Project phase To during creation only. From during updates Phase (Text 12)

Configurable code 1 To and From Creation and Update Text 6

Configurable code 2 To and From Creation and Update Text 7

Configurable code 3 To and From Creation and Update Text 8

Add to calendar To and From Creation and Update Calendar CP

(Flag 4)

Locked task To and From Creation and Update Locked (Flag 7)

Open task To Creation and Update Not editable in

Microsoft Project

Work code To and From Creation and Update Work Code

(Text 9)
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Changepoint Field
Direction of
Feed

During Creation
and/or Update

Microsoft Project
Column

Location To and From Creation and Update Location (Text 10)

Task status

(completed only)

To and From Creation and Update Percent Complete

Planned hours

(computed value)

To and From Creation Duration

Staffing level To and From Creation and Update Text 5

Function To and From Creation and Update Text 11

Capital To and From Creation and Update Capital (Flag 10)

Allow work code

override

To and From Creation and Update (Flag 9)

Allow work location

override

To and From Creation and Update (Flag 8)

Planned start To during creation only. From during updates Start

Actual start To during creation, if the option to update the

actual start date is selected.

Thereafter, from during updates.

Actual Start

Actual finish From Update Actual Finish

Planned finish To during creation only. From during updates Finish

Milestone To and From Creation and Update Milestone
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Task assignment field mappings

Changepoint Field
Direction of
Feed

During Creation
and/or Update

Microsoft Project
Column

Planned hours To during creation only. From during updates Work

Not stored in

Changepoint

To and From Creation and Update Units

MSP calculates

units based on

work/duration,

which is updated

from Changepoint.

Actual hours To during creation only. Actual Work

(summary)

Time Scale Actual

Work (detailed)

Forecast start

Forecast finish

When the task

assignment is not

completed, these are

set to planned start and

planned finish. When

resource completes

the task and agrees to

update the planned

hours, then they are

set to planned start and

planned finish.

To and From Creation and Update Start (Start 10)

To and From Creation and Update Finish (Finish 10)

Actual start To Creation and Update Actual Start
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Changepoint Field
Direction of
Feed

During Creation
and/or Update

Microsoft Project
Column

Actual finish To Creation and Update Actual Finish

(Changepoint

updates the actual

start andMSP

calculates the

actual finish)

Manager comments

Notes entered inMSP

will be updated in

Manager comments
only.

To and From Creation and Update Notes

Bothmanager

comments and

resource

comments are

updated inNotes.

Resource comments To Creation and Update Notes

Planned start From Creation Start

Planned finish From Creation Finish
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Changepoint Field
Direction of
Feed

During Creation
and/or Update

Microsoft Project
Column

Cost to date

(task assignment –

This figure is the total

hours times the

resource’s hourly cost

rate)

To Creation and Update Actual Cost

(This value is

calculated based

on time entries and

the effective dates

on cost rates for

each task

assignment

through a

scheduled job run

in Changepoint.

The values

calculated are

added to the field

in Microsoft

Project.)

Remaining hours

Remaining hours are

sent to Changepoint

only when the resource

completes the task and

selects to update the

planned hours for the

completed task. Then

remaining hours is set

to 0 (zero).

To and From Creation and Update RemainingWork

Text 1 To and From Creation and Update Text 1

Text 2 To and From Creation and Update Text 2

Text 3 To and From Creation and Update Text 3
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Changepoint Field
Direction of
Feed

During Creation
and/or Update

Microsoft Project
Column

Staffing level

description

To and From Creation and Update Staffing level

(Text 5)

Locked To and From Creation and Update Locked (Flag 7)

Location To and From Creation and Update Location (Text 10)

Functions To and From Creation and Update Functions

(Text 11)

Allow work code

override

To and From Creation Location Override

(Flag 8)

Allow work location

override

To and From Creation Work Code

Override (Flag 9)

Code 1 To and From Creation and Update Text 6

Code 2 To and From Creation and Update Text 7

Code 3 To and From Creation and Update Text 8

Work code To and From Creation and Update Work Code

(Text 9)

Resource Field Mappings

Changepoint Field
Direction of
Feed

During Creation
and/or Update

Microsoft Project
Column

Indicate CP resource To Creation Flag 1 (Read-only

in MSP)

Resource name To Creation and Update Resource

Hourly cost rate To Creation and Update Standard Rate

Effective date To Creation and Update Effective Date
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About editing tasks and task assignments in linkedMSP projects

Nonworking days settings

Changepoint Setting
Level

Microsoft Project Setting

System level Project Calendar

Global Workgroup Personal Calendar

Workgroup

Resource

About editing tasks and task assignments in linked MSP projects
You can select the values for the following fields at the task level and at the task assignment
level:

• Work

• Duration

• Start

• Finish

• Code 1,2,3 (if used)

• Text 1,2,3 (if used)

• Forecast start

• Forecast finish

• Chargeable

• Staffing level

• Function

• Work code

• Work location

• Work location override

• Work code override

Project Management | 223



10. Microsoft Project Integration

• Locked

Tip: If the columns for the fields are not displayed, you can insert them.

When creating a task in Microsoft Project, you can select the values for these fields in the task
view. Task assignments that you create for tasks automatically have the same field values as
the task and are transferred to Changepoint when you save the linked project. However, you
can edit these values for tasks and specific task assignments.

Editing a task in a linked MSP project

1. Access the linked MSP project.

2. Click the View tab.

3. Click Gantt Chart > CP Gantt.

4. Click Table > CPUsage.

5. Make the necessary changes.

6. If there are existing task assignments, a message displays, asking if you want to override
this value for all assignments. Do one of the following:

• To replace the values for all existing task assignments with the new value, select Yes.

• To leave the values for existing task assignments unchanged, select No.

7. Save the project.

Note: Changes to the Staffing level field are handled in a different way. Existing task
assignments that were previously saved with or without a staffing level will not be
updated. You must edit the task assignments accordingly. For more information, see
"Editing a task assignment in a linked MSP project" on page 224.

Editing a task assignment in a linked MSP project

1. Access the linked MSP project.

2. Click the View tab.

3. Click Task Usage > Task Usage.

4. Click Table > CPUsage.

5. Make the necessary changes.
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About setting baselines in linkedMSP projects

6. Save the project.

About setting baselines in linked MSP projects
In Microsoft Project, you can set up to 11 baselines. However, only the information from the
first baseline option in the list (Baseline, without a number), is transferred to Changepoint.
You can set this baseline multiple times; however, each time you set the baseline, the new
baseline information replaces the previous baseline information in Changepoint.

Note: Changes that you make to project and task assignment baselines in Microsoft Project
are not transferred to Changepoint.

For information about setting a baseline, see the Microsoft Project help.

About saving interim plans in linked MSP projects
The use of interim plans is solely for the purpose of project tracking in Microsoft Project. The
interim plan fields have no effect on the Changepoint project dates. That is, this information is
not transferred back to Changepoint.

To view an interim plan after it has been saved, insert the interim baseline field columns into
the table. For example, if you selected the Start1 and Finish1 fields when saving the interim
plan, then you would add these fields to the table.

For information about saving an interim plan, see the Microsoft Project help.

Setting up multiple baselines in a linked MSP project

To display both the active and original baselines in Microsoft projects, each Microsoft Project
user must configure a specific bar style for each of the baselines in their local Microsoft
Project settings. You only have to perform this procedure once for each installation of
Microsoft Project.

Note: It may be possible to have one user perform this procedure and then email the
Global.mpt file to the other Changepoint users at the organization. For more information,
see the Microsoft Project online help.

1. In Microsoft Project, click Format > Bar Styles.

2. The Bar Styles dialog box appears.

3. Insert a new row and different color bar for each for the active and original baselines. For
more information about configuring bar styles, see the Microsoft Project online help.
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4. Click OK to close the dialog box.

5. Click the View tab.

6. Select Additional View > More Views.

The More Views dialog box appears.

7. Click the Organizer button.

The Organizer dialog box appears.

8. Select CP Gantt in the list to the right that displays the name of the current project.

9. Click the Copy button.
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About saving interim plans in linkedMSP projects

The CP Gantt entry is copied to the Global.mpt list (added to the Global.mpt template file).

10. When prompted to replace the existing file, click Yes.

11. Click Close to close the Organizer dialog box.

12. Click Close to close the More Views dialog box.

After you save the settings, the two new baseline fields are displayed in Microsoft Project for
all projects in the CP Gantt chart view, and you can do the following with or without
Changepoint:

• Show the Baseline and Interim Baseline on the CP Gantt view.

• Export the Interim baseline to the Start1 and Finish1 fields.
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11. Project Management Troubleshooting
Scenarios for saving baselines

This topic provides project scenarios with different combinations of settings for rolling up
subtasks and saving task baselines, and details the expected results of saving baselines on
the different levels of projects and tasks within those scenarios.

The scenarios are based on the following project structure:

Project level 1 Project level 2 Project level 3 Project level 4

Project 1

– Task 1

– Project 1.1

Task 1.1.1

Task 1.1.2

Task 2

Scenario 1

The following conditions exist:

• Project 1 is not configured to roll up planned information from subprojects to parent task

• Resources do not have the option to save task baselines without affecting upper-level
tasks, OR

• Resources have the option to save task baselines without affecting upper-level tasks, but
when saving a task baseline, the resource selects the option to roll up and baseline
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Project or
task

Rollup Baseline

Project 1 Roll up Task 1 and Task 2 to

Project 1

Task 1, Task 2, Project 1

No baseline in Project 1.1

Task 1* Roll up to Project 1 Task 1, Project 1

Project 1.1* No roll up to the parent task Task 1.1.1, Task 1.1.2, Project 1.1

Task 1.1.1* Roll up to Project 1.1 Task 1.1.1, Project 1.1

Task 1.1.2* Roll up to Project 1.1 Task 1.1.2, Project 1.1

Task 2* Roll up to Project 1 Task 2, Project 1

* When saving a task baseline, the system uses the previous (most recent) baseline values for
the other project tasks when they are required to calculate summary task and project baselines.

Scenario 2

The following conditions exist:

• Project 1 is not configured to roll up planned information from subprojects to parent task

• Resources have the option to save task baselines without affecting upper-level tasks option

• When saving a task baseline, the resource selects the option to baseline the task and lower
tasks only

Project or
task

Rollup Baseline

Project 1 Roll up Task 1 and Task 2 to

Project 1

Task 1, Task 2, Project 1

No baseline in Project 1.1

Task 1 No roll up to the Project 1 Task 1

Project 1.1 Roll up Task 1.1.1 and 1.1.2 to

Project 1.1. No rollup to the Task 1

Project 1.1, Task 1.1.1, Task 1.1.2

(Project 1 baseline rules apply)
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Project or
task

Rollup Baseline

Task 1.1.1 No roll up to the Task 1 Task 1.1.1

Task 1.1.2 No roll up to the Task 1 Task 1.1.2

Task 2 No roll up to the Project 1 Task 2

Scenario 3

The following conditions exist:

• Project 1 is configured to roll up planned information from subprojects to parent task

• Resources do not have the option to save task baselines without affecting upper-level
tasks, OR

• Resources have the option to save task baselines without affecting upper-level tasks, but
when saving a task baseline, the resource selects the option to rollup and baseline

Project or
task

Rollup Baseline

Project 1 Project 1 All projects and tasks

Task 1* Roll up to Project 1 Task 1, Project 1

Project 1.1, Task 1.1.1, Task 1.1.2

Project 1.1* Roll up to Task 1, Project 1 Project 1.1, Task 1.1.1, Task 1.1.2

Task 1, Project 1, Task 2 (old

baseline value)

Task 1.1.1* Roll up to Project 1.1, Task 1,

Project 1

Task 1.1.1, Project 1.1, Task 1,

Project 1

Task 1.1.2* Roll up to Project 1.1, Task 1,

Project 1

Task 1.1.2, Project 1.1, Task 1,

Project 1

Task 2* Roll up to Project 1 Task 2, Project 1
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* When saving a task baseline, the system uses the previous (most recent) baseline values for
the other project tasks when they are required to calculate summary task and project baselines.

Scenario 4

The following conditions exist:

• Project 1 is configured to roll up planned information from subprojects to parent task

• Resources have the option to save task baselines without affecting upper-level tasks

• When saving a task baseline, the resource selects the option to baseline the task and lower
tasks only

Project or
task

Rollup Baseline

Project 1 Project 1 All projects and tasks

Task 1 Roll up to Task 1

No rollup to Project 1

Task 1

Project 1.1, Task 1.1.1, Task 1.1.2

Project 1.1 * † Rollup to Task 1, Project 1 Project 1.1, Task 1.1.1, Task 1.1.2

Task 1, Project 1,

Task 2 (old baseline value)

Task 1.1.1 * † Rollup to Project 1.1, Task 1 Task 1.1.1, Project 1.1, Task 1

Task 1.1.2 * † Rollup to Project 1.1, Task 1 Task 1.1.2, Project 1.1, Task 1

Task 2 NoRollup to Project 1 Task 2

* When saving a task baseline, the system uses the previous (most recent) baseline values for
the other project tasks when they are required to calculate summary task and project baselines.

† Baselines are saved for higher level tasks because the rolling up of planned information from
subprojects to parent task takes precedence even when the resource saves a task baseline and
selects the option to baseline the task and lower tasks only.

Troubleshooting projects
This topic provides troubleshooting information for the project profile and project dialog box.
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Troubleshooting projects

Chargeable project check box is not available

The Chargeable project check box is available only if the option to allow project managers to
override the Chargeable status check box has been selected in the initiative dialog box. For
the project to display as a selection in the cross charge dialog box, the project must be
chargeable.

Cannot change the Chargeable status of a project

You cannot change the setting of the Chargeable project check box when the Split charges
check box has been selected on the Cross Charge information tab of the initiative, and either
of the following conditions exist:

• Cross charges exist for an initiative or phantom initiative that is in Draft, Pending
Approval, Pending Second Approval or Approved status.

• All cross charges are committed, but there is time and/or expenses for the initiative or
phantom initiative that have not been fully cross charged.

Project ID field is not available

The field has not been enabled by your organization.

Fiscal Periods field: cost structure is not available

The Fiscal periods field lists only cost structures that have defined fiscal periods.

Cross Charge Contact field is not available

This field is available only if the option to allow project managers to specify the charge contact
check box has been selected for the initiative. The address type (main, charge, shipping or
another as configured by your System Administrator) for the contact is selected at the initiative
level.

CP Project Type field is not available

The CP project type field has not been enabled by your organization.

Alternate Name field is not available

The field has not been enabled by your organization.

Request field is not available

The project did not originate from a request.
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Enable project time approval check box is not available

This field is available only if the option to allow project managers to specify the time approver
field has been enabled for the initiative associated with this project.

Project Plan editor cannot take ownership of a project
Project plan editor cannot create or delete tasks
Resource does not appear in project plan editor list

These issues are most likely related to access rights. See "Managing projects" in the Security
Access Reference Guide.

“Baseline only” option selected when saving a baseline, but parent task is being
rolled up and baselined

If the option to roll up planned information from subprojects to parent task is selected on the
Access tab of the parent project, it takes precedence over the option to save a baseline without
affecting higher level tasks.

Project Team section does not appear

In order for the Project Team section to appear, both of the following conditions must exist:

• resource requests must be enabled on the cost structure

• resource requests must be enabled at the project level on the Projected Resources dialog
box of the initiative

Fiscal Year Breakdown section does not appear

The section displays only if fiscal periods have been specified for the cost structure that is
associated with the project.

Allow users to override the [Chargeable] status on expenses entered for this
project check box is not available in the Access section of the project dialog box

This option is available only if the initiative and project are chargeable, and the option for the
project manager to override this status has been enabled on the initiative.

Troubleshooting linked MSP projects

Project is not available for linking from Microsoft Project

If your organization uses resource requests, all mandatory configurable fields on resource
requests must be completed on the project editing and task editing views before the project
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Troubleshooting tasks

will be available for linking from Microsoft Project.

Troubleshooting tasks
This topic provides troubleshooting information for the task profile and task editing view.

A resource is not available to be assigned to a task

Resources require the Track Project-Related Time feature to be assigned to a task.

Open task field not available

If resource requests have been enabled for projects or tasks on the initiative, then the Open
task check box is disabled on the task editing view.

Cross Charged to fixed-fee portion of the initiative field is not available

This option is available only if the initiative uses fixed-fee cross charging.

Fixed Fee field is not available

This field is available only if the initiative is cross charged under some variation of a fixed-fee
method.

Cross charge rate field is not available

This field is available only if you have the View Cross Charge and Cost Rates in Task
Assignment Section feature. Also, the first time that you access a task in the system, you
must right-click on the grid and select Show cross charge rates to view this field.

Cost rate field (Staffing level cost rate or Resource-based cost rate) is not
available

The Cost rate field is a non-editable field that displays the staffing level-based or resource-
based cost rate that is applicable to the task assignment. It is only available to resources who
have the View Cross Charge and Cost Rates in Task Assignment Section feature.

The cost rate that is displayed is determined by the settings for the cost structure in
Changepoint Administration:

• If the cost structure for the task is configured to use staffing level cost rates, then this field
is called Staffing level cost rate.
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• If the cost structure is configured to use resource cost rates, then the field is called
Resource-based cost rate and you additionally require the View Costs feature for it to
display.

The first time that you access a task in the system, you must right-click on the table and
select Show cost rates to view this field.

Soft-booked field is not available

This field is available only if soft-booking has been enabled for the cost structure.

Status update section is not available

The Status update section appears only on tasks that are assigned to you.

Troubleshooting the project worksheet
This topic provides troubleshooting information for the project worksheet.

Summary task manager cannot create a task or task assignment using a subtask
as the insertion point

Adding a new task above an existing task requires edit access to tasks because the WBS has
to be updated.

If summary task managers have been granted project access to create tasks, but not to edit
tasks, then they must use the task assignment to add or paste new tasks or task assignments.

A resource in your preferred resources list in the Manage Preferred Resources
dialog box does not appear in the task assignment resource list

Only resources who have the Track Project-Related Time feature can be assigned to tasks.

You cannot edit the planned hours for a task

Add the Loading method column to the worksheet view and select one of the auto-distribute
loading methods for the task.

You get a validation error message when trying to save the project worksheet,
but there are no errors on the project worksheet

The error may be on a row that is hidden by a filter. Remove the filter and try again.
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Resource availability changes when planned start is moved in the past

Changing a planned start date for a task assignment in the past will affect the resource
availability because the resource availability is calculated from the current date, while planned
hours are distributed across the duration, regardless if the planned start is in the past.

For example, you have a task assignment with the following data:

• planned start in the past

• planned hours: 60

• 20 days duration (20 working days between the planned start and the planned finish)

• 4 working days between the current date and the planned finish

• total available hours per day: 6

The 60 planned hours would be spread over the 20 days, resulting in 3 planned hours per day
(60 / 20 = 3).

If the total available hours per day is 6, then the resource’s available hours per day is 3
(6 hours – 3 planned hours = 3). The total resource availability is: 3 hours * 4 working days =
12 available hours.

If you change the planned start date to 40 working days earlier, then the duration increases to
60 working days from the original 20 days. The planned hours for the task assignment are
spread over a longer period, which reduces the planned hours per day to 1 (60 planned hours /
60 working days = 1).

Therefore the resource’s availability per day is increased to 5 (6 total available hours minus 1
planned hour per day = 5). The total resource availability increases to 20 hours (5 hours *
4 working days = 20 hours).

Resource availability is 0

If you click on an assignment that has planned start and planned finish in the past, you will
get 0 availability shown in the planned hours field and no availability shown in the fiscal or
daily periods.
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Fiscal period columns do not display in the project worksheet and the number of
periods field  is missing

You require the Edit Project Information in Fiscal Periods feature to view and use the
fiscal and daily periods columns.

Daily periods are displayed and the switch timescale  icon is missing

A fiscal period has not been associated with the project.

Fiscal Period field is not displayed when you are editing a project

Contact your system administrator.

Planned hours change to zero when task is viewed in the project worksheet

If you create a task in the task editing view and the planned hours are allocated over any
nonworking days, then when you launch the project worksheet, the planned hours are
automatically re-allocated over the working days only. However, if the duration of the task
covers nonworking days only, then the planned hours are removed as there are no working
days within the duration to allocate them to.

Planned hours remain at zero when you click the calculate  icon

You must clear the values from the cells to be calculated, even if the value is zero. The
calculation applies only to empty cells.

Planned hours are changed after the project is rolled up

Possible cause: Fiscal periods have been selected on the project, task assignment planned start
and planned finish dates are in the past, and the default loading method is 1 - Auto
distribute – update past and future. This loading method will cause planned hours in past
fiscal periods to be replaced with actuals and the difference to be allocated to current and
future fiscal periods. When both planned start and planned finish are in the past, planned hours
will be set to actual hours, or to 0 if no actual hours have been entered.

Solution: When creating tasks in the worksheet, ensure that you select a loading method that
does not replace past period information with actuals is selected, for example: 4 - Auto
distribute - no update to past).
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Troubleshooting PPW

Only the project row appears in the project worksheet

You can only view the tasks and task assignments that you have edit access for are displayed
in the project worksheet. Check whether a filter has been applied to the project worksheet.

You access a project for editing, but the Configurable Fields dialog box appears

The Configurable Fields dialog box appears when you access a project for editing and there
are no values for the configurable fields because no project team entries have been added and
no resource requests have been submitted. However, a resource request has been submitted
automatically and it requires values for the mandatory configurable fields before it can be
processed. Before you can access the project, you must complete the mandatory configurable
fields and then click Save.

A task is incorrectly marked as critical

For performance reasons, there is a default period during which nonworking days data for tasks
is stored. The default period begins five years prior to the current date, and ends five years
past the current date. Therefore, calculations for tasks with planned start and/or planned finish
dates that are outside of the default period can be incorrect, and tasks can be incorrectly
marked as critical.

Unassigned resource is not available for selection in a project worksheet filter

Unassigned resources are not listed in the Value column in a filer criteria row when the
condition is Equal to. The workaround is to use the Like condition instead.

Troubleshooting PPW

Task field values not inherited when assigning tasks in task view

Configurable field values (and a few standard fields) are not inherited when assigning tasks in
a task view unless the fields on the task and task assignment have been displayed in PPW.

To ensure that field values are inherited by new or existing task assignments, do the following:

1. Create a task view that contains the desired fields.

2. Create a task assignment view that contains the desired fields. Make the task assignment
view your default view so that it appears each time you access PPW.

3. Switch to the task view to add or change data.
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You cannot insert a task or make any modifications in PPW and the "Save" and
"Apply" buttons are missing.

Check that you have a project lock. If PPW is locked by other resources, you must wait until
you receive a message that project is unlocked before you can lock it. The project manager
can take the lock from the other resources by clicking , which can cause the other

resources to lose their changes.

Summary task managers can see only their summary tasks in PPW

To view all of the tasks in PPW, summary task managers must be granted view project access
to the project by the project manager.

Rolled up amounts for the project are incorrect in PPW

Only the tasks that are currently displayed in the worksheet are rolled up after changes have
been made.

Therefore the rolled up amounts can be lower than the project totals for the following reasons:

• filter has been applied to limit the tasks that are displayed

• you are a summary task manager and do not have view project access to the project

Cannot edit planned start, planned finish, and planned hours in a task view

If one or more task assignments for a task has a manual loading method, then you cannot edit
the planned start, planned finish, or planned hours for the task in a task view.

Planned effort totals for daily distribution amounts are incorrect in PPW

Daily distribution amounts are calculated and stored using five decimal places, but are rounded
to three decimal places when displayed in PPW. Therefore due to rounding, the daily
distribution amounts for a task assignment might add up to a slightly different amount than the
total planned effort that is displayed for a task assignment.

"Select/Deselect tasks for activation" icon does not appear in PPW

The Select/Deselect tasks for activation icon ( ) is available in a task view only when no

sort criteria has been specified in the view and no filter has been applied.
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Cannot add effort to a resource in the "Assign Resources" dialog box

When the default loading method is manual, you must use a task assignment view to allocate
effort to daily or fiscal periods.
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Create/Edit Project dialog, General section
options 20, 23

E

Edit Project dialog, Project team tab
options 34

effort. See planned hours 115, 180

examples
loading methods 119, 183

expense-only users, specifying 30

exporting
project worksheet to Microsoft Excel 84,

153
project worksheet to Microsoft Excel,

about 84

F

filtering data in PPW 168

filters
project worksheet 88

forecast dates
MSP projects, about 214

G

Gantt chart
project worksheet, viewing, about 141, 189
timescale, changing 190

Gantt chart, PPW
tasks, linking 191

Gantt chart, project worksheet
accessing 142
baseline, forecast info, showing 145
critical path, showing 145
managing tasks, about 143
task dependencies, about 144
task progress, showing 144
tasks, linking 144
tasks, moving in 143
tasks, unlinking 144
timescale, changing 142
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Gantt chart. project worksheet
duration of tasks, changing 143

Gantt charts
duration of tasks, changing 190

L

Link Changepoint Project dialog box
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loading methods
about 116, 181
examples 119, 183
selecting 121

M

Manage Filters (project worksheet) dialog box
options 89

Manage Filters dialog box 169

Manage Views dialog box 157

Microsoft Project integration
about 203

MSP projects
accessing 208
actual hours, updating 213
baselines, setting up multiple 225
baselines, setting, about 225
Changepoint MSP COM Add-in,

installing 206
Changepoint resources, identifying 214
data transfer between MSP and

Changepoint 203
editing 213
editing, about 212
fields, mapping with Changepoint 215
forecast dates, about 214
interim plans, about 225
link, removing 215

link, removing, about 214
linking 211
linking, about 208
Microsoft Project default values,

setting 207
project worksheet, in 84
resource lists, creating 205
setting up 205
task assignments, editing 224
task or task assignment, deleting 213
task usage information, viewing 214
tasks and task assignments, deleting 213
tasks and task assignments, editing,

about 223
troubleshooting 234
website settings, configuring 207

O

open tasks
about 51
access to, restricting 70
project worksheet, about 94

P

planned hours
allocating in project worksheet 115, 180
automatically allocating in project work-

sheet 122

PPW
basics 147
linking 171

PPW filters
creating 168
editing 169

PPW tasks
indenting and outdenting 152
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PPW views
about 154
creating 156
editing 167

preferred resources
adding in project worksheet 108

project
objective, associating 24

project allocation worksheet. See project
worksheet 79

project management
about 13
resources, about 13

project plan editors
assigning to project 28
assigning to project, about 27
reassigning projects to 46

project planning worksheet
accessing 150

project profile
noneditable sections 15

project teams
about 33
assigning resources to tasks 37
copying projected resources to the pro-

ject team 35
creating project team entries 33
editing entries 37
entries, deleting 37
submitting resource requests 36

project worksheet
accessing 79
allocating planned hours, examples 130
basics 79
check boxes, editing 111
columns, related 109

critical path, about 129
critical path, viewing 129
date and effort calculations, about 134
date and effort calculations,

examples 137
date and effort calculations,

performing 135
date and effort calculations, required

columns for 136
dates, specifying 113
dates, specifying using the

calendar 114
dates, specifying using the date

field 113
editing recurring demand 124
errors, about 83
exporting to Microsoft Excel 84, 153
exporting to Microsoft Excel, about 84
filtering information, about 88
forecast info for task assignments, edit-

ing 127
Gantt chart, viewing, about 141, 189
level option, using in calculations 135
linked tasks, editing settings 102
linked tasks, editing settings, about 102
lists, clearing values from 113
lists, editing multiple values 112
lists, specifying multiple values 111
locking tasks, about 94
MSP projects, about 84
open tasks, about 94
periods, displaying from a specific

date 81
periods, displaying previous or next 81
periods, switching fiscal, daily 80
planned hours, allocating manually 122
planned hours, allocating manually,

about 122
planned hours, allocating to match

resource availability 126
planned hours, allocating, about 115,
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180
planned hours, automatically allocating,

about 122
predecessor and successor tasks,

identifying 102
preferred resources, adding 108
printing 83
printing, about 83
replacing planned information with forecast

and actual information 126
reports, running from 82
resource availability, displaying 125
resource availability, displaying, about 124
resource requests in, about 107
resource searches, using for task assign-

ments 105
resource searches, using for task assign-

ments, about 105
searching 82
summary and subtasks, creating 97
summary tasks, about 94
troubleshooting 236
updating remaining effort or percent com-

plete, about 128

project worksheet filters
about 88
applying 93
calculated columns, about 90
clearing from view 93
creating 91
deleting 93
editing 92
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project worksheet task assignments
copying 106
copying, about 106
creating 104
creating, about 104
deleting 110
deleting, about 110

project worksheet tasks
copying 100
copying, about 100
creating 99
creating, about 97
deleting 110
deleting, about 109
editing 109
editing multiple at once 115
editing, about 108
expanding and collapsing 80
indenting and outdenting 97
linking 101
linking, about 101
locking and unlocking 95
managing, about 93
moving 96
moving multiple 96
moving single 96
selecting multiple 95
unlinking 103

project worksheet views
copying 86
creating 85
deleting 88
editing 87

projects
access restrictions to requests, removing 27
access, about 26
accessing 15
applications, linking to 31
applications, unlinking 32
baselines, allowing resources to save 29
baselines, saving 47
baselines, saving, about 46
baselines, scenarios 229
Budget information section, completing 21
copying to update a project 42
copying, about 41
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creating 19
creating methods 15
creating, about 16
deleting 40
deleting, about 40
editing 40
editing, about 39
expenses, allowing resources to

submit 30
fiscal periods, using 19
icons 16
ownership, taking 46
phases, about 18
progress reporting 193
project plan editors, specifying 28
project plan editors, specifying,

about 27
quick plan, creating based on projected

resources 202
quick plan, project options 199
quick plan, task options 201
quick plans 195
reassigning 46
rolling up 49
rolling up, about 48
setting up split charges 25
statuses, about 17
subprojects, creating 32
summary task managers, granting pro-

ject access 28
task status updates, about 18
time approvers, specifying 23
troubleshooting 232
view access, granting 26
work codes and locations,

specifying 25
work codes and locations, specifying,

about 24

Q

quick plans
project, defining 198
tasks, defining 200

R

reporting
project progress 193

reports
quick plan, initiative option 195
Task Status Compliance Report 193

resource availability
displaying in project worksheet 125
displaying in project worksheet,

about 124

resource leveling, about 14

resource requests
in project worksheet, about 107
submitting from tasks 65

resources
assigning to tasks in project

worksheet 104
assigning to tasks in project worksheet,

about 104
Changepoint, identifying in MSP pro-

jects 214
checking available hours 60
checking available hours, about 61
checking available hours, example 62
task assignments, deleting from 66

rolling up
projects from profile 49
projects from profile, about 48
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soft-bookings 14

sorting tasks in project worksheet 96

split charges
setting up for projects 25

status updates
about 18

subprojects
creating 32
creating, about 32
granting access to 29
rolling up 49
rolling up, about 48

subtasks
creating in project worksheet 97

summary task managers
project access, granting 28
tasks, creating 98

summary tasks
about 51
creating in project worksheet 97
project worksheet, about 94

T

task assignments
allocating recurring planned hours 123
checking available hours 60
checking available hours, about 61
checking available hours, examples 62
copying in project worksheet 106
copying in project worksheet, about 106
creating in project worksheet 104
creating in project worksheet, about 104
cross charge rates, viewing, about 63

deleting in project worksheet 110
deleting in project worksheet, about 110
loading methods, selecting 121
multiple, editing in project worksheet 115
planned hours, allocating automatically 65
planned hours, allocating automatically,

about 64
resource requests, submitting 65
resource searches in project worksheet,

using, about 105
resource searches, using in project work-

sheet 105
resources, assigning 57
resources, deleting 66

task editing view
accessing 73
General section options 53
General section, completing 56

Task Status Compliance report 193

tasks
about 51
activating in PPW 187
applications, linking to 57
assign multiple resources 175
assign multiple resources in PPW 173
assign resources 174
baseline, saving without affecting higher

tasks 69
baseline, saving without affecting higher

tasks, about 69
baselines, saving 69
baselines, saving, about 67
baselines, saving, example 67
Chargeable status, editing 74
copying in project worksheet 100
copying in project worksheet, about 100
creating 55
creating in project worksheet 99
creating in project worksheet, about 97
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creating, about 52
deleting 76
deleting in project worksheet 110
deleting in project worksheet,

about 109
dependencies, creating 72
dependencies, creating in project work-

sheet 101
dependencies, creating, about 70
dependencies, removing 73
dependency options 71
editing configurable fields 75
editing in project worksheet 109
editing in project worksheet, about 108
expanding and collapsing in project

worksheet 80
icons 51
indenting and outdenting in PPW 152
indenting and outdenting in project

worksheet 97
linked in project worksheet, editing set-

tings 102
linked in project worksheet, editing set-

tings, about 102
linking in PPW 171
linking in project worksheet 101
linking in project worksheet, about 101
loading methods, selecting 121
locking and unlocking in project work-

sheet 95
locking, about 94
managing in project worksheet,

about 93
moving in project worksheet 96
multiple, editing in project

worksheet 115
open, about 51
open, restricting access to 70
profiles, accessing 52
reopening 77
reopening, about 77

resources, assigning to 57
resources, selecting, about 60
searching in project worksheet 82
sorting 78
staffing level, changing 75
summary and subtasks, creating in pro-

ject worksheet 97
summary, about 51
troubleshooting 235
unlinking in project worksheet 103
validating in PPW 186
work codes, setting 76
work locations, setting 76

tasks, PPW
copying 172
creating 170
editing 188
moving 152

time approvers, specifying 22

troubleshooting
MSP projects 234
project worksheet 236
projects 232
tasks 235

W

Worksheet Print Setup dialog box
options 145

worksheet, project allocation. See project
worksheet 79
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